Operation .............................................................. 34

Navigating the MPC Hardware Screen........ 34

General Features................................................. 35

Programs .......................................................... 35
About Programs............................................... 35
Drum Programs................................................. 36
Keygroup Programs ........................................ 37
Clip Programs ................................................... 38
Plugin Programs ............................................... 39
MIDI Programs .................................................. 40
CV Programs .................................................... 41

Saving .......................................................... 42

Preferences ..................................................... 42

Now & Locators .................................................. 44

Timing Correct/T.C. .......................................... 46

Click/Metronome .............................................. 48

Automation ........................................................ 49
Global .............................................................. 49
Programs & Audio Tracks ......................... 49

16 Level .......................................................... 50

Pad Assign ....................................................... 51

Pad Copy ........................................................ 52

Erase ............................................................... 53

Edit Sequence ................................................... 54

Effects .............................................................. 58
Overview ........................................................ 58
Insert Effects .................................................. 61
Send/Return Effects ........................................ 68

Audio Mixdown .................................................. 75

Modes ..................................................................... 76

Main Mode .......................................................... 77
MIDI Tracks ...................................................... 78
Audio Tracks ...................................................... 81

Step Sequencer .................................................. 84

Sample Edit Mode ............................................ 90
Trim Mode ....................................................... 91
Chop Mode ....................................................... 98
Program Mode ............................................... 106

Program Edit Mode ......................................... 111
Drum Programs ................................................. 112
Keygroup Programs ........................................ 124
Clip Programs ................................................... 138
Plugin Programs ............................................... 142
MIDI Programs .................................................. 143
CV Programs .................................................... 143
Anatomy of an Envelope ................................ 144

Browser ............................................................. 145

Sample Record Mode ......................................... 147
Sample ............................................................ 150
Slice .............................................................. 152
Pad Tap ........................................................... 153
Pad Hold .......................................................... 154

Looper .............................................................. 155

Pad Mixer .......................................................... 159

Channel Mixer ................................................... 162
MIDI Tracks ...................................................... 165
Audio Tracks ...................................................... 166
Programs ......................................................... 167
Returns ........................................................... 168
Submixes ........................................................ 169
Master Outputs ............................................... 170

Pad Mute Mode .................................................. 171

Track Mute Mode ............................................... 173
Modes (continued)

Next Sequence Mode ................................ 175

Song Mode ................................................ 177

Q-Link Edit Mode ....................................... 179
  Project .................................................. 180
  Program .................................................. 180
  Pad Scene .............................................. 181
  Pad Parameter ........................................... 181
  Screen .................................................... 182

MIDI Control Mode .................................... 183
  Pads ..................................................... 184
  Buttons ................................................... 185
  Q-Link Knobs ........................................... 186

Pad Perform Mode .................................... 187

Appendix .................................................... 190

Effects & Parameters ................................. 190
  Reverbs ................................................. 190
  Delays ................................................... 192
  Flangers ............................................... 195
  Choruses ............................................... 196
  Autopans ................................................ 196
  Tremolos ............................................... 197
  Phasers .................................................. 197
  HP (High-Pass) Filters ............................... 198
  LP (Low-Pass) Filters ................................ 199
  Parametric EQs ........................................ 200
  Distortions ............................................. 201
  Compressors .......................................... 202
  Bit Reducers .......................................... 203
  Other ..................................................... 204

Glossary .................................................. 205

MIDI Machine Control (MMC) ....................... 210

Trademarks & Licenses ............................... 211

Addenda ..................................................... 212

Updates in MPC 2.1 .................................... 212
  New Features ............................................ 212
    Step Sequencer: Velocity Adjustment via Q-Links ........................................ 212
    List Editor ............................................. 213
    Faster Attack for Amp Envelopes ........................................ 216

Updates in MPC 2.3 .................................... 217
  New Features ............................................ 217
    Arpeggiator .......................................... 217
    Pad Perform Mode: Chromatic Type ........................................ 218
    Q-Link Navigation Enhancements ........................................ 218

Updates in MPC 2.4 .................................... 219
  New Features ............................................ 219
    Clip Program Improvements ........................................ 219
    Next Sequence Mode .................................... 219
    Additional Transport Controls ........................................ 219

Updates in MPC 2.6 .................................... 220
  New Features ............................................ 219
    Erase Parameters ...................................... 219
    Workflow Enhancements .................................... 219
Introduction

Thank you for purchasing the MPC Renaissance or MPC Studio. At Akai Professional, we know how serious music is to you. That’s why we design our equipment with only one thing in mind—to make your performance the best it can be.

This user guide explains how to create music using **MPC Renaissance** and **MPC Studio**. There is similar documentation available for MPC products that use a touchscreen and for the MPC software application itself.

Welcome to the MPC family.

---

Akai Professional

---

System Requirements & Product Support

For the latest information about this product (system requirements, compatibility information, etc.) and product registration, visit [akaipro.com](http://akaipro.com).

For additional support, visit [akaipro.com/support](http://akaipro.com/support).

---

About This User Guide

This manual should help you get familiar with using your **MPC Renaissance** or **MPC Studio**. For consistency, the terminology throughout is based on the MPC nomenclature. We also used specific formatting to indicate particular topics of significance:

**Important/Note/Tip:** Important or helpful information on a given topic.

Names of buttons, controls, parameters, settings, and other options are written in **bold** characters throughout the manual.

**Examples:** Press the **Play Start** button.

- Turn **Q-Link Knob 4**.
- Tap the **Mute** button.
- The **Velocity** ranges from 0 to 127.
- Set the **Sample Play** selector to **One Shot**.
- Tap **BPM**, and then use the numeric keypad to enter 120 as the tempo.

Some parts of this manual refer to other relevant chapters or sections, which are cited in **bold, italic blue** characters. Click the text to skip immediately to that section.

**Examples:** Read the **Important Notes** section before proceeding.

- For more information about installing the necessary drivers and software, see **Setup > 2. Installation**.
- To learn more about using send effects, see **General Features > Effects > Send/Return Effects**.
Important Notes

Read the included safety & warranty manual before using your MPC hardware.

Before getting started and connecting devices to your MPC hardware or turning the hardware on/off, make sure all devices are switched off.

Important:

Before installing the MPC software, make sure your computer meets the system requirements described at akaipro.com. This applies whether you’ll use MPC software as your host software or as a plugin in another digital audio workstation (DAW).

Before connecting your MPC hardware to your computer, install the drivers and software. Visit akaipro.com to download the latest versions. Refer to the 2. Installation section for more information.

Setup

1. Connection

Here is just an example of how to use MPC Renaissance in your setup. Items not listed under Introduction > Box Contents of your included quickstart guide are sold separately.

![Diagram of MPC Renaissance setup](image)
2. Installation

Follow these steps to download and install the required drivers & software:

1. Go to akaipro.com and register your product. If you don’t have an Akai Professional account yet, you will be prompted to create one.
2. In your Akai Professional account, download the MPC software package.
3. Open the file and double-click the installer application.
4. Follow the on-screen instructions to complete the installation.

**Note:** By default, the MPC software will be installed in [your hard drive]\Program Files\Akai Pro\MPC (Windows®) or Applications (macOS®). You can also create a shortcut on your Desktop.

3. Getting Started

1. Power on your MPC hardware.
2. On your computer, open the MPC software.
3. Follow the on-screen instructions to authorize your version of MPC.
4. You will need an iLok account to complete this. You can create an account at ilok.com.
   Make a note of the PACE code in your account, and enter it when asked for it during the authorization/unlock process.
5. In the MPC software, click the Edit menu, and select Preferences. Click the Audio tab and select the sound card you want to use. Click OK when you are done.

**Important:**

We highly recommend using your MPC hardware’s sound card ([Akai Pro MPC Renaissance/Studio ASIO](https://www.akai-pro.com/products/mpc-renaissance/)). If you need to use the internal sound card on a Windows computer, we recommend downloading the latest ASIO4ALL driver at asio4all.com.

To view the MPC software user guide, click the Help menu, select MPC Help, and select MPC User Manual.
Features

This chapter explains the features and functions of each MPC model with an LCD screen: **MPC Renaissance** and **MPC Studio**.

### MPC Renaissance

#### Top Panel

![MPC Renaissance Top Panel Diagram]

**Navigation & Data Entry Controls**

1. **Display**: This LCD shows all the information relevant to MPC Renaissance’s current operation. Much of this information is also shown in the software. Use the **cursors** to navigate through the display, and use the **data dial**, and +/- buttons to adjust the currently selected setting/parameter. Use the **Mode** buttons to change what page is shown, and use the **function buttons** to change what tab is shown.

   **Tip**: You can adjust the display contrast by holding down **Shift** and turning the **data dial**.

2. **Function Buttons**: Press one of these buttons to select its corresponding tab, shown above the button in the display.

3. **Cursors**: Press these buttons to navigate through the fields of menus and options shown on the screen.

4. **Data Dial**: Use this dial to scroll through the available menu options or adjust the parameter values of the selected field on the screen.

5. +/-: Press these buttons to increase or decrease the value of the selected field on the screen.
6. **Numeric Keypad**: If the selected field on the screen is a number, press these numbered buttons as you would on a standard numeric keypad to enter a value. Press the keypad’s **Enter** to enter it.

7. **Undo/Redo**: Press this button to undo your last action.
   
   Press and hold **Shift** and press this button to redo the last action you undid.

---

**Pad & Q-Link Controls**

8. **Q-Link Knobs**: Turn these touch-sensitive knobs to adjust various parameters and settings. The LEDs surrounding each knob show the knob’s current position.

9. **Q-Link Trigger**: Press this button to cycle through the three global automation states: Off, Read (solidly lit), and Write (flashing). See **Operation > General Features > Automation** to learn more about this.

10. **Pads**: Press these pads to trigger drum hits or other samples in your software. The pads are velocity-sensitive and pressure-sensitive, which makes them very responsive and intuitive to play. The pads will light up different colors, depending on how hard you play them (ranging from yellow at a low velocity to red at the highest velocity). You can also customize their colors.

11. **Pad Bank**: Press these buttons to access Pad Banks A–D.
    
    Press and hold **Shift** while pressing these buttons to access Pad Banks E–H. Alternatively, double-press one of these buttons.

12. **Pad Assign/Pad Copy**: Press this button to assign samples and specific colors to your pads in each program. See **Operation > General Features > Pad Assign** to learn more about this.
    
    You can also use this button to copy the samples and parameters from one pad to another. Hold **Shift** and press this button to open the **Copy Pad** window. In the **From Pad** field, press the “source” pad. Use the **cursors** to select the **To Pads** field, and then press the “destination” pads. Press **F5** (**Do It**)—the samples and parameters will be copied automatically from the source pad to the destination pad.

13. **Full Level/Half Level**: Press this button to activate or deactivate the Full Level feature. When activated, the pads will always trigger their samples at the maximum velocity (127), regardless of how much force you use.
    
    Press and hold **Shift** and then press this button to activate or deactivate the Half Level feature. When activated, the pads will always trigger their samples at half-velocity (64).

14. **16 Level**: Press this button to activate/deactivate 16 Level. When activated, the last pad that was hit will be temporarily copied to all 16 pads. The pads will now output the same note number as the initial pad, but a selectable parameter will be fixed at values that increase as the pad numbers increase (e.g., Pad 1 is the minimum, Pad 16 is the maximum), regardless of how hard you press them. In the screen that appears, use the **Type** selector to choose the parameter: Velocity, Tune, Filter, Layer, Attack, or Decay. See **Operation > General Features > 16 Level** to learn more.

15. **Note Repeat/Latch**: Press and hold this button, and then press a pad to trigger that pad’s sample repeatedly. The rate is based on the current tempo and Time Correct settings.
    
    Press and hold **Shift** and then press this button to “latch” the Note Repeat feature. When latched, you do not have to hold the Note Repeat button for it to be activated. Press **Note Repeat** once more to un latch it.
Mode & View Controls

**Note:** See *Operation > Modes* to learn about the different modes you can access with these controls.

16. **Shift:** Press and hold this button to access some buttons’ secondary functions (indicated by red writing).
   Double-press this button to see which buttons have secondary functions—the buttons will flash for a few seconds.

17. **Main/Track:** Press this button to enter Main Mode.
    Press and hold Shift and press this button to enter the Track View.

18. **Browser/Save:** Press this button to view the Browser. The Browser lets you navigate your computer’s internal hard disk to load samples, sequences, songs, etc. Using filter buttons and user-definable folders, you can easily adapt it to your workflow. You can also preview samples before loading them.
    Press and hold Shift and press this button to save the current project (including its samples, programs, sequences, and songs).

19. **Prog Edit/Q-Link:** Press this button to view Program Edit Mode, which contains all parameters for editing your programs.
    Press and hold Shift and press this button to enter Q-Link Edit Mode, where you can determine what the Q-Link knobs control in other modes.

20. **Prog Mix/Track Mix:** Press this button to view the Pad Mixer where you can set a program’s levels, stereo panning, routing, and effects.
    Press and hold Shift and press this button to enter the Channel Mixer where you can set levels, stereo panning, and other settings for your tracks, programs, returns, submixes, and masters.
    **Important:** Prog Mix on your MPC hardware corresponds to the Pad Mixer in the MPC software. Similarly, Track Mix (or Shift+Prog Mix/Track Mix) on your MPC hardware corresponds to the Channel Mixer in the MPC software. This is due to the functionality changing as the software has evolved.

21. **Seq Edit/Effects:** Press this button to view the Edit Sequence screen where you can create or edit sequences.
    Press and hold Shift and press this button to enter the Effects page, where you can select and route effects as well as edit their parameters.

22. **Sample Edit/Sample Rec:** Press this button to view Sample Edit Mode where you can edit your samples using various functions and processes.
    Press and hold Shift and press this button to view the Sampler where you can record audio samples to use in your projects.

23. **Song/Other:** Press this button to enter Song Mode where you can arrange sequences in a specific order and/or repetition to create songs. You can edit the structure of a song during playback for easy, on-the-fly composing.
    Press and hold Shift and press this button to enter MIDI Control Mode, which lets you edit various MIDI parameters for the pads, Q-Link knobs, and certain buttons on your hardware.

24. **Step Seq:** Press this button to view the Step Sequencer where you can create or edit sequences by using the pads as “step buttons,” simulating the experience of a traditional step-sequencer-style drum machine.

25. **Next Seq:** Press this button to view Next Sequence Mode where you can trigger different sequences simply by playing the pads. This is useful for live performances, letting you change a song’s structure in real time.

26. **Track Mute/Pad Mute:** Press this button to view Track Mute Mode where you can easily mute tracks within a sequence or set mute groups for each track.
    Press and hold Shift and press this button to view Pad Mute Mode where you can easily mute pads within a program or set mute groups for each pad within a program.

27. **Window/Full Screen:** When this button is lit, it means the selected field in the display contains additional parameters in a sub-window; press this button to access them. Use the function buttons, cursors, and data dial or +/- buttons to navigate the sub-window.
    Press and hold Shift and press this button to switch between Full Screen and Half Screen Modes in the software. In Full Screen Mode, the workspace occupies the whole window. In Half Screen Mode, the parameter controls (Q-Link knobs, pads, sequence and track information, project information, etc.) are shown underneath the workspace.
28. **Project/Folder 1**: Press this button to view only project files in the Browser. Press and hold Shift and press this button to select the Browser’s Folder 1 shortcut.

29. **Sequence/Folder 2**: Press this button to view only sequence files in the Browser. Press and hold Shift and press this button to select the Browser’s Folder 2 shortcut.

30. **Program/Folder 3**: Press this button to view only program files in the Browser. Press and hold Shift and press this button to select the Browser’s Folder 3 shortcut.

31. **Sample/Folder 4**: Press this button to view only sample files in the Browser. Press and hold Shift and press this button to select the Browser’s Folder 4 shortcut.

32. **No Filter/Folder 5**: Press this button to view all files in the Browser. Press and hold Shift and press this button to select the Browser’s Folder 5 shortcut.

---

**Transport & Recording Controls**

33. **Play**: Press this button to play the sequence from the playhead’s current position.

34. **Play Start**: Press this button to play the sequence from its start point.

35. **Stop**: Press this button to stop playback. You can double-press this button to silence audio that is still sounding once a note stops playing. Quickly pressing this button three times will act as a “MIDI panic” and shut off all voices and stop all audio processing.

36. **Rec**: Press this button to record-arm the sequence. Press Play or Play Start to start recording. Recording in this way (as opposed to using **Overdub**) erases the events of the current sequence. After the sequence plays through once while recording, Overdub will be enabled.

37. **Overdub**: Press this button to enable Overdub. When enabled, you can record events in a sequence without overwriting any previously recorded events. You can enable Overdub before or during recording.

38. **</>/ (Event</>): Use these buttons to move the playhead left or right, one step at a time.

    Press and hold Locate and press one of these buttons to move the playhead to the previous/next event in the sequence grid.

39. **</>> (Start/End)**: Use these buttons to move the playhead left or right, one bar at a time.

    Press and hold Locate and press one of these buttons to move the playhead to the start or end of the sequence grid.

40. **Locate**: Press and hold this button to activate the secondary functions of the </> and </>> buttons (i.e., Event </> and Start/End, respectively).

41. **Erase**: As a sequence is playing, press and hold this button and then press a pad to delete the note event for that pad at the current playback position. This is a quick way to delete note events from your sequence without having to stop playback. See Operation > General Features > Erase to learn more.

42. **Tap Tempo**: Press this button in time with the desired tempo to enter a new tempo (in BPM). You can set how many taps are required in the Preferences (see Operation > General Features > Preferences to learn how to do this).

    Press and hold Shift and press this button to set whether the currently selected sequence follows its own tempo or a master tempo.

---

**I/O & Level Controls**

43. **Phono/Line Switch**: Use this switch to select the Mic In or Phono In jacks on the rear panel. If you are using a mic or other line-level audio source connected to the Mic In jacks, select Mic In. If you are using a phono-level device like a turntable connected to the Phono In jacks, select Phono In.

44. **Rec Gain**: Use this knob to adjust the gain of the incoming signal from the inputs (Mic In Left/Right or Phono In L/R) on the rear panel. Use the level meter above the Mic In/Phono In switch to check the recording level. Be careful when setting this knob at higher levels, which can cause the signal to distort.
45. **Direct Mon**: Turn this knob to adjust the balance between the input and output signals in the headphones.

   - **Input** corresponds to the input signal—all devices connected to the inputs on the front and rear panels. While recording, you can turn this knob all the way to **Input** for zero-latency direct monitoring.

   - **Comp** corresponds to the output signal—the signal sent from the **Stereo Out L/R** outputs on the rear panel. When you are not recording, we recommend turning this knob all the way to the **Comp** position to hear the full-volume playback signal.

46. **Main Volume**: Turn this knob to adjust the volume level of the **Stereo Out L/R** outputs.

47. **Vintage Mode**: Press this to toggle through the available Vintage Modes. The MPC3000 and MPC60 settings emulate the sounds of those classic MPCs, while the **Other** setting emulates the sound of vintage sampling drum machines. When none of the LEDs are lit, Vintage Mode is off.

### Front Panel

1. **Footswitch Inputs (FS 1/2) (1/4” / 6.35 mm)**: Connect optional 1/4” (6.35 mm) TS footswitches to these inputs.

2. **Mix**: Turn this knob to adjust the balance between the **Main** and **Assign** signals in your headphones. **Main** is the signal sent from the **Stereo Out L/R** outputs. **Assign** is the signal sent from the **Assignable Mix Outs 1/2**.

3. **Headphone Outputs (1/8” or 1/4” / 3.5 mm or 6.35 mm)**: Connect your headphones (not included) to either or both of these standard stereo outputs. Use the **Mix** knob to determine what signal is heard in the headphones. Turn the **Headphone Volume** knob to set the volume level.

4. **Headphone Volume**: Turn this knob to adjust the volume of the headphone outputs.
1. **Power Input**: Use the included power adapter (12 VDC, 2 A, center-positive) to connect MPC Renaissance to a power outlet. This must be connected to a power outlet in order for MPC Renaissance to power on.

2. **Power Adapter Restraint**: Secure the power adapter cable to this restraint to prevent it from accidentally unplugging.

3. **Power Switch**: Press this button to turn MPC Renaissance’s power on or off.

4. **Computer USB Port** (USB Type B): Use the included USB cable to connect this high-retention-force USB port to an available USB port on your computer. This connection allows MPC Renaissance to send/receive MIDI and audio data to/from the MPC software on your computer.

5. **USB Hub Ports A/B** (USB Type A): Connect USB flash drives or MIDI controllers to these high-speed USB 2.0 ports. These USB ports supply power to connected USB devices and can also be used to receive MIDI messages from external USB MIDI devices, which will be sent to the computer.

6. **Stereo Out L/R** (1/4” / 6.35 mm): Use standard 1/4” (6.35 mm) TRS cables to connect these outputs to your speaker system. The signal sent out of these outputs is the master mix. Turn the **Main Volume** knob to set their volume.

   **Tip**: To route a program to these outputs, set its routing to **Out 1,2** in the **Channel Mixer** when the **Mixer** field is set to **Programs**. See **Operation > Modes > Channel Mixer** to learn more about this.

7. **Assignable Mix Out 1/2** (1/4” / 6.35 mm): Use standard 1/4” (6.35 mm) TRS cables to connect these outputs to an external mixer. The signal sent from these outputs is full-volume (0 dB).

   **Tip**: To route a program to these outputs, set its routing to **Out 3,4** in the **Channel Mixer** when the **Mixer** field is set to **Programs**. See **Operation > Modes > Channel Mixer** to learn more about this.

8. **S/PDIF In/Out**: Use standard RCA cables to connect these jacks to devices that can send/receive digital audio.

9. **Mic In Left/Right** (XLR or 1/4” / 6.35 mm): Use standard XLR or 1/4” (6.35 mm) TRS cables to connect these inputs to audio sources (microphone, mixer, synthesizer, etc.). Turn the **Rec Gain** knob to set the input level.

10. **Mic/Line**: Set this switch appropriately for the device you connected to the **Mic In Left/Right** inputs. If your sound source is a microphone, set it to **Mic**. If your sound source is a line-level device, like an external mixer or keyboard, set it to **Line**.

11. **Phantom Power**: This switch activates and deactivates phantom power for the **Mic In Left/Right** inputs. When activated, +48V of phantom power will be supplied to both inputs. Note that most dynamic microphones do not require phantom power, while most condenser microphones do. Refer to your microphone’s documentation to check if it needs phantom power.

12. **Phono In L/R** (1/4” / 6.35 mm or RCA): Use standard 1/4” (6.35 mm) TRS cables or stereo RCA cables to connect these inputs to audio sources (mixer, turntable, synthesizer, etc.). To use the 1/4” (6.35 mm) inputs, set the **Phono/Line** switch to **Line**. To use the RCA inputs, set the **Phono/Line** switch to **Phono**. Turn the **Rec Gain** knob to set their input levels.

13. **Phono/Line**: Set this switch appropriately for the device you connected to the **Phono In L/R** inputs. If your sound source is a phono-level turntable, set it to **Phono**. If your sound source is a line-level device, like an external mixer or keyboard, set it to **Line**.

14. **Grounding Terminal**: If you are sending a phono-level turntable signal to the **Phono In L/R** inputs and are hearing a low hum or buzz, it could mean that the turntable is not grounded. If the turntable has a grounding wire, connect it to this terminal.

   **Note**: Some turntables have a grounding wire built into the RCA connection and, therefore, nothing needs to be connected to the grounding terminal.

15. **MIDI In**: Use standard 5-pin MIDI cables to connect these inputs to the MIDI outputs of optional external MIDI devices.

16. **MIDI Out**: Use standard 5-pin MIDI cables to connect these outputs to the MIDI inputs of optional external MIDI devices.
Power & I/O

1. **Power Switch**: Press this button to turn MPC Studio's power on or off.

2. **Computer USB Port** (USB Type B): Use the included USB cable to connect this high-retention-force USB port to an available USB port on your computer. This connection allows MPC Studio to send/receive MIDI and audio data to/from the MPC software on your computer.

3. **MIDI In**: Use standard 5-pin MIDI cables to connect these inputs to the MIDI outputs of optional external MIDI devices.
   
   **Important**: Do not connect audio devices (e.g., headphones, monitors, etc.) to the MIDI In. Use the included 1/8”-to-5-pin adapters to connect MIDI devices only.

4. **MIDI Out**: Use standard 5-pin MIDI cables to connect these outputs to the MIDI inputs of optional external MIDI devices.
   
   **Important**: Do not connect audio devices (e.g., headphones, monitors, etc.) to the MIDI Out. Use the included 1/8”-to-5-pin adapters to connect MIDI devices only.
Navigation & Data Entry Controls

5. **Display**: This LCD shows all the information relevant to MPC Studio's current operation. Much of this information is also shown in the software. Use the **cursors** to navigate through the display, and use the **data dial**, and +/- buttons to adjust the currently selected setting/parameter. Use the **Mode** buttons to change what page is shown, and use the **function buttons** to change what tab is shown.

   **Tip**: You can adjust the display contrast by holding down **Shift** and turning the **data dial**.

6. **Function Buttons**: Press one of these buttons to select its corresponding tab, shown above the button in the display.

7. **Cursors**: Press these buttons to navigate through the fields of menus and options shown on the screen.

8. **Data Dial**: Use this dial to scroll through the available menu options or adjust the parameter values of the selected field on the screen.

9. +/-: Press these buttons to increase or decrease the value of the selected field on the screen.

10. **Numeric**: If the selected field on the screen is a number, press and hold this button, and use the **pads** as you would on a standard numeric keypad to enter a value. The pads' values are written above in **green** and will be lit **green** while as you press and hold this button.

11. **Undo/Redo**: Press this button to undo your last action. Press and hold **Shift** and press this button to redo the last action you undid.

Pad & Q-Link Controls

12. **Q-Link Knobs**: Turn these touch-sensitive knobs to adjust various parameters and settings. The knobs can control one column or row of parameters at a time. Use the **Scroll Knob** above them to change which column or row of parameters they currently control.

   In modes where the display shows a 4x4 array of parameters, you will see an additional indicator on the top or left side of the array, indicating the currently controlled row/column.

13. **Scroll**: Turn this knob to change which column or row of parameters the **Q-Link knobs** currently control.

14. **Q-Link Trigger**: Press this button to cycle through the three global automation states: **Off**, **Read** (solidly lit), and **Write** (flashing). See **Operation > General Features > Automation** to learn more about this.

15. **Pads**: Press these pads to trigger drum hits or other samples in your software. The pads are velocity-sensitive and pressure-sensitive, which makes them very responsive and intuitive to play. The pads will light up different colors, depending on how hard you play them (ranging from yellow at a low velocity to red at the highest velocity). You can also customize their colors.

16. **Pad Bank**: Press these buttons to access Pad Banks A–D.

   Press and hold **Shift** while pressing these buttons to access Pad Banks E–H. Alternatively, double-press one of these buttons.

17. **Pad Assign/Pad Copy**: Press this button to assign samples and specific colors to your pads in each program. See **Operation > General Features > Automation** to learn more about this.

   You can also use this button to copy the samples and parameters from one pad to another. Hold **Shift** and press this button to open the **Copy Pad** window. In the **From Pad** field, press the “source” pad. Use the **cursors** to select the **To Pads** field, and then press the “destination” pads. Press **F5 (Do It)**—the samples and parameters will be copied automatically from the source pad to the destination pad.

18. **Full Level/Half Level**: Press this button to activate or deactivate the Full Level feature. When activated, the pads will always trigger their samples at the maximum velocity (127), regardless of how much force you use.

   Press and hold **Shift** and then press this button to activate or deactivate the Half Level feature. When activated, the pads will always trigger their samples at half-velocity (64).
19. **16 Level**: Press this button to activate/deactivate 16 Level. When activated, the last pad that was hit will be temporarily copied to all 16 pads. The pads will now output the same note number as the initial pad, but a selectable parameter will be fixed at values that increase as the pad numbers increase (e.g., Pad 1 is the minimum, Pad 16 is the maximum), regardless of how hard you press them. In the screen that appears, use the **Type** selector to choose the parameter: Velocity, Tune, Filter, Layer, Attack, or Decay. See Operation > General Features > 16 Level to learn more.

20. **Note Repeat/Latch**: Press and hold this button, and then press a pad to trigger that pad’s sample repeatedly. The rate is based on the current tempo and Time Correct settings.

   Press and hold **Shift** and then press this button to “latch” the Note Repeat feature. When latched, you do not have to hold the Note Repeat button for it to be activated. Press **Note Repeat** once more to unlatch it.

---

**Mode & View Controls**

**Note**: See Operation > Modes to learn about the different modes you can access with these controls.

21. **Shift**: Press and hold this button to access some buttons’ secondary functions (indicated by **red** writing).

   Double-press this button to see which buttons have secondary functions—the buttons will flash for a few seconds.

22. **Main/Track**: Press this button to enter Main Mode.

   Press and hold **Shift** and press this button to enter the Track View.

23. **Browser/Save**: Press this button to view the Browser. The Browser lets you navigate your computer’s internal hard disk to load samples, sequences, songs, etc. Using filter buttons and user-definable folders, you can easily adapt it to your workflow. You can also preview samples before loading them.

   Press and hold **Shift** and press this button to save the current project (including its samples, programs, sequences, and songs).

24. **Prog Edit/Q-Link**: Press this button to view Program Edit Mode, which contains all parameters for editing your programs.

   Press and hold **Shift** and press this button to enter Q-Link Edit Mode, where you can determine what the Q-Link knobs control in other modes.

25. **Prog Mix/Track Mix**: Press this button to view the Pad Mixer where you can set a program’s levels, stereo panning, routing, and effects.

   Press and hold **Shift** and press this button to enter the Channel Mixer where you can set levels, stereo panning, and other settings for your tracks, programs, returns, submixes, and masters.

   **Important**: **Prog Mix** on your MPC hardware corresponds to the **Pad Mixer** in the MPC software. Similarly, **Track Mix** (or **Shift**+**Prog Mix/Track Mix**) on your MPC hardware corresponds to the **Channel Mixer** in the MPC software. This is due to the functionality changing as the software has evolved.

26. **Seq Edit/Effects**: Press this button to view the Edit Sequence screen where you can create or edit sequences.

   Press and hold **Shift** and press this button to enter the Effects page, where you can select and route effects as well as edit their parameters.

27. **Sample Edit/Sample Rec**: Press this button to view Sample Edit Mode where you can edit your samples using various functions and processes.

   Press and hold **Shift** and press this button to view the Sampler where you can record audio samples to use in your projects.

28. **Song/Other**: Press this button to enter Song Mode where you can arrange sequences in a specific order and/or repetition to create songs. You can edit the structure of a song during playback for easy, on-the-fly composing.

   Press and hold **Shift** and press this button to enter MIDI Control Mode, which lets you edit various MIDI parameters for the pads, Q-Link knobs, and certain buttons on your hardware.

29. **Step Seq**: Press this button to view the Step Sequencer where you can create or edit sequences by using the pads as “step buttons,” simulating the experience of a traditional step-sequencer-style drum machine.

30. **Next Seq**: Press this button to view Next Sequence Mode where you can trigger different sequences simply by playing the pads. This is useful for live performances, letting you change a song’s structure in real time.
31. **Track Mute/Pad Mute:** Press this button to view Track Mute Mode where you can easily mute tracks within a sequence or set mute groups for each track.

Press and hold **Shift** and press this button to view Pad Mute Mode where you can easily mute pads within a program or set mute groups for each pad within a program.

32. **Window/Full Screen:** When this button is lit, it means the selected field in the display contains additional parameters in a sub-window; press this button to access them. Use the **function buttons, cursors,** and **data dial** or +/- buttons to navigate the sub-window.

Press and hold **Shift** and press this button to switch between Full Screen and Half Screen Modes in the software. In Full Screen Mode, the workspace occupies the whole window. In Half Screen Mode, the parameter controls (Q-Link knobs, pads, sequence and track information, project information, etc.) are shown underneath the workspace.

33. **Project/Folder 1:** Press this button to view only project files in the Browser. Press and hold **Shift** and press this button to select the Browser’s Folder 1 shortcut.

34. **Sequence/Folder 2:** Press this button to view only sequence files in the Browser. Press and hold **Shift** and press this button to select the Browser’s Folder 2 shortcut.

35. **Program/Folder 3:** Press this button to view only program files in the Browser. Press and hold **Shift** and press this button to select the Browser’s Folder 3 shortcut.

36. **Sample/Folder 4:** Press this button to view only sample files in the Browser. Press and hold **Shift** and press this button to select the Browser’s Folder 4 shortcut.

37. **No Filter/Folder 5:** Press this button to view all files in the Browser. Press and hold **Shift** and press this button to select the Browser’s Folder 5 shortcut.

### Transport & Recording Controls

38. **Play:** Press this button to play the sequence from the playhead’s current position.

39. **Play Start:** Press this button to play the sequence from its start point.

40. **Stop:** Press this button to stop playback. You can double-press this button to silence audio that is still sounding once a note stops playing. Quickly pressing this button three times will act as a “MIDI panic” and shut off all voices and stop all audio processing.

41. **Rec:** Press this button to record-arm the sequence. Press **Play** or **Play Start** to start recording. Recording in this way (as opposed to using **Overdub**) erases the events of the current sequence. After the sequence plays through once while recording, Overdub will be enabled.

42. **Overdub:** Press this button to enable Overdub. When enabled, you can record events in a sequence without overwriting any previously recorded events. You can enable Overdub before or during recording.

43. **Step */* (Event */*|): Use these buttons to move the playhead left or right, one step at a time.

Press and hold **Go To** and press one of these buttons to move the playhead to the previous/next event in the sequence grid.

44. **Bar */* (Start/End): Use these buttons to move the playhead left or right, one bar at a time.

Press and hold **Go To** and press one of these buttons to move the playhead to the start or end of the sequence grid.

45. **Go To:** Press and hold this button to activate the secondary functions of the */* and */* buttons (i.e., **Event */*| and Start/End, respectively).

46. **Erase:** As a sequence is playing, press and hold this button and then press a pad to delete the note event for that pad at the current playback position. This is a quick way to delete note events from your sequence without having to stop playback. See **Operation > General Features > Erase** to learn more.

47. **Tap Tempo:** Press this button in time with the desired tempo to enter a new tempo (in BPM). You can set how many taps are required in the Preferences (see **Operation > General Features > Preferences** to learn how to do this).

Press and hold **Shift** and press this button to set whether the currently selected sequence follows its own tempo or a master tempo.
Basic Concepts

This chapter should help explain some fundamental aspects of the MPC universe.

The MPC workflow is quite different from traditional digital audio workstations (DAWs). In most typical DAWs, each track uses an instance of each instrument, and all tracks are always playing even if they don’t contain any audio or MIDI information. Furthermore, your entire project needs to be arranged just as the resulting song would be. This isn’t the case with MPC, which offers much more flexibility within your project. It’s important to understand some basic terms, though:

A **sequence** is a “building block” of a song. It contains multiple tracks that play at the same time like a normal DAW. In a project, you might create one sequence for your verse and another sequence for your chorus, alternating and/or repeating each one in a specific order to create the song. (A project can contain 128 sequences.)

A **track** is a layer in a sequence. There are two types of tracks:

- **MIDI tracks** consist of MIDI data only, no audio data. These tracks produce sound by using **programs**, described below. Unlike a normal DAW, each MIDI track exists only in its sequence. The advantage of this is not having to manage empty or unwanted tracks across all of your sequences—each sequence contains only the tracks you want to use in it. If you want to use the same track across multiple sequences, you can copy the track from one sequence into another. (A sequence can contain 128 MIDI tracks.)

- **Audio tracks** consist of a recorded audio signal, like a traditional DAW. These tracks do **not** use programs because the audio is already contained in the track. Also, unlike MIDI tracks, audio tracks are present in every sequence in the project, even if the tracks themselves are empty. (A sequence can contain 128 audio tracks.)

A **program** is a preset through which MIDI tracks are routed. Programs may contain audio samples that are triggered when tracks play through them, producing the sound you want on that track. Programs are independent of tracks and sequences, so you can set multiple tracks to use the same program (unlike normal DAWs where each track requires its own set of samples). Furthermore, you can use the same program/programs across multiple sequences. (A project can contain 128 programs.)

Each program can be played using the **16 pads** (across eight pad banks, which gives you access to 128 pads in each program). Each pad plays a MIDI note when you press it, but that MIDI note will trigger something different for each program. For instance, in drum programs, the pads are assigned to samples—one pad could trigger a kick drum sound and another could trigger a snare drum sound—whereas in keygroup programs, each pad triggers a MIDI note that plays the corresponding pitch of the sample assigned to its keygroup.

Here’s a diagram to illustrate an example of how these pieces could work together:

Please take a look at the following **Tutorial** chapter, as well. It will walk you through the creation of a short song to show you some of your MPC hardware’s most important features.
This chapter should familiarize you with some basic MPC features. We’ll create a short song to illustrate some of the most important features. To get the most out of this chapter, we recommend reproducing each of the described steps.

Starting Up

Make sure you have completed all of the steps described in Introduction > Setup. This includes:

- Installing the most current drivers and software.
- Connecting your MPC hardware to a power source using the included power adapter and powering it on.
- Opening and authorizing your MPC software.

Creating a Drum Kit

Let’s start by making a simple drum kit.

1. Press Browser to show the Browser.
2. Find and load a kick drum sample:
   - To move through lists, use the data dial, −/+ buttons, or up and down cursors.
   - To view only samples while browsing, press Sample/Folder 5.
   - To move up one folder level, press the left cursor.
   - To enter a folder, select it and press the right cursor.
   - To load a selected file, press F6/Load.
   - To play a selected sound, press and hold F3/Play.
   - To enable or disable the audition function, press F2/Auto. When enabled, each sample file will automatically play when it is first selected.
After loading samples for a drum kit into the sample pool, assign a kick drum sound to a pad:

1. Press **Pad Assign**. The pads will be shown in a 4x4 array in the screen.
2. Make sure the **Sample** tab is selected (press F1/Sample).
3. Press the pad to which you want to assign the sample.
4. Use the **data dial** or -/+ buttons to select the kick drum sample. Its name will appear in the pad in the screen.

Now, you can press **Pad 1** to play the kick drum sample.

**To create a simple drum kit**, repeat the above steps for other pads. We recommend loading a snare drum, a closed hi-hat, and an open hi-hat.

### Creating a Drum Sequence

Now that your drum kit is set up, let’s record a drum sequence.

1. Press **Main** to enter Main Mode.
2. Press **Tap Tempo** repeatedly at the speed you want to record your sequence. Your MPC hardware will detect the rate and adjust itself automatically.
3. Press **Rec** to record-arm the sequence.
4. Press **Play** to start the actual recording. You will hear the count-in for one measure before the recording starts. We recommend recording only one sound (pad) at a time, especially if you’re not familiar with playing drums on the pads.
5. Play a simple kick drum pattern. The note events you just recorded will automatically be placed in the grid (in this case, on 16th notes). The initial measure length is two bars. After the two bars, the recording will automatically activate Overdub; the sequence will play again from the beginning and keeps looping, allowing you to record further notes. Don’t stop the recording!
6. Play the snare drum part, then a hi-hat part.
7. When you’re done recording, press **Stop**.

If you start recording again on this sequence, keep in mind that the pads you play in your new recording will replace existing notes played with the same pads. To prevent this, press **Overdub** before recording instead of the Rec button. Overdub lets you record additional note events over the existing sequence.

The **Undo** button functions differently while recording. Normally, pressing **Undo** will undo just the last event. When there is an event to undo, the **Undo** button will be lit solid. While recording, the **Undo** button will flash. In this case, pressing **Undo** will erase all events from that recording (i.e., since **Play** or **Play Start** was pressed).
Saving & Renaming

We recommend doing some renaming of your programs and samples before going further. The collection of drum samples you loaded earlier (and their respective pad assignments) are arranged into a program. When you load this program in the future, you will be able to use all of the samples that belong to it.

Use the MPC software window to name your program and samples, and then save your project.

To see the user guide in the MPC software and learn how to do this, click the Help menu, select MPC Help, and select MPC User Manual.

Making Basic Sound Edits

Let’s make sure the samples are properly tuned and have good levels.

Press Prog Edit to enter Program Edit Mode.

Press a pad to show its parameters on the screen. Make sure the Master tab is selected (press F1/Master).

To adjust its volume, turn Q-Link Knob 10 (MPC Renaissance) or the second Q-Link knob in the second row (MPC Studio). Alternatively, use the cursors to select Level and then use the data dial or +/- buttons to adjust it.

To adjust its stereo panning, turn Q-Link Knob 11 (MPC Renaissance) or the third Q-Link knob in the second row (MPC Studio). Alternatively, use the cursors to select Pan and then use the data dial or +/- buttons to adjust it.

Adjust the level of each pad to suit your taste. We recommend spreading the panning of the bright sounds (e.g., cymbals, snare drum) a little. Additionally, you can tune the sound by adjusting the Semi and Fine parameters using Q-Link Knobs 14 and 15 (MPC Renaissance) or the second and third Q-Link knobs in the first row (MPC Studio).

The snare drum may need some reverb to give it a more spatial sound.

Press F6/Effects to view the Effects tab. Press the pad with your snare drum sound to select it.
To add an effect:

1. Use the cursors to select the Insert 1 slot.
2. Use the data dial or –/+ buttons.
3. In the Select Effect screen that appears, use the data dial, –/+ buttons, or up and down cursors to move through the list.
4. Select Reverb Medium and then press F4/Select to load it.

To adjust the effect's parameters, select its name, and then press Window. In the screen that appears, use the Q-Link knobs to adjust the parameters. Alternatively, use the cursors to select a parameter, and use the data dial or –/+ buttons.

To turn the effect on or off, press F6/On/Off.

To remove the effect, select its name, and then load an effect as described above, but select <none> instead of an actual effect.
Creating a Bass Track

Let's try recording a bass line. Unlike a drum kit, it's important to be able to play and record a bass sound chromatically, so this will be slightly different than setting up the drum kit.

Adding a bass line over the drum part means we need to work on a new track. A track is simply a layer of a sequence. Each track uses a program within your project. You can work with multiple tracks in a single sequence (e.g., a drum track, a bass track, a piano track, etc.). When you play the sequence, all of them will play simultaneously.

First, let's make an empty track.

To select a new track:
1. Press Main to go back to Main Mode.
2. Press F4/Track+ to select Track 002 – (unused). Alternatively, use the Trk field.

Let's create a new program for this track to use.

To create a new program:
1. Use the cursors to select the Pgm field, and then press Window.
2. In the Edit Program screen that appears, press F3/New.
3. In the New Program screen that appears, select Type, and set it to Keygroup. This indicates a keygroup program, which is necessary to play the bass sound chromatically with the pads.
   You are now using a keygroup program on your new track.
To load and edit a bass sound:

1. Press Browser to show the Browser, and use it to navigate to where your bass sounds are located, and load one to the project’s sample pool. (You can look at this earlier section if you forgot how to do this!)

2. After loading a bass sample to the sample pool, don’t use Pad Assign like you did when creating a drum program; keygroup programs are different.
   Instead, press Prog Edit to enter Program Edit Mode.

3. In Program Edit Mode, press F2/Samples to show the first Samples tab.

4. Make sure Layer in the upper-left corner is set to 1. Select the Smpl field, and then set it to the bass sample you just loaded to the sample pool. Because you’re working with a keygroup program instead of a drum program, this sample is now playable across all pads.
   Tip: On your MPC hardware, press the Pad Bank D button to switch to Pad Bank D and press Pad 13. You should hear the bass sample played back with its original pitch. You can use the other pads to play your sample chromatically.

Let’s add a second layer and set the layers’ velocity ranges so the bass will sound different when played at a higher velocity (as a real bass would):

1. Press Browser to show the Browser, and select a different bass sample that sounds similar but a little bit brighter, and load it to the project’s sample pool.

2. Return to Program Edit Mode, and in the first Samples tab, set Layer to 2, and set Smpl to the new bass sample. Press a pad to hear both samples will sound at once. Maybe this new sound is interesting as it is, but let’s make some quick edits to get as close as we can to a real-life bass sound.

3. Press F3/Pan Vel tab to show the panning and velocity parameters for each sample layer: S1–S4.

4. Set S1’s High setting to 80, and then do the same to set S2’s Low setting to 81. You can do this with Q-Link Knobs 15 and 10 (MPC Renaissance) or the first Q-Link knob in the third column and second Q-Link knob in the second column (MPC Studio), respectively.

Now when you press a pad, the lower velocities (0–80) will trigger the Layer 1 sample only, while higher velocities (81–127) will trigger the Layer 2 sample only.
Let's record that bass line now. Prepare your recording as described earlier, and record some bass notes. You can edit your recording just like we've done earlier.

Once you've recorded it, let's tweak the sound a bit in the Filter section.

1. In Program Edit Mode, press F4/Flt Env tab to show the filter and envelope parameters.
2. Set the Type to Low 4, a 4-pole low-pass filter by turning Q-Link Knob 13 (MPC Renaissance) or the first Q-Link knob in the first row (MPC Studio).
3. Turn Q-Link Knobs 14 and 15 (MPC Renaissance) or the second and third Q-Link knobs in the first row (MPC Studio) to adjust the Cutoff or Reso (resonance) settings until your bass sample sounds good to you.
4. Turn Q-Link Knobs 1 and 4 (MPC Renaissance) or the first and fourth Q-Link knobs in the fourth row (MPC Studio) to adjust the Amp Atk (attack) or Amp Rel (release) settings. These control the overall level characteristics of the sound.

Do you want to add an effect? Do this in the Effects tab like you did earlier.

1. Select the Insert 1 slot, and then use the data dial or +/- buttons.
2. In the Select Effect screen that appears, select Reverb Medium and then press F4/Select to load it.

So far, we've created a simple drum sequence and a bass line to go with it. Repeat this process to create a second sequence.
Recording an Audio Track

We’ve already created some MIDI tracks, so let’s record some actual audio for our next track:

1. Press Main to go back to Main Mode.
2. Press F2/Audio. 001 – Audio 001 will appear in the Trk field.
3. Connect a synthesizer or other line-level audio source to the XLR/1/4” (6.35 mm) input inputs on your MPC hardware’s rear panel, and set the Mic/Line selector to Line.
4. Set Input field to Input 1 or Input 1,2 (depending on your audio source).
5. Set Mon to AUTO—you will hear incoming audio while the track is record-enabled only.
6. Turn the Rec Gain knob to set the input level while playing your audio source. You should now see the level in the meter. Make sure it does not exceed the maximum level (the meter should not be “peaking” constantly).
7. If Mute or Solo are on, press F5/Mute or F6/Solo so they are off. Also, press Q-Link Trigger until it is off (not solidly lit or flashing).
8. Press Shift+F4/Rec Arm to record-enable the track.
9. Press Rec to record-arm the sequence.
10. To start recording, press Play or Play Start—then play your audio source! You should hear your existing sequence playing in the background.
   
   To stop recording, press Stop.

Record another audio track for your other sequence: Select the other sequence in Main Mode, and create another audio track (Audio 002) to go with that sequence.
Creating a Song

This section explains how to make a song out of your sequences. Before starting, make sure that you have recorded some sequences (which we described earlier).

To enter Song Mode, make sure playback is stopped, and then press Song.

In Song Mode, each of the sequences you’ve created in this project assigned to a pad. The sequence playlist is to the left of the pads, showing the song’s structure.

As a song plays, it moves through each step of the sequence playlist. Each step contains a sequence you assigned. Each step can be repeated, determined by the value in the Repeat column (the repeat icon; a value of 1 means the sequence will play through only once). The Bars column on the right shows the length of that sequence.

Each step can be set to play its sequence at an independent tempo, determined by the value in the BPM column.

Important: Each sequence has its own tempo, while the project itself may use a different master tempo. The BPM value for each sequence may be different from the master tempo. As long as playback is set to follow the master tempo, each sequence’s individual tempo will be ignored. By default, each project is set to use the sequence tempo, which you set back in the Creating a Drum Sequence chapter. We recommend pressing Shift+Tap Tempo (so that the top of the screen shows Mst instead of Seq) and entering a master tempo to ensure all sequences use the same tempo.

To insert a step at the current position, press F6/Insert.

To delete the currently selected step, press F5/Delete.

To set which sequence plays for a step, select the step’s Sequence field, and then use the data dial or −/+ buttons to select a sequence.

To set how many times a sequence repeats, select the step’s Rpts field, and then use the data dial or −/+ buttons to select a number.

Exporting the Song

Want to share your new song? Just export it first using the Audio Mixdown window in the MPC software. The Audio Mixdown window lets you render and export either the current sequence or song as an audio file. In Song Mode, this will export the entire song. In Main Mode, this will export the current sequence only.

To see the user guide in the MPC software and learn more about this, click the Help menu, select MPC Help, and select MPC User Manual.
Other Features Explained

This chapter describes various advanced features. For a fuller explanation of these features, please refer to their corresponding sections in the *Operation* chapter.

---

**Step Sequencer**

You’ve already learned how to record note events on a track, but you can quickly enter note events in the Step Sequencer by using the pads as “step buttons,” simulating the experience of a traditional step-sequencer-style drum machine.

To enter the Step Sequencer, press *Step Seq*.

Let’s create a sequence on a new track:

1. Select *Trk* and select an *(unused)* track.
2. Select *Len* and set a length for the track. If you select the minimum value, *SEQ*, the track will be however long your sequence is.
   
   **Tip:** This lets you maintain tracks of different lengths. For instance, you could play a 1-bar drum sequence repeatedly under a 4-bar bass line.

3. Press *F2/Bar–* or *F3/Bar+* to select the bar whose steps you want to create or edit. The bar number will appear in the *Bar* field at the top of the screen.
4. Press *F5/Pad–* or *F6/Pad+* to select the pad whose steps want to create or edit. The pad number will appear in the *Pad* field at the top of the screen.
5. Press *Play* to start your sequence.
6. Each pad represents a step in the bar. If the pad already has note events on the selected track, the corresponding pads (steps) will be lit with colors corresponding to their velocities.

   **To enter a note at a step,** press an **unlit pad**. The pad will light up with a color corresponding to its velocity.

   **To delete the note from a step,** press a **lit pad**. The pad will become unlit.

See *Operation > Modes > Step Sequencer* to learn more about this feature.
Drum Loops & Chop Mode

Modern music producers often use drum loops to add grit and nuance to programmed beats. This section explains how to use Sample Edit Mode to work with drum loops.

Use the Browser to locate a drum loop, and then double-tap it to add it to the current program. The loop does not have to match the tempo of anything in the project.

To enter Sample Edit Mode, press Sample Edit.

1. Use the Sample field at the top of the screen to select the loaded drum loop. You can scroll through all loaded samples in the project.
2. Press F1/Trim/Chop to switch between Trim Mode and Chop Mode. Select Chop Mode, which will let us cut the drum loop into slices.
3. Set the Chop To field to Threshold, and then use the Threshold field to select a value. The lower the threshold, the more slices will be created. Be sure to select a value so that every transient peak of the drum loop has a corresponding a slice marker.

Tip: Each slice will be automatically assigned to a pad: Pad A01 plays Slice 1, Pad A02 plays Slice 2, etc. Press each pad to play the slice with the same number.

Let’s use this chopped sample to create a new program in which each of these slices is an individual sample. We can also automatically create corresponding note events to play back these slices sequentially.

1. Press and hold Shift and then press F4/Convert to screen to show the Convert or Assign Slices screen.
2. Set Convert To to New Program with New Samples.
3. Set Crop Samples to ON.
4. Set Create New Program to ON.
5. Set Create Events to ON.
6. Set Number Of Bars to the number of bars the entire sample should use in your program.
7. Press F5/Do It to proceed. Each slice will be assigned to a pad, and each pad will have a recorded note event in the track. When you play that track, it will play each pad (each slice) in the original order.
8. Press Play and listen to how the drum loop matches your song tempo now.
You can also edit the note events of the drum loop slices—enter Main Mode to do this. A new track with the note events playing their corresponding slices has been automatically created. Press \textit{Shift+F1/T.C.} to use the \textbf{Timing Correct} screen to quantize the note events so they fall on exact, even time intervals.

You can also rearrange the note events, thus creating a new playback order for the slices. You can also edit each slice or sample in Program Edit Mode. You can add effects for slices or use the filter function to change the frequency range of a selected slice. There are almost no limits to what you can do.

See \textit{Operation > Modes > Sample Edit Mode > Chop Mode} to learn more about this feature.
Pad Muting & Track Muting

Pad Mute Mode and Track Mute Mode let you silence different pads and tracks to see what the sequence sounds like without those samples or parts.

To enter Pad Mute Mode, press Shift + Track Mute/Pad Mute.

<table>
<thead>
<tr>
<th>Program/Drums</th>
</tr>
</thead>
<tbody>
<tr>
<td>SnrSm12</td>
</tr>
<tr>
<td>SnrSm13</td>
</tr>
<tr>
<td>EXCESSIVE Cl</td>
</tr>
<tr>
<td>REVOLUTION Cl</td>
</tr>
<tr>
<td>1980Crash</td>
</tr>
<tr>
<td>1980RideA</td>
</tr>
<tr>
<td>1980RideB</td>
</tr>
<tr>
<td>Glass</td>
</tr>
<tr>
<td>1980Hatcl</td>
</tr>
<tr>
<td>1980HatDr</td>
</tr>
<tr>
<td>Side11</td>
</tr>
<tr>
<td>Side12</td>
</tr>
<tr>
<td>1980Kick1</td>
</tr>
<tr>
<td>1980Kick</td>
</tr>
<tr>
<td>SnrSm111</td>
</tr>
<tr>
<td>1980Snare</td>
</tr>
<tr>
<td>PadMute</td>
</tr>
<tr>
<td>PadGroup</td>
</tr>
<tr>
<td>Time Div</td>
</tr>
<tr>
<td>T.C.</td>
</tr>
</tbody>
</table>

1. Press **Play** to play the sequence.
2. Use the **Program** field to select your drum program.
3. Mute or unmute a pad by pressing it. The muted pad will be lit **red**. You can mute multiple pads at the same time.

See **Operation > Modes > Pad Mute Mode** to learn more about track mutes.

You can also mute entire tracks by using the similar Track Mute function.

To enter Track Mute Mode, press **Track Mute**.

<table>
<thead>
<tr>
<th>Time Div</th>
<th>T.C.</th>
<th>Solo</th>
</tr>
</thead>
<tbody>
<tr>
<td>TrkMute</td>
<td>TrkGroup</td>
<td></td>
</tr>
</tbody>
</table>

1. Press **Play** to play the sequence.
2. Use the **Sequence** field to select the desired sequence.
3. Each pad is assigned to a track. Mute or unmute a track by pressing the corresponding **pad**. The pad will be lit **red**. You can mute multiple tracks at the same time.

**Tip:** To mute a track only at precise note intervals (“quantizing” your mutes, essentially), press **F4/Time Div** to set a musical timing value. Use the **Note Value** field to set the quantization value, and then press **F4/Close** to return to the Track Mute screen. Now, when you press a pad in Track Mute Mode, the mute will occur precisely at the beginning of the following time division (in this example, one bar). This lets you test musical combinations of patterns—the preliminary stage to building a song structure.

See **Operation > Modes > Track Mute Mode** to learn more about track mutes.
This section describes recording new samples of your own, which you can use in your projects.

**Important**: To record any audio, you need to connect an audio source to your MPC hardware or to your computer’s audio interface.

**To open Sample Record Mode**, press Shift+Sample Edit/Sample Rec.

1. Connect an audio source to the input/inputs of your MPC hardware.
2. Make sure Input is set to In 1,2 (the inputs of your MPC hardware).
3. Turn the Rec Gain knob to set the input level while playing your audio source. You should now see the level in the meter. Make sure it does not exceed the maximum level (the meter should not be “peaking” constantly).
4. Set the Threshold field to a fairly low level (e.g., -50 dB).
5. Press F6/Record to record-arm the sampler.
6. Play your audio source. The Sampler will start recording immediately when the input level reaches the threshold value. Alternatively, press F6/Start to manually start recording.
7. **To stop recording**, press F6/Stop. The Keep or Discard Sample window will appear.

In the Keep or Discard Sample window:

- **To assign the new sample to a program**, use the Prg field.
- **To assign the sample to a pad in the program**, select the Assign to Pad field, and then press the desired pad. Alternatively, use the data dial or +/- buttons to select the desired pad number.
- **To confirm your selections**, press F5/Keep.
- **To discard the recording and return to the previous screen**, press F4/Discard.
- **To play the recording**, press F2/Play.

See **Operation > Modes > Sample Record Mode** to learn more about this feature.
Sample Editing

You may need to edit your newly recorded samples using Sample Edit Mode.

To enter Sample Edit Mode, press Sample Edit.

In Sample Edit Mode:

To switch between Trim Mode and Chop Mode, press F1/Trim/Chop. In this example, set it to Trim.

To set the sample's start point, use Q-Link Knobs 1, 5, 9, and 13 (MPC Renaissance) or the first column of Q-Link knobs (MPC Studio) to adjust the start point with varying degrees of resolution. Alternatively, use the Start field.

To set the sample's end point, use Q-Link Knobs 2, 6, 10, and 14 (MPC Renaissance) or the second column of Q-Link knobs (MPC Studio) to adjust the end point with varying degrees of resolution. Alternatively, use the End field.

To hear your edits, press Pad 10 to play the sample from the start point to the end point.

Let's apply some processing to the sample.

To open the Process Sample window, press F6/Process.

1. Use the data dial or +/- buttons to select the desired process in the Function field. Let's select Pitch Shift to change the overall pitch of your sample. This will transpose the sample without affecting its length.

2. To set the pitch shift amount, use the cursors to select the integer or decimal Pitch fields, and use the data dial or +/- buttons to adjust the value. Alternatively, use the numeric keypad (MPC Renaissance) or press and hold Numeric and use the pads (MPC Studio) to enter a value.

3. To confirm your selections, tap Do It.

To cancel the process, tap Cancel.

See Operation > Modes > Sample Edit Mode to learn more.

Recording Automation

Automating various parameters is a good way to add some motion and dynamism to your sequences.

To see the user guide in the MPC software and learn more about this, click the Help menu, select MPC Help, and select MPC User Manual.
Operation

This chapter explains the complete features and functions of your MPC hardware.

Navigating the MPC Hardware Screen

Below is some important information about using your MPC hardware controls to navigate what is shown in its screen.

The screen on your MPC hardware reflects what it is controlling in the software, but due to space and character limitations, the hardware screen is slightly different (e.g., parameter names may be abbreviated, the layout may be different or spread across multiple tabs, etc.).

Use the cursors to select any of the fields shown in the screen. You can also use the up and down cursors to move through lists.

Turn the data dial or press the +/- buttons to change the setting or value of the currently selected (highlighted) field in the screen. You can also use these controls to move through lists.

If the selected field is a number, you can use the numeric keypad to enter a number and then press Enter to confirm it. On the MPC Renaissance, this is the set of 12 buttons above the transport controls. On the MPC Studio, press and hold Numeric, and then use the pads that are lit green.

When the Window button is lit, it means the selected field in the screen contains additional parameters in a sub-window. Press Window to access them.

When accessing the secondary functions of buttons on your MPC hardware, you can do this one of two ways: (1) pressing and holding Shift and then pressing the desired button or (2) double-pressing the desired button. This manual describes these operations using only the first option, but both are acceptable.

Almost every mode shown on the screen has 1–6 buttons at the bottom. Each of these buttons select a different tab in that mode or perform a specific function in that mode.

In addition to the six buttons at the bottom of the screen, there are often additional ones you can use when you press and hold Shift. Press and hold Shift to show the secondary buttons, and any of them, if desired. Release Shift to return to the previous buttons.

While the MPC Renaissance has 16 Q-Link knobs, allowing direct access to all 16 parameters, the MPC Studio is equipped with 4 Q-Link knobs which need to be assigned to the corresponding Q-Link knob column or row by turning the Scroll knob above them. In modes where the screen shows a 4x4 array of parameters, you will see an additional indicator on the top or left side of the array, indicating the currently controlled column or row.
General Features

Programs

About Programs

Each track you create within a sequence is routed through a program. There are six types of programs, each of which determines how the track sounds or what it is used for. A single project can hold up to 128 programs.

This chapter covers how to create each program type.

To learn about editing your programs to your preference, see the Modes > Program Edit Mode chapter.

A drum program uses one or more samples as its sound source. It contains (1) a list of samples and (2) the settings for each sample (i.e., pad assignments, loop points, pitch tuning, effects, etc.). Drum programs are used mostly for creating drum parts and quickly and easily assigning samples to pads. See Drum Programs for more information.

A keygroup program uses one or more samples as its sound source. It contains (1) a list of samples and (2) the settings for each sample (i.e., pitch tuning, effects, etc.). Keygroup programs are used to play samples chromatically with a MIDI keyboard or the MPC pads. See Keygroup Programs for more information.

A clip program uses several samples that can be looped (clips). Each clip can be assigned to a pad, which you can press to trigger the clip according to a quantization setting. This lets you create intriguing, layered performances by launching different combinations of clips together. See Clip Programs for more information.

A plugin program contains an instance of a plugin through which you can send your track’s MIDI data. See Plugin Programs for more information.

A MIDI program lets you send your track’s MIDI data to an external MIDI device like a synth or drum machine. See MIDI Programs for more information.

A CV program lets you send your track’s MIDI data to an external MIDI device that uses control voltage (CV), like a synth. See CV Programs for more information.
Drum Programs

A drum program uses one or more samples as its sound source. It contains (1) a list of samples and (2) the settings for each sample (i.e., pad assignments, loop points, pitch tuning, effects, etc.). Drum programs are used mostly for creating drum parts and quickly and easily assigning samples to pads.

To create a drum program:
1. Press Main to enter Main Mode.
2. Use the cursors to select Pgm, and press Window.
4. In the New Program screen that appears, set the Type field to Drum.
5. Press F5/Do It to create the program or F4/Cancel to return to Main Mode without creating the program.

To load a sample into a drum program:
1. Press Pad Assign. The pads will be shown in a 4x4 array in the screen.
2. Use the Program field to select the desired program.
3. Press F1/Sample so that the Sample tab is selected.
4. Press the pad to which you want to assign the sample.
5. Use the data dial or +/- buttons to select the desired sample. Its name will appear in the pad in the screen.
   Now, you can press that pad to play the assigned sample.

To clear the assigned sample from a selected pad, set it to the “minimum” value so the pad in the screen is blank.

To assign samples to additional pads, repeat Steps 4–5.

Alternatively, assign samples in a drum program in Program Edit Mode in one of these two ways:

Tip: On your MPC hardware, press the Pad Bank D button to switch to Pad Bank D and press Pad 13. You should hear the bass sample played back with its original pitch. You can use the other pads to play your sample chromatically.

1. While using the program, press Prog Edit to enter Program Edit Mode.
2. Press F2/Samples to show the first Samples tab.
3. Press the pad to which you want to assign the sample.
4. Set Layer to the number of the desired layer: 1–4.
5. Set Smpl to the desired sample.

1. While using the program, press Prog Edit to enter Program Edit Mode.
2. Press F2/Samples to show the second or third Samples tab. This lets you view the samples assigned to all four layers of the current pad as well as the different settings of each layer.
3. Press the pad to which you want to assign the sample.
4. Turn the first column of Q-Link Knobs to select the desired sample for Layer 1, 2, 3, or 4 (respectively). Alternatively, use the S1–4 fields.
Keygroup Programs

A keygroup program uses one or more samples as its sound source. It contains (1) a list of samples and (2) the settings for each sample (i.e., pitch tuning, effects, etc.). Keygroup programs are used to play samples chromatically with a MIDI keyboard or the MPC pads.

To create a keygroup program:
1. Press Main to enter Main Mode.
2. Use the cursors to select Pgm, and press Window.
4. In the New Program screen that appears, set the Type field to Keygroup.
5. Press F5/Do It to create the program or F4/Cancel to return to Main Mode without creating the program.

To assign samples in a keygroup program, use one of these two methods:

Tips:
To create complex keygroup programs, you can add more keygroups (up to 128). This is useful when working with multi-samples (e.g., when programming a real piano).

On your MPC hardware, press the Pad Bank D button to and press Pad 13. You should hear the sample played back with its original pitch. You can use the other pads to play your sample chromatically.

Remember that a keygroup program offers up to 128 keygroups, and each keygroup can hold up to four samples (Layers 1–4). This is a total of 512 samples.

1. While using the program, press Prog Edit to enter Program Edit Mode.
2. Press F1/Master to show the Master tab.
3. Use the Kg Select field to select the keygroup to which you want to assign the sample. Alternatively, press a pad that belongs to that keygroup.
4. Press F2/Samples to show the first Samples tab.
5. Set Layer to the number of the desired layer: 1–4.
6. Press the pad to which you want to assign the sample.
7. Set Smpl to the desired sample.

1. While using the program, press Prog Edit to enter Program Edit Mode.
2. Press F1/Master to show the Master tab.
3. Use the Kg Select field to select the keygroup to which you want to assign the sample. Alternatively, press a pad that belongs to that keygroup.
4. Press F2/Samples to show the second or third Samples tab. This lets you view the samples assigned to all four layers of the current pad as well as the different settings of each layer.
5. Press the pad to which you want to assign the sample.
6. Turn the first column of Q-Link Knobs to select the desired sample for Layer 1, 2, 3, or 4 (respectively). Alternatively, use the S1–4 fields.
Clip Programs

A clip program uses several samples that can be looped (clips). Each clip can be assigned to a pad, which you can press to trigger the clip according to a quantization setting. This lets you create intriguing, layered performances by launching different combinations of clips together.

By default, the 16 pads are divided into four columns of four pads. Each column represents a mute group; when a pad is playing a clip, all other pads in that same mute group are turned off. This enables you to launch a clip without having to manually stop other clips that are similar. For instance, pressing Pad 2 may launch a bass clip. You could then press Pad 6, which launches another bass clip and stops the clip on Pad 2. This way, you’ll never be playing two bass clips simultaneously.

The four-columns pad configuration described above is just a default to make things easy (e.g., you could use the first column for drum clips, the second for bass clips, the third for keyboard clips, and the fourth for vocal clips). You can use Program Edit Mode to assign pads to any combination of mute groups you want.

To create a clip program:
1. Press Main to enter Main Mode.
2. Use the cursors to select Pgm, and press Window.
4. In the New Program screen that appears, set the Type field to Clip.
5. Press F5/Do It to create the program or F4/Cancel to return to Main Mode without creating the program.

To load a clip into a clip program:
1. While using the program, press Prog Edit to enter Program Edit Mode.
2. Press F2/Pad.
3. Press a pad to select it (and play its assigned samples, if any).
4. Set Sample to the desired clip.
   - To clear the assigned clip from a selected pad, repeat Step 4, but select <none>.
   - To assign clips to additional pads, repeat Steps 3–4.

To clear the assigned clip from a selected pad, repeat Step 4, but select <none>.
To assign clips to additional pads, repeat Steps 3–4.
**Plugin Programs**

A plugin program contains an instance of a plugin through which you can send your track's MIDI data. This lets you use the same instance of a plugin with multiple tracks (rather than load an instance of a plugin on every track, which can be cumbersome and CPU-intensive).

**To create a plugin program:**
1. Press **Main** to enter Main Mode.
2. Use the **cursors** to select **Pgm**, and press **Window**.
3. Press **F3/New**.
4. In the **New Program** screen that appears, set the **Type** field to **Plugin**.
5. Press **F5/Do It** to create the program or **F4/Cancel** to return to Main Mode without creating the program.

**To select the plugin that the program will use:**
1. Press **Main** to enter Main Mode.
2. Use the **cursors** to select **Plg**, and use the **data dial** or −/+ buttons.
3. In the **Select Plugin** screen that appears, select a plugin.
   
   **Note:** To select a plugin here, you must have already loaded it in the MPC software's **Plugin Manager**. See the user guide in the MPC software to learn more: click the **Help** menu, select **MPC Help**, and select **MPC User Manual**.
4. Press **F4/Select** to select the plugin or **F3/Back** to return to Main Mode without selecting a plugin.
   
   **To select a preset in your plugin** (if any), select **Plg**, and press **Window**. In the list that appears, select the desired preset and press **F5/Select** to select it or **F4/Close** to return to Main Mode.

   **To select the MIDI channel the program will use**, use the **Ch** field. Use this setting when you are working with a virtual instrument plugin that supports multi-mode.

**To adjust the volume and panning of a track using the plugin program:**
1. Press **Shift+Prog Mix/Track Mix** to enter the Channel Mixer.
2. Set **Mixer** to **Tracks**.
3. Press **F1/Level** to view the velocity levels of all tracks or **F2/Pan** to view the panning of all tracks.
4. Select the field that corresponds to the track with the plugin program, and adjust the value. Alternatively, turn its corresponding **Q-Link knob**. After you do this once, you can adjust the volume and panning of the plugin program normally.

   **Important:**
   
   If you copy a sequence, the volume and pan values will be copied with that sequence. This is also true if you move to a new sequence and put the same plugin program on a new track.

   By default, some plugins do not support MIDI volume and pan. In this case, adjust volume levels and panning on the plugin program.
MIDI Programs

A MIDI program lets you send your track’s MIDI data to an external MIDI device like a synth or drum machine.

To create a MIDI program:
1. Press Main to enter Main Mode.
2. Use the cursors to select Pgm, and press Window.
4. In the New Program screen that appears, set the Type field to Midi.
5. Press F5/Do It to create the program or F4/Cancel to return to Main Mode without creating the program.

There are five additional settings to configure for a MIDI program: the MIDI port (Port), program change message (PC), MIDI channel (Ch), Most Significant Byte (Bank MSB), and Least Significant Byte (Bank LSB). See this section to learn more.

Note: You also have to configure the MIDI ports in the software’s Preferences (in the Edit Menu). See the user guide in the MPC software to learn more: click the Help menu, select MPC Help, and select MPC User Manual.

To adjust the level and panning of a track using the plugin program:
1. Press Shift+Prog Mix/Track Mix to enter the Channel Mixer.
2. Set Mixer to Tracks.
3. Press F1/Level to view the velocity levels of all tracks or F2/Pan to view the panning of all tracks.
4. Select the field that corresponds to the track with the MIDI program, and adjust the value. Alternatively, turn its corresponding Q-Link knob. After you do this once, you can adjust the volume and panning of the MIDI program normally.

Important:
If you copy a sequence, the volume and pan values will be copied with that sequence. This is also true if you move to a new sequence and put the same plugin program on a new track.
CV Programs

A CV program lets you send your control voltage (CV) signals to an external MIDI device like a synth or drum machine that uses CV.

To create a MIDI program:
1. Press Main to enter Main Mode.
2. Use the cursors to select Pgm, and press Window.
4. In the New Program screen that appears, set the Type field to CV.
5. Press F5/Do It to create the program or F4/Cancel to return to Main Mode without creating the program.

There are five additional settings to configure for a CV program: the note tracking (Note), the CV Port, the Gate Port, the modulation wheel (Mod Wheel), and Velocity Port. See the user guide in the MPC software to learn more: click the Help menu, select MPC Help, and select MPC User Manual.

To adjust the level and panning of a track using the CV program:
1. Press Shift+Prog Mix/Track Mix to enter the Channel Mixer.
2. Set Mixer to Tracks.
3. Press F1/Level to view the velocity levels of all tracks or F2/Pan to view the panning of all tracks.
4. Select the field that corresponds to the track with the CV program, and adjust the value. Alternatively, turn its corresponding Q-Link knob. After you do this once, you can adjust the volume and panning of the CV program normally.

**Important:** If you copy a sequence, the volume and pan values will be copied with that sequence. This is also true if you move to a new sequence and put the same plugin program on a new track.
Saving

To save the project, press Shift+Browser/Save. If you have already saved the project, your changes will be saved. If you have not saved the project yet, use the Save window in the software window to save the project.

Important: The MPC software window contains various settings to save a new project. To see the user guide in the MPC software and learn how to do this, click the Help menu, select MPC Help, and select MPC User Manual.

Preferences

The Preferences screen contains many customizable elements of the software. Changes to the Preferences are saved automatically.

Important: The Preferences window shown in the MPC software window contains even more settings you may want to configure. To see the user guide in the MPC software and learn how to do this, click the Help menu, select MPC Help, and select MPC User Manual.

To open the Preferences, press Shift+Song/Other, and then press F1/Prefs.

These are the buttons under the screen:

- **F1 MidiCtrl** Press this button to enter MIDI Control Mode. See Modes > MIDI Control Mode to learn more.

  - **Auto button** determines whether pressing Q-Link Trigger cycles through the automation states globally (Global) or for the currently selected program only (Program). See General Features > Automation to learn more about this.

  - **Number Of Taps** determines how many times you have to press the Tap Tempo button before the new tempo is recognized.

  - **Pad Threshold** determines how much force is required to strike the pads for them to trigger.

  - **Pad Sensitivity** determines how the pads respond to touch. At lower values, you need to use more force to generate a high-velocity note. At higher values, it is easier to generate high-velocity notes, even if you do not use much force while pressing a pad.

  - **Pad Curve** determines how striking the pads translates into velocity values. The A curve is essentially linear, while the B, C, and D curves are exponential (see graphic here).

  - **Footswitch 1 & Footswitch 2** determine how connected footswitches will work. These options are available for MPC Renaissance only, not for MPC Studio, which does not have footswitch inputs.
Recording Bit Depth determines bit depth of the audio recorded from a sample.

Display Resolution is the display resolution in PPQN (pulses per quarter note) of pulse values in certain areas of the operating system. Please note that this setting affects the display resolution, not the timing.

Program Change Target determines what an incoming MIDI program change message will change: nothing (Off), a program (Program), a sequence (Sequence), or a track (Track).
Now & Locators

In some modes, there is a time counter at the top of the screen. This shows the current playhead position. You may also see a thin white bar under it that spans the width of the screen, serving as a visual indicator of this position. (If the Auto Record feature is on, Punch In or Seq Start will be shown next to the time. See below to learn about this.)

To jump to a specific location, use the cursors to select each field, and then use the data dial or +/- buttons to change the number. You can also use the numeric keypad to enter a number and then press Enter to confirm it.

To move forward or backward a step, press the < or > button (MPC Renaissance) or the Step < or Step > button (MPC Studio), respectively.

To move forward or backward a bar, press the << or >> button (MPC Renaissance) or the Bar << or Bar >> button (MPC Studio), respectively.

You can also use the Locators screen to jump to another position in the current sequence, set time markers, or turn the Auto Record feature on or off.

To open the Locators screen, press Locate (MPC Renaissance) or Go To (MPC Studio).

You can use the following fields and buttons in the Locators screen. Use the cursors to select each field, and then use the data dial or +/- buttons to change the parameter. If the field is a number, you can use the numeric keypad to enter a number and then press Enter to confirm it.

GO TO determines where in your current sequence you want to jump.

To jump to a specific location, use the cursors to select each field, and then use the data dial or +/- buttons to change the number. You can also use the numeric keypad to enter a number and then press Enter to confirm it.

To move forward or backward a step, press the < or > button (MPC Renaissance) or the Step < or Step > button (MPC Studio), respectively.

To move forward or backward a bar, press the << or >> button (MPC Renaissance) or the Bar << or Bar >> button (MPC Studio), respectively.
**Auto Rec** determines how the Auto Record feature will function.

**To set how Auto Record works**, use this field to select an option:

- **Off**: Auto Record is disabled.
- **Punch In**: You can auto-record using punch-in and punch-out markers, enabling you to record over the specified length of time in the track between them. While recording, the entire sequence will play, but you will record over only the area between the **Punch In** and **Punch Out** markers. Any part of the sequence before the Punch In marker or after the Punch Out marker will remain untouched, even if you perform over it during recording.

![Auto Rec Screen](image)

**To set the Punch In and Punch Out markers**, select **Auto Rec** and press **Window**. Use the fields and buttons in the screen that appears:

- The left and right sets of three numeric fields determine the locations of Punch In and Punch Out markers (respectively).
- **F2/Punch In** sets the Punch In marker at the current location (as long as it is before the Punch Out marker).
- **F5/Punch Out** sets the Punch Out marker at the current location (as long as it is after the Punch In marker).
- **F4/Back** returns to the previous screen.

- **Seq Start**: After you record-arm the track and start playback, you will start recording once the sequence loops back to its start. This is essentially a punch-in feature for the entire track, enabling you to start playing a record-armed track while allowing more time than the usual count-in to prepare for the actual recording to start.

1–6 are the locations of time markers. You can use these to jump automatically to precise locations in a sequence.

**To manually enter a time marker location**, use each field.

- **To set a time marker at the current location** (the **GO TO** field), select one of its three fields, and then press **F2/Capture**.

- **To jump to a time marker**, select one of its three fields, and press **F5/Go**. Alternatively, on MPC Renaissance, you can press and hold **Locate** and then press a number (1–6) on the **numeric keypad** (you can do this even while not in the **Locators** screen).

**F2/Capture** sets a time marker at the current location (shown in the **GO TO** field).

**F4/Close** returns to the previous screen.

**F5/Go** jumps to the currently selected time marker (1–6) and returns to the previous screen.
The **Timing Correct** feature (abbreviated **TC**) includes settings to help quantize the note events in a track. This is available in Main Mode and the Step Sequencer.

**Note:** Pad Mute Mode and Track Mute Mode include a similar Timing Correct feature in each mode, but it is different from the feature described here. See **Modes > Pad Mute Mode** and **Track Mute Mode** to learn about those settings.

To open the Timing Correct settings:

In **Main Mode**, press **Shift+F1/T.C.**

In the **Step Sequencer**, press **F1/T.C.**

You can use the following fields and buttons in the **Timing Correct** screen. Use the **cursors** to select each field, and then use the **data dial** or +/- buttons to change the parameter. If the field is a number, you can use the **numeric keypad** to enter a number and then press **Enter** to confirm it.

**Type** determines how timing corrections are applied.

- **Start**: The entire note event will be nudged forward or backward so the start point aligns with the closest time division marker in the grid.
- **End**: The end points of note events will be extended or shortened to align with the closest time division marker in the grid. The start points will remain untouched.
- **Length**: The end points of note events will be extended or shortened so that each event’s length is a multiple of the time division, regardless of where it is in the grid. The start points will remain untouched.
- **Legato**: The end points of note events will be extended or shortened to create a long, unbroken phrase from the first note event’s start point to the last note event’s end point. Each note event will sustain until another note event starts. If multiple note events start at the same time (and are not the last note events), their lengths will become identical. Selecting **Legato** disables all other options in this window.
**Time Div** is the quantization value. Note events will “snap” to these time divisions on the grid. The T indicates a triplet-based value.

To set the quantization value, use this field. Alternatively, if you are not in the Timing Correct screen, press and hold **Note Repeat** and press one of the six buttons under the screen; **F1–F5** sets the note value, and **F6/(3)** determines whether it is a standard value or triplet-based value.

**Strength** determines how strictly notes will be quantized (i.e., shifted toward the quantize value): 0–100%. Lower values move notes a little bit towards the closest quantize value, resulting in a less mechanical feel than a strict quantization (a higher value).

To set the quantization strength, use this field.

**Swing** determines the amount of swing: 50–75%. Swing lets you “shuffle” your beats, from subtle to extreme. 50% corresponds to no swing (“straight”) and 75% corresponds to the maximum amount.

To set the amount of swing, use this field.

**Shift Timing** is an offset for the events that will be time-corrected. The affected events will be shifted by this amount: -48 to 48 ticks of the time counter.

To off-set the time-corrected notes, use this field.

**Window** determines how many notes around each beat (Time Div) will be quantized. Any notes outside this range will not be quantized; notes inside will. This value is measured as a percentage: 0–100%.

To set the quantization window, use this field.

**Events** determines the target range for the time correction:

- **All**: Time correction will be applied to all note events in the currently selected track.
- **Selected**: Time correction will be applied to only the selected note events in the currently selected track. (Use the grid in the MPC software window to do this.)
- **Range**: Time correction will be applied to note events within a certain span of time. You can also set whether it applies to all notes within that timespan or specific note values only.
  
  **From** is the start of the range.
  **To** is the end of the range.
  **Notes** are the specific note values that you want to time-correct within the range. Press the corresponding pads to select or deselect the notes.

F3/All Trks applies the Timing Correct settings to all tracks at the same time.

F4/Close returns to the previous screen without applying your changes.

F5/Do It applies the time corrections you entered and returns to the previous screen.
The **Click/Metronome** screen contains all settings regarding the metronome (click track). These settings are accessible from within Main Mode only, though they apply to all modes (globally).

To open the metronome settings, press Main to enter Main Mode, and then press Shift+F2/Click.

You can use the following fields and buttons in the **Click/Metronome** screen. Use the cursors to select each field, and then use the data dial or +/- buttons to change the parameter. If the field is a number, you can use the numeric keypad to enter a number and then press Enter to confirm it.

### Count-In
Determines if the metronome counts before recording and playback.

To set how the metronome count-in works, use this field to select an option:

- **Off** disables the metronome pre-count.
- **Record** enables the pre-count during recording only.
- **Record + Play** enables pre-count in both Record and Playback Modes.

### Metronome
Determines if/when the metronome is enabled:

To set when the metronome is enabled, use this field to select an option:

- **Off** disables the metronome.
- **Play** enables the metronome sound during playback only.
- **Record** enables the metronome sound during recording only.
- **Record + Play** enables the metronome to sound during recording and playing.

### Rate
Is the time division of the metronome click: 1/4, 1/4T, 1/8, 1/8T, 1/16, 1/16T, 1/32 or 1/32T. T indicates a triplet-based time division.

To set the metronome rate, use this field.

### Sound
Is the sound that occurs during each beat of the metronome: Sidestick 1, Sidestick 2, Clap, Metroclick, Shake, Tambourine, or MPC Click.

To set the metronome sound, use this field.

### Volume
Is the volume of the metronome.

To set the metronome volume, use this field.
Automation

You can set the automation for programs and audio tracks to be “written,” “read,” or disabled entirely. You can do this globally or for individual programs and audio tracks.

Global

Changing the global automation state will change the automation state for all programs in your project.

To change the global automation state, press Q-Link Trigger when it is set to Global in the Preferences screen (see this section to learn how to do this).

The Q-Link Trigger button will cycle through its three states:

- When off, automation data will be ignored. If you have already recorded or entered automation, this will switch between Read (solidly lit) and Write (flashing) only, but you can override this and turn it off by pressing and holding Shift while pressing the button.

  Important: If you have already recorded automation and turn it off, the track will still use the effect and its parameter values at the point where you turned it off.

- When solidly lit (Read), automation data will be read but not recorded. (Think of this as a protective feature to prevent accidental changes to your automation while recording.)

- When flashing (Write), automation can be recorded and will overwrite any existing automation. (Make sure not to touch the Q-Link knobs accidentally while you are recording.)

To set Q-Link Trigger to control global automation, press Shift+Song/Other (which will enter MIDI Control Mode), press F1/Prefs to show the Preferences screen, and set Auto button to Global.

Programs & Audio Tracks

You can also set the automation for each program or audio track. Program automation is available for all program types except MIDI programs.

Note: Remember that changing the global automation state will change the automation state for all programs in your project; if they were originally different, all of them will then match the global automation state.

To change the automation state of a program or audio track, first select the MIDI track using the desired program or select the desired audio track. After that, press Q-Link Trigger when it is set to Program in the Preferences screen (see this section to learn how to do this).

Alternatively, do the following:

1. Press Main to enter Main Mode or Step Seq to enter the Step Sequencer.
2. Use the cursors to select the parameter in the lower-right corner. This varies depending on the last parameter you adjusted in its sub-window.
3. Press Window.
4. Use the cursors to select Automation. Use the data dial or –/+ buttons to change its automation state.
You can set each program or audio track to one of three automation states:

- **When off (x),** the program or audio track will ignore automation data.
  
  **Important:** If you have already recorded automation and turn it off, the track will still use the effect and its parameter values at the point where you turned it off.

- **When set to Read (R),** the program or audio track will read automation data but will not record any additional automation over it. (Think of this as a protective feature to prevent accidental changes to your automation while recording.)

- **When set to Write (W),** the program or audio track can record automation. (If you have any Q-Link knobs assigned to automatable parameters, make sure not to touch any accidentally while you are recording.)

To set Q-Link Trigger to control automation for a program or audio track, press **Shift+Song/Other** (which will enter MIDI Control Mode), press **F1/Prefs** to show the **Preferences** screen, and set **Auto button** to **Program**.

### 16 Level

16 Level temporarily copies the samples of one pad to all 16 pads. The pads will now output the same note number as the initial pad, but a selectable parameter will be fixed at values that increase as the pad numbers increase (i.e., Pad 1 is the minimum, Pad 16 is the maximum), regardless of how hard you press them.

To activate or deactivate 16 Level:

1. Press **16 Level**.
2. Use the fields in the **16 Levels** screen that appears:
   - **Active** determines whether 16 Level is activated (**ON**) or not (**OFF**).
   - **Pad** is the pad that will be copied to all 16 of them. (You can simply press the pad to select it, but **Active** must be set to **OFF** first.)
   - **Type** is the parameter that will vary in value across all 16 pads: **Velocity**, **Tune**, **Filter**, **Layer**, **Attack**, or **Decay**.
     
     If you select **Tune**, use the **Original Pad** field to select which you pad you want to use the original pitch of the sample/samples. Alternatively, hold **Shift** and press the desired pad.
     
     When **Type** is set to **Layer**, pads with multiple samples will play back each layer according to the **Velocity Start** and **Velocity End** settings for each layer.
3. Press **F5/Close** to the previous screen.
Pad Assign enables you to assign samples and specific colors to your pads in each program.

To use Pad Assign:

1. Press Pad Assign.
2. Use the fields in the screen that appears:
   - **Program** is the currently selected program whose pads are shown in the 16 fields below.
   - **Style** determines how the pad lights will display:
     - **OFF**: The pads will be unlit whether you are playing them or not.
     - **VELO**: The pads will be unlit while you are not playing them. When you press them, they will light with colors according to the velocity: red indicates a high velocity, yellow indicates a low velocity.
     - **FIXED**: The pads will be lit with their assigned colors whether you are playing them or not.
     - **OFF->V**: The pads will be unlit when you are not playing them. When you press them, they will light with their assigned color with a brightness that corresponds with the velocity.
     - **DIM->V**: The pads will be dimly lit when you are not playing them. When you press them, they will light with their assigned color with a brightness that corresponds with the velocity.
     - **BRI->V**: The pads will be brightly lit when you are not playing them. When you press them, they will light with their assigned color with a brightness that corresponds with the velocity.
   - **Pad** determines whether you are setting the color for one pad (SINGLE) or all pads (ALL).

The pads are shown in a 4x4 array with the names of their assigned samples or their colors, depending on the tab selected at the bottom of the screen.

To view more pads, use the Pad Bank buttons.

To assign samples to the pads, press F1/Sample to select the Sample tab. Use the field in each pad to select a sample from your project’s sample pool. You can also select a pad by pressing it.

To assign colors to the pads, press one of the F2–F5 buttons to select the corresponding color. Press each pad to assign or un-assign that color.

F6/>Default makes the current pad color settings the defaults for all programs on the same type (e.g., drum programs, keygroup programs, etc.). In the screen that appears, press F4/Do it to confirm your choice or F3/Cancel to return to the previous screen without saving the settings as defaults.

3. Press a mode button to enter any other mode.
Pad Copy

You can use the Pad Copy function to copy the samples and parameters from one pad to another.

To copy one pad to another:

1. Press and hold Shift+Pad Assign/Pad Copy.
2. In the Copy Pad window that appears, use the From Pad field to select the “source” pad. Alternatively, press the “source” pad (when this field is selected).
3. Use the cursors to select the To Pads field, and then press the “destination” pads.
4. Press F5/Do It to continue. The samples and parameters will be copied automatically from the source pad to the destination pad/pads.

   Alternatively, press F4/Close to cancel the operation and return to the previous screen.
**Erase**

The Erase function erases all or part of a track in a specific sequence.

To use the Erase function:

1. Press **Erase**.

2. Use the fields in the screen that appears:
   - **Sequence** determines the sequence containing the track whose events you want to erase (partially or entirely).
   - **Track** determines the track whose events you want to erase (partially or entirely).
   - **Time** and **To** define the time range of the track whose events you want to erase (partially or entirely). **Time** is the start of the time range, and **To** is the end.
   - **Erase** determines what types of events you will erase:
     - **All** erases all pad events from the designated time range and reset all of its settings.
     - **Automation** erases only automation from the designated time range. Use the **Parameter** field to select what type of automation to erase, or select **All** to erase all automation from the designated time range.
     - **Note** erases only specific pad events from the designated time range. Press each pad (in each bank) to select or deselect its notes, which will appear in the **Notes** field below.
     - **Except Note** erases everything except pad events from the designated time range. Press each pad (in each bank) to select or deselect its notes, which will appear in the **Notes** field below.

3. Press **F5/Do It** to erase the events, or press **F4/Back** to return to the previous screen without erasing anything.
Edit Sequence

You can use the Edit Sequence screen to make changes to your currently selected sequence. These functions are described below. All options in the screen will work for MIDI tracks, but some of them will not work for audio tracks.

To enter the Edit Sequence screen, press Seq Edit.

To select an editing function, press the corresponding pad (Pad 1–8) or press the corresponding button on the numeric keypad.

To exit the screen, press F4/Back to return to Main Mode, or press another mode button.

In the screen for each editing function, use the cursors to select each field, and then use the data dial or +/- buttons to change the parameter. If the field is a number, you can use the numeric keypad to enter a number and then press Enter to confirm it.

The Insert Blank Bars function adds empty bars to a sequence at a specified point.

- **Sequence** determines the sequence to which you want to add empty bars.
- **Number Of Bars** determines how many empty bars you will add.
- **Time Sig** determines the time signature of the empty bars (one field for the number of beats, one field for the note value).
- **Before Bar** is the bar before which the empty ones will be inserted.
- **F5/Do It** inserts the bars.
- **F4/Back** returns to the previous screen without making any changes.

The Delete Bars function removes a range of bars from a sequence.

- **Sequence** determines the sequence containing the track whose bars you want to delete.
- **First Bar** and **Last Bar** define the range of bars in the track whose events you want to delete. **First Bar** is the start of the range, and **Last Bar** is the end.
- **F5/Do It** deletes the bars.
- **F4/Back** returns to the previous screen without making any changes.
The **Copy Bars** function copies a range of bars from a sequence and adds them to another at a specified point.

The **first Sequence** field is the “source” sequence whose bars you want to copy.

**First Bar** and **Last Bar** define the range of bars you want to copy in the source sequence. **First Bar** is the start of the range, and **Last Bar** is the end.

The **second Sequence** field is the “destination” sequence where the source sequence bars will be copied.

**After Bar** is the bar after which the new ones will be inserted.

**Copies** determines how many instances of the copied bars you will add.

F4/Replace overwrites the destination sequence.

F5/Merge adds the events to the destination sequence without erasing anything.

F3/Back returns to the previous screen without making any changes.

---

The **Copy Events** function copies the content of a track from a sequence and adds them to a track in another sequence at a specified point.

The **first Sequence** field is the “source” sequence containing the track whose content you want to copy.

The **first Track** field is the “source” track whose content you want to copy.

The **Pads** or **Notes** field lets you select specific events to copy. Press the pads to select the pads or notes to copy from.

**Time** and **To** define the time range of the track whose content you want to copy. **Time** is the start of the time range, and **To** is the end.

The **second Sequence** field is the “destination” sequence containing the track where the source track’s content will be copied.

The **second Track** field is the “destination” track where the source track’s content will be copied.

**Time** is the location in the sequence where the content will be copied.

**Copies** determines how many instances of the copied content you will add.

The lower-right field determines what events will be copied (available for MIDI tracks only):

- **All Events** copies the notes in the time range determined by the **Time** and **To** fields above.
- **Only Selected** copies only the currently selected events.

F4/Replace overwrites the destination sequence.

F5/Merge adds the events to the destination sequence without erasing anything.

F3/Back returns to the previous screen without making any changes.
The **Copy a Sequence** function copies the contents of one sequence to another.

- **Copy Contents of Sequence** is the “source” whose events you want to copy.
- **Over Contents of Sequence** is the “destination” sequence where the source sequence will be copied.
- **F5/Do It** copies the sequence.
- **F4/Back** returns to the previous screen without making any changes.

---

The **Transpose** function transposes a range of events on a track in a sequence. The events within that range will shift accordingly in the Grid View. This option is available for MIDI tracks only.

- **Sequence** determines the sequence containing the track whose events you want to transpose.
- **Track** determines the track whose events you want to transpose.
- **Time** and **To** define the time range of the track whose events you want to transpose. **Time** is the start of the time range, and **To** is the end.

**For drum programs:**
- **Change Pad** is the “source” pad (whose events you want to transpose).
- **To Pad** is the “destination” pad (where the events will be placed).

**For keygroup programs, plugin programs, and MIDI programs:**
- **Range** consists of two fields that define the range of notes of the events you want to transpose. Note events within this range will be transposed, while note events outside of this range will remain unchanged.
- **Transpose** determines how many semitones up or down you want to transpose the note events.
- **F5/Do It** transposes the events.
- **F4/Back** returns to the previous screen without making any changes.
The **Erase** function erases all or part of a track in a specific sequence.

**Sequence** determines the sequence containing the track whose events you want to erase (partially or entirely).

**Track** determines the track whose events you want to erase (partially or entirely).

**Time** and **To** define the time range of the track whose events you want to erase (partially or entirely). **Time** is the start of the time range, and **To** is the end.

**Erase** determines what types of events you will erase:

- **All** erases all pad events from the designated time range and resets all of its settings.
- **Automation** erases only automation from the designated time range. Use the **Parameter** field to select what type of automation to erase, or select **All** to erase all automation from the designated time range.
- **Note** erases only specific pad events from the designated time range. Press each pad (in each bank) to select or deselect its notes, which will appear in the **Notes** field below.
- **Except Note** erases everything except pad events from the designated time range. Press each pad (in each bank) to select or deselect its notes, which will appear in the **Notes** field below.

**F5/Do It** erases the events.

**F4/Back** returns to the previous screen without making any changes.

The **Copy Track** function copies the contents of one track to another within the same sequence.

The **first Track** field is the “source” track whose content you want to copy.

The **second Track** field is the “destination” track where the source track’s content will be copied.

**F5/Do It** copies the track.

**F4/Back** returns to the previous screen without making any changes.
Effects

You can apply various effects to the pads, keygroups, audio tracks, programs, submixes, and master outputs, using insert and send/return effects. This chapter can help you get a good overall understanding of how the effects work.

See Appendix > Effects & Parameters for a list of all available effects (with a brief description of each) and their editable parameters.

Overview

In a program, each pad or keygroup can have up to four insert effects applied to it. See Insert Effects > Pads or Keygroups to learn more about this.

An entire program or audio track can also have up to four insert effects applied to it, as well. See Insert Effects > Programs or Audio Tracks to learn more about this.

For even further flexibility, each submix can have up to four insert effects applied to it. You can route pads, keygroups, audio tracks, or programs to a submix, which is then routed to a master output. See Insert Effects > Submixes to learn more about this.

Additionally, each pad, keygroup, audio track, program, and submix can each be sent to (up to) four return channels, each of which can have up to four insert effects of their own. Their audio will be routed through the insert effects on those returns, and the processed audio will be sent to a master output. See Send/Return Effects to learn more about this.

Finally, you can apply up to four insert effects to each master output (a stereo pair of channels: Outputs 1/2, Outputs 3/4, etc.). See Insert Effects > Master Outputs to learn more about this.

When you create an audio mixdown of a sequence or song, you can choose whether or not master insert effects are included or send/return effects are included, depending on what you are mixing down:

If you are creating an audio mixdown of a pair of master outputs, you can choose whether or not master insert effects will be included in the mixdown.

If you are creating an audio mixdown of separate programs or exploded tracks, you can choose whether or not send/return effects will be included in the mixdown.

To see the user guide in the MPC software and learn about this, click the Help menu, select MPC Help, and select MPC User Manual.

There are two other modes that handle effects differently:

- **Sample Record Mode** can use up to four insert effects, which are applied to the audio as you record it. This means that the effects cannot be “removed” from the sound later. Learn more about this in the Modes > Sample Record Mode chapter.

- Similarly, the **Looper** can use up to four insert effects, which are applied to the audio as you record it. This means that the effects cannot be “removed” from the sound later. Learn more about this in the Modes > Looper chapter.
When viewing effect slots (empty or loaded), you will see either all four slots at once or one slot at a time across four tabs:

To load an effect to a slot or to change a slot’s loaded effect, use the cursors to select the field for that insert slot, and then use the data dial or –/+ buttons to enter the Select Effect screen (described below).

To edit the parameters of a loaded effect, use the cursors to select the field for that insert slot, and then press Window to enter the effect’s parameter screen (described below).

To clear the insert slot, load an effect as described above, but select the <none> option.

To enable or disable an effect, turn its corresponding Q-Link knob while viewing an Insert tab in the Pad Mixer or Channel Mixer.

To enable or disable all four effect slots, use the cursors to select Inserts in the upper-right corner (if it is shown), and then use the data dial or –/+ buttons to select On or Off (respectively).

When selecting an effect, you will see the Select Effect screen:

To move through the list, use the data dial or –/+ buttons.
To load an effect, press F4/Select.
To return to the previous screen without loading an effect, press F3/Back.
When editing an effect, you will see this screen:

|--------|--------|------------|------------|-----------|-----------|------------|------------|-----------|

To adjust a parameter, use the cursors to select its field, and then use the data dial or +/- buttons to change it. Alternatively, turn the corresponding Q-Link knob.

To select another page of parameters, use the cursors to select Params in the upper-right corner, and then use the data dial or +/- buttons to change which parameters you are viewing.

To enable or disable the effect, press F6/On/Off.

To return to the previous screen, press F4/Close.
Insert Effects

This section describes the different ways to load insert effects to pads, keygroups, audio tracks, programs, submixes, and master outputs.

Pads

You can load up to four insert effects to each pad in a drum program or clip program. You can do this in Program Edit Mode or the Pad Mixer.

Tip: When using pad insert effects, they will be applied to the selected pad only. This means that you could apply unique combinations of effects to each pad within a program. If you want to apply the same effect to all pads, do this with a program insert effect (see Insert Effects > Programs).

To load a pad insert effect in Program Edit Mode:
1. Press Prog Edit to enter Program Edit Mode.
2. Use the cursors to select Program, and turn the data dial or +/- buttons to select the desired program.
3. Press the desired pad to select it.
5. Use the cursors to select the desired insert slot.
6. Turn the data dial or +/- buttons to open the Select Effect screen to select and load an effect.

To load a pad insert effect in the Pad Mixer:
1. Press Prog Mix to enter the Pad Mixer.
2. Use the cursors to select Program, and turn the data dial or +/- buttons to select the desired program.
   Alternatively, use the cursors to select Track, and turn the data dial or +/- buttons to select the desired track—the program it uses will be selected automatically.
3. Press F5/Insert to select the desired insert slot.
4. Press the desired pad to select it, or use the cursors to select its field.
5. Turn the data dial or +/- buttons to open the Select Effect screen to select and load an effect.
   Turn the Q-Link knobs to turn their corresponding effects on or off.
Keygroups
You can load up to four insert effects to each keygroup in a keygroup program. You can do this in Program Edit Mode or the Pad Mixer.

Important: When using keygroup insert effects, they will be applied to that keygroup only. Keep this in mind if you load insert effects to multiple keygroups with overlapping note ranges—the effects will overlap in that range as well.

To load a keygroup insert effect in Program Edit Mode:
1. Press Prog Edit to enter Program Edit Mode.
2. Use the cursors to select Program, and turn the data dial or +/- buttons to select the desired program.
3. Press a pad to select the keygroup it belongs to, or press F1/Master and then use the Kg Select field.
5. Use the cursors to select the desired insert slot.
6. Turn the data dial or +/- buttons to open the Select Effect screen to select and load an effect.

To load a keygroup insert effect in the Pad Mixer:
1. Press Prog Mix to enter the Pad Mixer.
2. Use the cursors to select Program, and turn the data dial or +/- buttons to select the desired program.
   Alternatively, use the cursors to select Track, and turn the data dial or +/- buttons to select the desired track—the program it uses will be selected automatically.
3. Press F5/Insert to select the desired insert slot.
4. Press a pad to select the keygroup it belongs to, or use the cursors to select its field.
5. Turn the data dial or +/- buttons to open the Select Effect screen to select and load an effect.
   Turn the Q-Link knobs to turn their corresponding effects on or off.
Audio Tracks

You can load up to four insert effects to each audio track. You can do this in Main Mode and the Channel Mixer.

To load an audio track insert effect in Main Mode:
1. Press **Main** to enter Main Mode.
2. Press **F2/Audio** to view your audio tracks in Main Mode.
3. Use the cursors to select **Trk**, and then use the data dial, +/- buttons, or numeric keypad to select the desired audio track. Alternatively, press **F3/Track-** or **F4/Track+**.
4. Use the cursors to select the parameter in the lower-right corner. This varies depending on the last parameter you adjusted in its sub-window.
5. Press **Window**.
6. Use the cursors to select the desired insert slot.
7. Turn the data dial or +/- buttons to open the **Select Effect** screen to select and load an effect.

To load an audio track insert effect in the Channel Mixer:
1. Press **Shift+Prog Mix/Track Mix** to enter the Channel Mixer.
2. Use the cursors to select **Mixer**, and turn the data dial or +/- buttons to select **Audio Tracks**.
3. Press **F5/Insert** to select the desired insert slot.
4. Use the cursors to select the corresponding field for the desired audio track.
5. Turn the data dial or +/- buttons to open the **Select Effect** screen to select and load an effect. Turn the Q-Link knobs to turn their corresponding effects on or off.
Programs

You can load up to four insert effects to each program. You can do this in Main Mode, the Step Sequencer, and the Channel Mixer. In Main Mode, you can load insert effects for drum, keygroup, clip, and plugin programs only. In the Channel Mixer, you can load insert effects for drum, keygroup, or clip programs only.

To load a program insert effect in Main Mode:

**Note:** In Main Mode, you can load insert effects for drum, keygroup, clip, or plugin programs. MIDI and CV programs do not use insert effects.

1. Press Main to enter Main Mode.
2. Press F1/Midi to view your MIDI tracks in Main Mode.
3. Use the cursors to select Trk, and then use the data dial, +/- buttons, or numeric keypad to select the track with the desired program. Alternatively, press F3/Track- or F4/Track+.
4. Use the cursors to select the parameter in the lower-right corner. This varies depending on the last parameter you adjusted in its sub-window.
5. Press Window.
6. Use the cursors to select the desired insert slot.
7. Turn the data dial or +/- buttons to open the Select Effect screen to select and load an effect.
To load a program insert effect in the Step Sequencer:

**Note:** In the Step Sequencer, you can load insert effects for drum, keygroup, clip, or plugin programs. MIDI and CV programs do not use insert effects.

1. Press **Step Seq** to enter the Step Sequencer. (If you cannot enter it because you are viewing audio tracks, press **Main** and then press **F1/Midi** to view MIDI tracks first.)
2. Use the cursors to select **Trk**, and then use the data dial, –/+ buttons, or numeric keypad to select the track with the desired program. Alternatively, press **F3/Track–** or **F4/Track+**.
3. Use the cursors to select the parameter in the lower-right corner. This varies depending on the last parameter you adjusted in its sub-window.
4. Press **Window**.
5. Use the cursors to select the desired insert slot.
6. Turn the data dial or –/+ buttons to open the **Select Effect** screen to select and load an effect.

To load a program insert effect in the Channel Mixer:

**Note:** In the Channel Mixer, you can load insert effects for drum, keygroup, or clip programs—not plugin programs. MIDI and CV programs do not use insert effects.

1. Press **Shift+Prog Mix/Track Mix** to enter the Channel Mixer.
2. Use the cursors to select **Mixer**, and turn the data dial, –/+ buttons to select **Programs**.
3. Press **F5/Insert** to select the desired insert slot.
4. Use the cursors to select the corresponding field for the desired program.
5. Turn the data dial or –/+ buttons to open the **Select Effect** screen to select and load an effect.
   - Turn the Q-Link knobs to turn their corresponding effects on or off.
Submixes
You can load up to four insert effects to each submix. You can do this in the Channel Mixer only.

To load a submix insert effect in the Channel Mixer:
1. Press Shift+Prog Mix/Track Mix to enter the Channel Mixer.
2. Use the cursors to select Mixer, and turn the data dial or +/- buttons to select Submixes.
3. Press F5/Insert to select the desired insert slot.
4. Use the cursors to select the corresponding field for the desired submix.
5. Turn the data dial or +/- buttons to open the Select Effect screen to select and load an effect.
   Turn the Q-Link knobs to turn their corresponding effects on or off.
Master Outputs
You can load up to four insert effects to each master output (a stereo pair of channels: Outputs 1/2, Outputs 3/4, etc.). You can do this in the Channel Mixer or in the Effects screen.

To load a master insert effect in the Channel Mixer:
1. Press Shift+Prog Mix/Track Mix to enter the Channel Mixer.
2. Use the cursors to select Mixer, and turn the data dial or +/- buttons to select Outputs.
3. Press F5/Insert to select the desired insert slot.
4. Use the cursors to select the corresponding field for the desired master output.
5. Turn the data dial or +/- buttons to open the Select Effect screen to select and load an effect.
   Turn the Q-Link knobs to turn their corresponding effects on or off.

To load a master insert effect in the Effects screen:
1. Press Shift+Seq Edit/Effects to enter Effects screen.
2. Use the cursors to select Outputs, and turn the data dial or +/- buttons to select the desired master output.
3. Use the cursors to select the desired insert slot (Insert 1–4).
4. Turn the data dial or +/- buttons to open the Select Effect screen to select and load an effect.
Send/Return Effects

Send/return effects work in the following way:

1. A pad, keygroup, audio track, program, or submix sends its audio to a return at a designated send level.
2. That audio is processed by the effects on the return. Each return can have up to four insert effects loaded and activated.
3. The processed audio is sent to a pair of master outputs (stereo) or a single master output (mono).

You can load send/return effects and set return levels only in the Channel Mixer, described below. The rest of this section describes the different ways to set the desired send levels for pads, keygroups, audio tracks, programs, or submixes.

To load a send/return effect to a return:
1. Press Shift+Prog Mix/Track Mix to enter the Channel Mixer.
2. Use the cursors to select Mixer, and turn the data dial or +/- buttons to select Returns.
3. Press F5/Insert to select the desired insert slot.
4. Use the cursors to select the corresponding field for the desired return channel.
5. Turn the data dial or +/- buttons to open the Select Effect screen to select and load an effect.
   Turn the Q-Link knobs to turn their corresponding effects on or off.

To set the return level:
1. Press Shift+Prog Mix/Track Mix to enter the Channel Mixer.
2. Use the cursors to select Mixer, and turn the data dial or +/- buttons to select Returns.
3. Press F1/Level to select the desired insert slot.
4. Use the cursors to select the corresponding field for the desired return channel.
5. Turn the data dial or +/- buttons to set the return level.
   Alternatively, turn the corresponding Q-Link knob to set the return level for each insert slot.
Pads

You can set the send levels for pads in Program Edit Mode or the Pad Mixer.

To set the send levels for a pad in Program Edit Mode:
1. Press **Prog Edit** to enter Program Edit Mode.
2. Use the **cursors** to select **Program**, and turn the **data dial** or →/↔ buttons to select the desired program.
3. Press the desired **pad** to select it.
4. Press **F6/Effects**.
5. Use the **cursors** to select the desired send level (Send 1–4).
6. Turn the **data dial** or →/↔ buttons to adjust the send level.
   Alternatively, turn the corresponding **Q-Link knob** (4, 8, 12, or 16 on MPC Renaissance or the **fourth column** of **Q-Link knobs** on MPC Studio) to adjust the level immediately for each send channel.

To set the send levels for a pad in the Pad Mixer:
1. Press **Prog Mix** to enter the Pad Mixer.
2. Use the **cursors** to select **Program**, and turn the **data dial** or →/↔ buttons to select the desired program.
   Alternatively, use the **cursors** to select **Track**, and turn the **data dial** or →/↔ buttons to select the desired track—the program it uses will be selected automatically.
3. Press **F4/Send** to select the desired send channel.
4. Press a **pad** to select it, or use the **cursors** to select its field.
5. Turn the **data dial** or →/↔ buttons to adjust the send level.
   Alternatively, turn the corresponding **Q-Link knob** to adjust the send level immediately for each pad.
Keygroups

You can set the send levels for keygroups in Program Edit Mode or the Pad Mixer.

To set the send levels for a keygroup in Program Edit Mode:
1. Press Prog Edit to enter Program Edit Mode.
2. Use the cursors to select Program, and turn the data dial or −/+ buttons to select the desired program.
3. Press the desired pad to select the keygroup it belongs to, or press F1/Master and then use the Kg Select field.
5. Use the cursors to select the desired send level (Send 1–4).
6. Turn the data dial or −/+ buttons to adjust the send level.

Alternatively, turn the corresponding Q-Link knob (4, 8, 12, or 16 on MPC Renaissance or the fourth column of Q-Link knobs on MPC Studio) to adjust the level immediately for each send channel.

To set the send levels for a keygroup in the Pad Mixer:
1. Press Prog Mix to enter the Pad Mixer.
2. Use the cursors to select Program, and turn the data dial or −/+ buttons to select the desired program.

   Alternatively, use the cursors to select Track, and turn the data dial or −/+ buttons to select the desired track—the program it uses will be selected automatically.
3. Press F4/Send to select the desired send channel.
4. Press a pad to select the keygroup it belongs to, or use the cursors to select its field.
5. Turn the data dial or −/+ buttons to adjust the send level.

   Alternatively, turn the corresponding Q-Link knob to adjust the send level immediately for each keygroup.
Audio Tracks

You can set the send levels for audio tracks in Main Mode or the Channel Mixer.

To load an audio track insert effect in Main Mode:

1. Press Main to enter Main Mode.
2. Press F2/Audio to view your audio tracks in Main Mode.
3. Use the cursors to select Trk, and then use the data dial, +/- buttons, or numeric keypad to select the desired audio track. Alternatively, press F3/Track- or F4/Track+.
4. Use the cursors to select the parameter in the lower-right corner. This varies depending on the last parameter you adjusted in its sub-window.
5. Press Window.
6. Use the cursors to select the desired send channel (Send1-4).
7. Turn the data dial or +/- buttons to adjust the send level.

To load an audio track insert effect in the Channel Mixer:

1. Press Shift+Prog Mix/Track Mix to enter the Channel Mixer.
2. Use the cursors to select Mixer, and turn the data dial or +/- buttons to select Audio Tracks.
3. Press F4/Send to select the desired send channel.
4. Use the cursors to select the corresponding field for the desired audio track.
5. Turn the data dial or +/- buttons to adjust the send level.

Alternatively, turn the corresponding Q-Link knob to adjust the send level immediately for each audio track.
Programs

You can set the send levels for programs in Main Mode, the Step Sequencer, or the Channel Mixer.

To set the send levels for a program in Main Mode:

**Note:** In Main Mode, you can set send levels for drum, keygroup, clip, or plugin programs. MIDI and CV programs do not use send/return effects.

1. Press Main to enter Main Mode.
2. Press F1/Midi to view your MIDI tracks in Main Mode.
3. Use the cursors to select Trk, and then use the data dial, +/- buttons, or numeric keypad to select the track with the desired program. Alternatively, press F3/Track– or F4/Track+.
4. Use the cursors to select the parameter in the lower-right corner. This varies depending on the last parameter you adjusted in its sub-window.
5. Press Window.
6. Use the cursors to select the desired send channel (Send1–4).
7. Turn the data dial or +/- buttons to adjust the send level.
To set the send levels for a program in the Step Sequencer:

**Note:** In the Step Sequencer, you can set send levels for drum, keygroup, clip, or plugin programs. MIDI and CV programs do not use send/return effects.

1. Press **Step Seq** to enter the Step Sequencer. (If you cannot enter it because you are viewing audio tracks, press **Main** and then press **F1**/**Midi** to view MIDI tracks first.)

2. Use the **cursors** to select **Trk**, and then use the **data dial**, */+** buttons, or **numeric keypad** to select the track with the desired program. Alternatively, press **F3/Track–** or **F4/Track+.**

3. Use the **cursors** to select the parameter in the lower-right corner. This varies depending on the last parameter you adjusted in its sub-window.

4. Press **Window**.

5. Use the **cursors** to select the desired send channel (**Send1**–**4**).

6. Turn the **data dial** or */+** buttons to adjust the send level.

To set the send levels for a program in the Channel Mixer:

**Note:** In the Channel Mixer, you can set send levels for drum, keygroup, clip, or plugin programs. MIDI and CV programs do not use send/return effects.

1. Press **Shift+Prog Mix/Track Mix** to enter the Channel Mixer.

2. Use the **cursors** to select **Mixer**, and turn the **data dial** or */+** buttons to select **Programs**.

3. Press **F4/Send** to select the desired send channel.

4. Use the **cursors** to select the corresponding field for the desired program.

5. Turn the **data dial** or */+** buttons to adjust the send level.

Alternatively, turn the corresponding **Q-Link knob** to adjust the send level immediately for each program.
Submixes
You can set the send levels for submixes in the Channel Mixer only.

<table>
<thead>
<tr>
<th>13: -</th>
<th>14: -</th>
<th>15: -</th>
<th>16: -</th>
</tr>
</thead>
<tbody>
<tr>
<td>8: -</td>
<td>10: -</td>
<td>11: -</td>
<td>12: -</td>
</tr>
<tr>
<td>5: 57</td>
<td>6: 0</td>
<td>7: 21</td>
<td>8: 0</td>
</tr>
<tr>
<td>1: 60</td>
<td>2: 47</td>
<td>3: 33</td>
<td>4: 55</td>
</tr>
</tbody>
</table>

To set the send levels for a submix:
1. Press Shift+Prog Mix/Track Mix to enter the Channel Mixer.
2. Use the cursors to select Mixer, and turn the data dial or +/- buttons to select Submixes.
3. Press F4/Send to select the desired send channel.
4. Use the cursors to select the corresponding field for the desired submix.
5. Turn the data dial or +/- buttons to adjust the send level.
   Alternatively, turn the corresponding Q-Link knob to adjust the send level immediately for each submix.
Audio Mixdown

The Audio Mixdown window lets you render and export either the current sequence or song as an audio file. In Song Mode, this will export the entire song. In Main Mode, this will export the current sequence only.

The Audio Mixdown window is shown in the MPC software window. To see the user guide in the MPC software and learn how to do this, click the Help menu, select MPC Help, and select MPC User Manual.
The MPC hardware is always controlling one of several modes. This chapter describes the various features and functions of each one.

**Important:** The **Prog Mix** button on your MPC hardware corresponds to the **Pad Mixer** in the MPC software. Similarly, **Track Mix** (or **Shift+Prog Mix/Track Mix**) on your MPC hardware corresponds to the **Channel Mixer** in the MPC software. This is due to the functionality changing as the software has evolved.

### Main Mode
Press Main.

### Browser
Press Browser.

### Program Edit Mode
Press **Prog Edit**.

### Sample Edit Mode
Press **Sample Edit**.

### Pad Mixer
Press **Prog Mix**.

### Channel Mixer
Press **Shift+Prog Mix/Track Mix**.

### Step Sequencer
Press **Step Seq**.

### List Editor
Press **Shift+Step Seq**. (The description of this mode is in **Addenda > Updates in MPC 2.1 > New Features > List Editor**. This feature has been available since earlier releases of the MPC software but not documented for use with MPC Renaissance or MPC Studio until recently.)

### Sample Record Mode
Press **Shift+Sample Edit/Sample Rec**.

### Looper
Press **Shift+Sample Edit/Sample Rec**, and then press **F1/Sampler**.

### Pad Mute Mode
Press **Shift+Track Mute/Pad Mute**.

### Track Mute Mode
Press **Track Mute**.

### Next Sequence Mode
Press **Next Seq**.

### Song Mode
Press **Song**.

### Q-Link Edit Mode
Press **Shift+Prog Edit/Q-Link**.

### MIDI Control Mode
Press **Shift+Song/Other**.
Main Mode

Main Mode gives you an overview of the most-used functions.

To enter Main Mode, press Main.

<table>
<thead>
<tr>
<th>Now: 001 : 04 : 27</th>
</tr>
</thead>
<tbody>
<tr>
<td>Seq: 001 - Sequence 01</td>
</tr>
<tr>
<td>BPM: 80.79 (MST) Bars: 2</td>
</tr>
<tr>
<td>Trk: 001 - Drums Len: SEQ Type: Drum</td>
</tr>
<tr>
<td>Psm: Drums Vel:12: 100</td>
</tr>
</tbody>
</table>

Use the cursors to select each field, and then use the data dial or +/- buttons to change the parameter. If the field is a number, you can use the numeric keypad to enter a number and then press Enter to confirm it.

Some information shown on this screen is common to both MIDI tracks and audio tracks (described below), while other information is used for MIDI tracks only (see MIDI Tracks) or audio tracks only (see Audio Tracks).

Now is the time counter at the top of the screen, which shows the current playhead position. (If the Auto Record feature is on, Punch In or Seq Start will be shown next to the time.) See General Features > Now & Locators to learn about this.

Seq is the current sequence number and its name.

To select a sequence, use this field.

To edit the sequence, select this field and then press Window. Use the fields in the Edit Current Sequence screen that appears:

- **F2/Clear** clears all events from the sequence and resets all of its settings. Press **F4/Clear** to continue or **F3/Cancel** to return to the previous screen.
- **F3/Double** immediately doubles the sequence in length and copies all events from the first half to the second half.
- **F4/Copy** copies the contents of one sequence to another. **Copy Contents of Sequence** is the “source” whose events you want to copy. **Over Contents of Sequence** is the “destination” sequence where the source sequence will be copied. Select each field, and then use the numeric keypad, data dial, or +/- buttons to select a sequence. Press **F5/Do It** to continue or **F4/Back** to return to the previous screen.
- **F5/Close** returns to the previous screen.

BPM is the tempo of the sequence.

To set the tempo, press Tap Tempo in time with the desired tempo. Alternatively, use this integer or decimal field.

To set whether the sequence follows its own tempo (seq) or a master tempo (mst), press Shift+Tap Tempo. Alternatively, select seq/mst, and then use the data dial or +/- buttons.

Bars is the length of the sequence in bars.

To set the number of bars, use this field.
Loop determines whether or not the sequence (or a part of it) will loop.

To enable or disable looping, set this field to ON or OFF (respectively).

To set the start point and end point of loop, select this field, and then press Window. In the Loop Measures screen that appears:

- First Bar is the first bar of the loop.
- Last Bar is the last bar of the loop.
- Number of Bars is the total number of bars in the sequence.
- F5/Close returns to the previous screen.

The level meter in the upper-right corner shows the current volume level of the master mix.

MIDI Tracks

These are the buttons under the screen for MIDI tracks:

- F1 Midi: Press this button to view your MIDI tracks in Main Mode.
- F2 Audio: Press this button to view your audio tracks in Main Mode.
- F3 Track−: Press this button to select the previous track.
- F4 Track+: Press this button to select the next track.
- F5 Mute: Press this button to mute the current track.
- F6 Solo: Press this button to solo the current track.

Shift+F1 T.C.: Press these buttons to open the Timing Correct/T.C. screen, which contains various settings to help quantize the note events in your sequence. See General Features > Timing Correct/T.C. to learn about this.

Shift+F2 Click: Press these buttons to open the Click/Metronome screen, which contains all settings regarding the metronome (click track). See General Features > Click/Metronome to learn about this.

Tran is the transposition (in semitones) of the entire sequence: -24 to +24. Off indicates no transposition (0 semitones).

To set the transposition, use this field.

The In and Out boxes show that your MPC hardware is receiving or sending (respectively) MIDI messages from or to your computer.

16 track indicators are arranged in a 4x4 grid of dots or squares next to the In and Out boxes. Dots indicate empty/unused tracks. Solid squares indicate used tracks. The outlined square indicates the currently selected track.

To select a track, use the Trk field. Alternatively, press F3/Track− or F4/Track+.

Trk is the current track number and its name.

To select a track, use the Trk field. Alternatively, press F3/Track− or F4/Track+.

To edit the track, select this field, and then press Window. In the Edit Current Track screen that appears:

- F2/Clear clears all events from the track and resets all of its settings. Press F4/OK to continue or F3/Cancel to return to the previous screen.
- **F3/Explode immediately** splits the current track into multiple tracks—one for each distinct pad or note (pitch, not event). The current track will also remain present and intact, while each track created from it is labeled with the track name and pad name or number.

- **F4/Copy** copies the contents of one track to another. **Copy Contents of Track** is the “source” track whose events you want to copy. **Over Contents of Track** is the “destination” track where the source track will be copied. Set each field to the desired track. Press **F5/Do It** to continue or **F4/Back** to return to the previous screen.

- **F5/Close** returns to the previous screen.

**Length** determines how long the track is in beats. If you select the minimum value, **Seq** (or 0), the track will be the exact same length as its sequence.

**Tip**: This feature lets you maintain tracks of different lengths. For instance, you could play a 1-bar drum sequence repeatedly under a 4-bar bass line.

To set the track length, use this field.

**Type** is the type of program through which the track is being routed. The specific program name is in the **Pgm** field.

To select a program type, use this field to select a drum program (**Drum**), plugin program (**Plugin**), MIDI program (**Midi**), keygroup program (**KGrp**), clip program (**Clip**), or CV program (**CV**).

The screen may show additional fields, depending on the type of program:

- **Drum Program**: (no additional fields)

- **Plugin Program**:

  **Note**: You have to specify the disk directory where your plugins are located. This can be done in the software’s **Preferences**. To see the user guide in the MPC software and learn how to do this, click the **Help** menu, select **MPC Help**, and select **MPC User Manual**.

  **Plg** is the preset (if any) within the plugin the program is using.

  To select a preset, select this field, and then press **Window**. In the screen that appears, select the desired preset, and press **F5/Select** to continue or **F4/Close** to return to the previous screen. You can press **F2/AutoSel** to activate or deactivate automatic selection, which will automatically load each preset as you move through the list.

  **Ch** is the MIDI channel the program uses. Use this setting when you are working with a virtual instrument plugin that supports multi-mode.

  To select a MIDI channel, use this field.

- **MIDI Program**:

  **Port** is the port over which the program sends its MIDI data.

  **Note**: You also have to configure the MIDI ports in the **Preferences**. To see the user guide in the MPC software and learn how to do this, click the **Help** menu, select **MPC Help**, and select **MPC User Manual**.

  To select a port, use this field.

  **PC** is the program change message the program sends out.

  To select a program change message, use this field.

  To set the **MSB** and **LSB** (Most Significant Byte and Least Significant Byte), select this field, and then press **Window**. In the screen that appears, set **Bank Enable** to **ON** or **OFF**. When set to **ON**, select the **Bank MSB** or **Bank LSB** values. Press **F4/Close** to return to the previous screen.

  **Ch** is the MIDI channel the program uses. Use this setting when you are working with a virtual instrument plugin that supports multi-mode.

  To select a MIDI channel, use this field.

- **Keygroup Program**: (no additional fields)
• **Clip Program:** (no additional fields)

• **CV Program:**

  Port is the port over which the program sends its MIDI data.

  **Note:** You also have to configure the MIDI ports in the **Preferences**. To see the user guide in the MPC software and learn how to do this, click the **Help** menu, select **MPC Help**, and select **MPC User Manual**.

  **To select a port**, use this field.

  PC is the program change message the program sends out.

  **To select a program change message**, use this field.

  **To set the MSB and LSB** (Most Significant Byte and Least Significant Byte), select this field, and then press **Window**. In the screen that appears, set **Bank Enable** to **ON** or **OFF**. When set to **ON**, select the **Bank MSB** or **Bank LSB** values. Press **F4/Close** to return to the previous screen.

  Ch is the MIDI channel the program uses. Use this setting when you are working with a virtual instrument plugin that supports multi-mode.

  **To select a MIDI channel**, use this field.

  **Pgm** is the program used by the current track.

  **To select a program**, use this field.

  **To edit the program**, select this field, and then press **Window**. In the **Edit Program** screen that appears:

  - **F2/Delete** erases all events from the track and resets all of its settings. Press **F4/Delete** to continue or **F3/Cancel** to return to the previous screen.
  - **F3/New** creates a new program. **New Name** is the name that the new program will use. Use the **Type** field to determine the type of program.
  - **F4/Copy** immediately creates an identical program. The duplicate program will use the same name but appended with a number (e.g., **Drums-1**).
  - **F5/Close** returns to the previous screen.

The parameter in the lower-right corner varies depending on the last parameter you adjusted in its sub-window.

To adjust the parameter, use this field.

**To edit the parameters in its sub-window**, select this field, and then press **Window**. Use the fields and buttons in the screen that appears (MIDI programs or CV programs will show only the fields under the **Track** column):
**Level** is the volume level of the program (if it is under **Program**) or track (if it is under **Track**). (You can also use the numeric keypad to change this number.)

**Pan** is the panning position of the program (if it is under **Program**) or track (if it is under **Track**) in the stereo field: **50 L** (left) to **50 R** (right). **C** indicates the center position. (If you use the numeric keypad to change this number, use values from **0** to **100**: **0** corresponds to **50 L**, **50** corresponds to **C**, and **100** corresponds to **50 R**.)

**Mute** determines whether or not the program is muted (**Mute**) or not (**____**).

**Automation** is the program’s automation status.

When **off** (**x**), the program will ignore automation data. If you have already recorded or entered automation, this will switch between **Read** (**R**) and **Write** (**W**) only, but you can override this and turn it off by pressing and holding **Shift** while pressing the button.

**Important:** If you have already recorded automation and turn it off, the track will still use the effect and its parameter values at the point where you turned it off.

When set to **Read** (**R**), the program will read automation data but will not record any additional automation over it. (Think of this as a protective feature to prevent accidental changes to your automation while recording.)

When set to **Write** (**W**), the program can record automation. (If you have any Q-Link knobs assigned to automatable parameters, make sure not to touch any accidentally while you are recording.)

**Tip:** See **General Features > Automation** to learn about setting global automation or automation for individual programs and audio tracks.

**Send1**–**4** show the send levels of the program (**0–100**).

**Inserts** 1–4 show the insert effects loaded to the program.

To **load an effect**, use its **Insert** field. Select an effect in the **Select Effect** screen that appears. Press **F4/Select** to load the selected effect or **F3/Back** to return to the previous screen.

To **change the settings of a loaded effect**, select its **Insert** field, and press **Window**. In the screen that appears, you can select and change each parameter (you can use the numeric keypad on some of them). Press **F4/Close** to return to the previous screen.

To **activate or deactivate an effect**, select its **Insert** field, and press **Window**. In the screen that appears, press **F6/On/Off** to activate or deactivate the effect. Press **F4/Close** to return to the previous screen.

**Tran** is the transposition (in semitones) of the track: **-24** to **+24**. **Off** indicates no transposition (**0** semitones).

**Vel%** determines how loudly or quietly a track plays relative to its recorded levels. When set to **50%**, the track will be played with half the velocity it was originally played. When set to **200%**, the track will play twice as loud. The maximum velocity level is still **127**, though.

**F4/Close** returns to the previous screen without confirming your changes.

**F5/Set** confirms your changes and returns to the previous screen.

---

**Audio Tracks**

These are the buttons under the screen for audio tracks:

- **F1 Midi** Press this button to view your MIDI tracks in Main Mode.
- **F2 Audio** Press this button to view your audio tracks in Main Mode.
- **F3 Track−** Press this button to select the previous track.
- **F4 Track+** Press this button to select the next track.
- **F5 Mute** Press this button to mute the current track.
- **F6 Solo** Press this button to solo the current track.
Shift+F1  T.C.  Press these buttons to open the Timing Correct/T.C. screen, which contains various settings to help quantize the note events in your sequence. See General Features > Timing Correct/T.C. to learn about this.

Shift+F2  Click  Press these buttons to open the Click/Metronome screen, which contains all settings regarding the metronome (click track). See General Features > Click/Metronome to learn about this.

Shift+F3  Peak  Press these buttons to reset the peak indicator on the input level meter.

Shift+F4  RecArm  Press these buttons to record-arm or record-disarm the audio track.

Trk is the current track number and its name.

To select a track, use this field. Alternatively, press F3/Track- or F4/Track+.

To edit the track, select this field, and then press Window. Use the buttons in the Edit Current Track screen that appears:

- F2/Clear erases all regions from the audio track without erasing the track itself. Press F4/OK to continue or F3/Cancel to return to the previous screen.
- F3/New creates a new audio track. Use the fields in the New Audio Track window that appears:
  - Input is the input source of the external audio signal: a stereo pair (Input 1,2–Input 31,32) or a mono channel (Input 1–32).
  - Ascending determines if the channel numbers of the input sources will ascend across the new audio tracks you create. When set to ON, the first new audio track will use the input source you set above (e.g., Input 1,2), the second new audio track will use the next input source (e.g., Input 3,4), the third new audio track (if applicable) will use the next one (e.g., Input 5,6), etc. When set to OFF, all of the new audio tracks you create in this instance will use the same input source. This feature is relevant only if you are creating more than one new audio track (determined by Number Of Tracks below).
  - Record Enable determines whether or not the track will be record-enabled (ON) or not (OFF). When you begin audio recording, the audio signal will be recorded to this track.
  - Input Monitor determines how the track will be monitored: OFF (you will not hear any incoming audio), ON (you will hear incoming audio whether or not the track is record-enabled), or AUTO (you will hear incoming audio while the track is record-enabled only).
  - Number Of Tracks is the number of tracks you will create. (You can also use the numeric keypad to change this number.)
    - F4/Cancel returns to the previous screen without confirming your changes.
    - F5/Do It confirms your changes and returns to the previous screen.
- F4/Delete erases the entire audio track. Press F4/Delete to continue or F3/Cancel to return to the previous screen.
- F5/Close returns to the previous screen.

Input is the input source of the external audio signal: a stereo pair (Input 1,2–Input 31,32) or a mono channel (Input 1–32).

To select an input, use this field.

Mon determines how the new audio track will be monitored.

To select a monitoring option, use this field to select an option:

- OFF: You will not hear any incoming audio.
- ON: You will hear incoming audio whether or not the track is record-enabled.
- AUTO: You will hear incoming audio while the track is record-enabled only.
The **input level meter** shows the current volume level of the audio track.

The **peak indicator** turns solid when the input level meter has exceeded the maximum volume level.

To reset the peak indicator, press Shift+F3/Peak.

**Rec Arm** shows whether or not the track will be record-enabled (ON) or not (OFF). When you begin audio recording, the audio signal will be recorded to this track.

To record-arm or record-disarm the track, set this field to ON or OFF (respectively). Alternatively, press Shift+F4/RecArm.

**Level** is the input gain level of the audio track. This controls the volume level of the audio signal as it records, not as it plays back.

To set the input gain level, use the integer or decimal field.

To set the input gain level and other track settings, select this field, and then press Window. Use the fields and buttons in the screen that appears:

- **Level** is the input gain level of the track. This controls the volume level of the audio signal as it records, not as it plays back. (You can also use the *numeric keypad* to change this number.)

- **Pan** is the panning position of the track in the stereo field: 50 L (left) to 50 R (right). C indicates the center position. (If you use the *numeric keypad* to change this number, use values from 0 to 100: 0 corresponds to 50 L, 50 corresponds to C, and 100 corresponds to 50 R.)

- **Mute** determines whether or not the track is muted (Mute) or not (____).

**Automation** is the track’s automation status.

When off (x), the track will ignore automation data. If you have already recorded or entered automation, this will switch between Read (R) and Write (W) only, but you can override this and turn it off by pressing and holding Shift while pressing the button.

**Important:** If you have already recorded automation and turn it off, the track will still use the effect and its parameter values at the point where you turned it off.

When set to Read (R), the track will read automation data but will not record any additional automation over it. (Think of this as a protective feature to prevent accidental changes to your automation while recording.)

When set to Write (W), the track can record automation. (If you have any Q-Link knobs assigned to automatable parameters, make sure not to touch any accidentally while you are recording.)

**Tip:** See General Features > Automation to learn about setting global automation or automation for individual programs and audio tracks.

**Send1–4** show the send levels of the track (0–100).

**Inserts 1–4** show the insert effects loaded to the track.

To load an effect, use its **Insert** field. Select an effect in the **Select Effect** screen that appears. Press F4/Select to load the selected effect or F3/Back to return to the previous screen.

To change the settings of a loaded effect, select its **Insert** field, and press Window. In the screen that appears, you can select and change each parameter (you can use the *numeric keypad* on some of them). Press F4/Close to return to the previous screen.

To activate or deactivate an effect, select its **Insert** field, and press Window. In the screen that appears, press F6/On/Off to activate or deactivate the effect. Press F4/Close to return to the previous screen.

F4/Close returns to the previous screen without confirming your changes.

F5/Set confirms your changes and returns to the previous screen.
Step Sequencer

The Step Sequencer lets you create or edit sequences by using the pads as “step buttons,” simulating the experience of a traditional step-sequencer-style drum machine.

This is available for MIDI tracks only, not audio tracks.

To enter the Step Sequencer, press Step Seq. (If you cannot enter it because you are viewing audio tracks, press Main and then press F1/Midi to view MIDI tracks first.)

Use the cursors to select each field, and then use the data dial or −/+ buttons to change the parameter. If the field is a number, you can use the numeric keypad to enter a number and then press Enter to confirm it.

To enter or delete steps in a sequence:

1. Press F4/Pad Sel to select the pad whose steps you want to enter or delete, and then press the pad on your MPC hardware. The current pad number is in the Pad field in the upper-right corner. Alternatively, use the Pad field to change the number. (If you use the numeric keypad to change this number, use values from 0 to 127, corresponding to Pad A01 to Pad H16.)
2. Press F2/Bar– or F3/Bar+ to select the bar of the sequence whose steps you want to enter or delete. The current bar number is in the Bar field in the upper-left corner. Alternatively, use the Bar field to change the number.
3. Press the pads of your MPC hardware to enter or delete steps. Each pad corresponds to a step in the bar and will light with a color corresponding to its velocity.

Keep in mind that for time divisions larger than 16, the bar’s steps will be represented by multiple pad banks. In this case, use the Pad Bank buttons to view all the steps within a bar.

These are the buttons under the screen:

- **F1 T.C.** Press this button to open the Timing Correct/T.C. screen, which contains various settings to help quantize the note events in your sequence. See General Features > Timing Correct/T.C. to learn about this.
- **F2 Bar–** Press this button to select the previous bar of the sequence to edit. The current bar number is in the Bar field in the upper-right corner.
- **F3 Bar+** Press this button to select the next bar of the sequence to edit. The current bar number is in the Bar field in the upper-right corner.
- **F4 Pad Sel** Press this button to activate or deactivate Pad Select. When this is activated, use the pads to select a pad rather than enter or delete a step. When this is deactivated, use the pads to enter or delete steps for the pad in the Pad field in the upper-right corner.
- **F5 Pad–** Press this button to select the previous pad whose steps you want to edit. The current pad number is in the Pad field in the upper-right corner.
- **F6 Pad+** Press this button to select the next pad whose steps you want to edit. The current pad number is in the Pad field in the upper-right corner.
Now is the time counter at the top of the screen, which shows the current playhead position. (If the Auto Record feature is on, Punch In or Seq Start will be shown next to the time.) See General Features > Now & Locators to learn about this.

Bar is the bar of the sequence whose steps you want to enter or delete.

To select a bar, press F2/Bar– or F3/Bar+. Alternatively, use the Bar field.

Pad is the pad whose steps you want to enter or delete.

To select a pad, press F4/Pad Sel and then press the pad on your MPC hardware. Alternatively, use the Pad field. If you use the numeric keypad to change this number, use values from 0 to 127, corresponding to Pad A01 to Pad H16.

Seq is the current sequence number and its name.

To select a sequence, use this field.

To edit the sequence, select this field, and then press Window. Use the buttons in the Edit Current Sequence screen that appears:

- F2/Clear clears all events from the sequence and resets all of its settings. Press F4/Clear to continue or F3/Cancel to return to the previous screen.
- F3/Double immediately doubles the sequence in length and copies all events from the first half to the second half.
- F4/Copy copies the contents of one sequence to another. Copy Contents of Sequence is the “source” whose events you want to copy. Over Contents of Sequence is the “destination” sequence where the source sequence will be copied. Set each field to the desired sequence. Press F5/Do It to continue or F4/Back to return to the previous screen.
- F5/Close returns to the previous screen.

BPM is the tempo of the sequence.

To set the tempo, press Tap Tempo in time with the desired tempo. Alternatively, use this integer or decimal field.

To set whether the sequence follows its own tempo (seq) or a master tempo (mst), press Shift+Tap Tempo. Alternatively, select seq/mst, and then use the data dial or –/+ buttons.

Bars is the length of the sequence in bars.

To set the number of bars, use this field.

Loop determines whether or not the sequence (or a part of it) will loop.

To enable or disable looping, use this field.

To set the start point and end point of loop, use the cursors to select this field, and then press Window. In the Loop Measures screen, use the cursors to select each field, and then use the numeric keypad, data dial, or –/+ buttons to change the number:

- First Bar is the first bar of the loop.
- Last Bar is the last bar of the loop.
- Number of Bars is the total number of bars in the sequence.

The level meter in the upper-right corner shows the current volume level of the master mix.
**Tran** is the transposition (in semitones) of the entire sequence: -24 to +24. **Off** indicates no transposition (0 semitones).

**To set the transposition**, use this field.

The **In** and **Out** boxes show that your MPC hardware is receiving or sending (respectively) MIDI messages from or to your computer.

16 **track indicators** are arranged in a 4x4 grid of dots or squares next to the **In** and **Out** boxes. Dots indicate empty/unused tracks. Solid squares indicate used tracks. The outlined square indicates the currently selected track.

**To select a track**, use the **Trk** field.

**Trk** is the current track number and its name.

**To select a track**, use this field.

**To edit the track**, select this field, and then press **Window**. Use the buttons in the **Edit Current Track** screen that appears:

- **F2/Clear** clears all events from the track and resets all of its settings. Press **F4/OK** to continue or **F3/Cancel** to return to the previous screen.
- **F3/Explode** immediately splits the current track into multiple tracks—one for each distinct pad or note (pitch, not event). The current track will also remain present and intact, while each track created from it is labeled with the track name and pad name or number.
- **F4/Copy** copies the contents of one track to another. **Copy Contents of Track** is the “source” track whose events you want to copy. **Over Contents of Track** is the “destination” track where the source track will be copied. Set each field to the desired track. Press **F5/Do It** to continue or **F4/Back** to return to the previous screen.
- **F5/Close** returns to the previous screen.

**Length** determines how long the track is in beats. If you select the minimum value, **Seq** (or 0), the track will be the exact same length as its sequence.

**Tip:** This feature lets you maintain tracks of different lengths. For instance, you could play a 1-bar drum sequence repeatedly under a 4-bar bass line.

**To set the track length**, use this field.

**Type** shows the type of program through which the track is being routed. The specific program name is displayed by the **Pgm** field.

**To select a program type**, use this field to select a drum program (**Drum**), plugin program (**Plugin**), MIDI program (**Midi**), keygroup program (**KGrp**), clip program (**Clip**), or CV program (**CV**).

The screen may show additional fields, depending on the type of program:

- **Drum Program**: (no additional fields)
- **Plugin Program**:

  **Note:** You have to specify the disk directory where your plugins are located. This can be done in the software’s **Preferences**. To see the user guide in the MPC software and learn how to do this, click the **Help** menu, select **MPC Help**, and select **MPC User Manual**.

  **Plg** is the preset (if any) within the plugin the program is using.

**To select a preset**, select this field, and then press **Window**. In the screen that appears, select the desired preset, and press **F5/Select** to continue or **F4/Close** to return to the previous screen. You can press **F2/AutoSel** to activate or deactivate automatic selection, which will automatically load each preset as you move through the list.

**Ch** is the MIDI channel the program uses. Use this setting when you are working with a virtual instrument plugin that supports multi-mode.

**To select a MIDI channel**, use this field.
• **MIDI Program:**

  **Port** is the port over which the program sends its MIDI data.

  **Note:** You also have to configure the MIDI ports in the Preferences. To see the user guide in the MPC software and learn how to do this, click the Help menu, select MPC Help, and select MPC User Manual.

  **To select a port**, use this field.

  **PC** is the program change message the program sends out.

  **To select a program change message**, use this field.

  **To set the MSB and LSB** (Most Significant Byte and Least Significant Byte), select this field, and then press Window. In the screen that appears, set Bank Enable to ON or OFF. When set to ON, select the Bank MSB or Bank LSB values. Press F4/Close to return to the previous screen.

  **Ch** is the MIDI channel the program uses. Use this setting when you are working with a virtual instrument plugin that supports multi-mode.

  **To select a MIDI channel**, use this field.

• **Keygroup Program:** (no additional fields)

• **Clip Program:** (no additional fields)

• **CV Program:**

  **Port** is the port over which the program sends its MIDI data.

  **Note:** You also have to configure the MIDI ports in the Preferences. To see the user guide in the MPC software and learn how to do this, click the Help menu, select MPC Help, and select MPC User Manual.

  **To select a port**, use this field.

  **PC** is the program change message the program sends out.

  **To select a program change message**, use this field.

  **To set the MSB and LSB** (Most Significant Byte and Least Significant Byte), select this field, and then press Window. In the screen that appears, set Bank Enable to ON or OFF. When set to ON, select the Bank MSB or Bank LSB values. Press F4/Close to return to the previous screen.

  **Ch** is the MIDI channel the program uses. Use this setting when you are working with a virtual instrument plugin that supports multi-mode.

  **To select a MIDI channel**, use this field.

• **Pgm** is the program used by the current track.

  **To select a program**, use this field.

  **To edit the program**, select this field, and then press Window. In the Edit Program screen that appears:

  - F2/Delete erases all events from the track and resets all of its settings. Press F4/Delete to continue or F3/Cancel to return to the previous screen.

  - F3/New creates a new program. New Name is the name that the new program will use. Type is the type of program.

  - F4/Copy immediately creates an identical program. The duplicate program will use the same name but appended with a number (e.g., Drums-1).

  - F5/Close returns to the previous screen.
The parameter in the lower-right corner varies depending on the last parameter you adjusted in its sub-window.

To adjust the parameter, use this field.

To edit the parameters in its sub-window, select this field, and then press Window. Use the fields and buttons in the screen that appears (MIDI programs or CV programs will show only the fields under the Track column):

- **Level** is the volume level of the program (if it is under Program) or track (if it is under Track). (You can also use the numeric keypad to change this number.)

- **Pan** is the panning position of the program (if it is under Program) or track (if it is under Track) in the stereo field: 50 L (left) to 50 R (right). C indicates the center position. (If you use the numeric keypad to change this number, use values from 0 to 100: 0 corresponds to 50 L, 50 corresponds to C, and 100 corresponds to 50 R.)

- **Mute** determines whether or not the program is muted (Mute) or not (____).

- **Automation** is the program’s automation status.

  When off (x), the program will ignore automation data. If you have already recorded or entered automation, this will switch between Read (R) and Write (W) only, but you can override this and turn it off by pressing and holding Shift while pressing the button.

  **Important**: If you have already recorded automation and turn it off, the track will still use the effect and its parameter values at the point where you turned it off.

  When set to Read (R), the program will read automation data but will not record any additional automation over it. (Think of this as a protective feature to prevent accidental changes to your automation while recording.)

  When set to Write (W), the program can record automation. (If you have any Q-Link knobs assigned to automatable parameters, make sure not to touch any accidentally while you are recording.)

  **Tip**: See General Features > Automation to learn about setting global automation or automation for individual programs and audio tracks.

- **Send1–4** show the send levels of the program (0–100).
Inserts 1–4 show the insert effects loaded to the program.

To load an effect, use its Insert field. Select an effect in the Select Effect screen that appears. Press F4/Select to load the selected effect or F3/Back to return to the previous screen.

To change the settings of a loaded effect, select its Insert field, and press Window. In the screen that appears, you can select and change each parameter (you can use the numeric keypad on some of them). Press F4/Close to return to the previous screen.

To activate or deactivate an effect, select its Insert field, and press Window. In the screen that appears, press F6/On/Off to activate or deactivate the effect. Press F4/Close to return to the previous screen.

Tran is the transposition (in semitones) of the track: -24 to +24. Off indicates no transposition (0 semitones).

Vel% determines how loudly or quietly a track plays relative to its recorded levels. When set to 50%, the track will be played with half the velocity it was originally played. When set to 200%, the track will play twice as loud. The maximum velocity level is still 127, though.

F4/Close returns to the previous screen without confirming your changes.

F5/Set confirms your changes and returns to the previous screen.

You can also use the Q-Link knobs to adjust the velocity of the note event at each step. The numbers of the steps that correspond to the Q-Link knobs will be shown in the screen.

To show the step numbers in the screen, press Shift+Prog Edit/Q-Links, and then press F5/Screen. Press F6/Parameter/Value to switch between viewing the parameter names (Parameter) and values (Value) in the screen.

To adjust the velocity of each note event, use the corresponding Q-Link knob to select a value (1–127).

To enter a note event at a step, use the corresponding Q-Link knob to change its velocity from 0 (Off) to a value of 1 or greater.

To delete a note event from a step, set the corresponding Q-Link knob to its minimum position, 0 (Off).
Sample Edit Mode

Sample Edit Mode lets you edit samples in three different sub-modes: Trim Mode, Chop Mode, or Program Mode. Each mode has slightly different functions and methods of operation. Please refer to the Trim Mode, Chop Mode, and Program Mode parts of this chapter to learn how each works.

To enter Sample Edit Mode, press Sample Edit.

Tip: You can use Trim Mode for a specific slice of the sample, previously created and selected in Chop Mode. This allows for a more detailed view of a single slice than in Chop Mode and gives you more options for auditioning the slice. You can easily switch between Trim Mode and Chop Mode while doing this.

To use both Trim Mode and Chop Mode to edit a sample slice:

1. Press F1/Trim/Chop so it shows the Chop tab (Chop Mode).
2. Set all fields as desired to create your sample slices.
3. Set Slice to the desired slice.
4. Press F1/Trim/Chop so it shows the Trim tab (Trim Mode). The region you are now editing is indicated by the normal start point and end point markers rather than slice markers.
5. Press F1/Trim/Chop so at any time to return to the Chop tab (Chop Mode).
Trim Mode

We recommend using Trim Mode to simply crop the start and/or end from a sample.

To enter Trim Mode, press F1/Trim/Chop.

These are the buttons under the screen in Trim Mode:

- **F1 Trim**: Press this button to switch between Trim Mode and Chop Mode. See Chop Mode to learn about it.
- **F2 Program**: Press this button to enter Program Mode. See Program Mode to learn more.
- **F3 Zoom Out**: Press this button to zoom out of the waveform.
- **F4 Zoom In**: Press this button to zoom in on the waveform.
- **F5 Assign**: Press this button to show the Assign Sample screen, where you can assign the sample to a program or pad. See Trim Mode > Assigning Samples to learn more.
- **F6 Process**: Press this button to show the Process Slice screen, where you can select different ways in which to process the slice. See Trim Mode > Processing Slices & Samples to learn more.
- **Shift+F3 0 Snap**: Press these buttons to activate or deactivate 0 Snap, which forces start points, end points, and loop points to occur only at the waveform’s “zero-crossings.” This can help prevent clicks and glitches when playing a sample.
- **Shift+F4 Loop**: Press these buttons to switch the loop function between Fwd and Off. See the loop function described here.

**Sample** is the sample you are currently editing.

To select a sample, use this field.

**Loop Lock** determines whether or not the Loop Lock feature is on. When set to ON, the sample’s loop point is the same as the start point. When set to OFF, the loop point is independent from the start point and indicated by a separate marker.

To turn Loop Lock on or off, set this field to ON or OFF (respectively).

**Link** determines whether or not the Link feature is activated. When activated (ON), changing the start point of a slice will also change the end point of the previous slice—and similarly, changing the end point of a slice will also change the start point of the next slice. You must have already created slices in Chop Mode to use this. Set Link to OFF if you are trying to create slices that use non-contiguous parts of the sample.

To enable or disable Link, set this field to ON or OFF (respectively).

**Important**: Link must be disabled (OFF) to make slices non-sequential, non-contiguous, or overlapping.
The waveform shows the “active” section of the sample’s waveform. The highlighted section of the waveform is the currently selected part.

To zoom in on or zoom out of the waveform, press F4/Zoom In or F3/Zoom Out (respectively). Alternatively, turn Q-Link Knob 4 (MPC Renaissance) or the fourth Q-Link knob in the fourth column (MPC Studio).

To scroll through the waveform, turn Q-Link Knob 8 (MPC Renaissance) or the third Q-Link knob in the fourth column (MPC Studio).

Start is the start point of the sample or currently selected slice.

End is the end point of the sample or currently selected slice.

To change the start point or end point, do either of the following:

- Use the Start or End field (respectively).
- Use the first or second column of Q-Link knobs (respectively). The top-most Q-Link knob (13 and 14) in each column provides coarse adjustment. The bottom-most Q-Link knobs (1 and 2) provide fine adjustment.

**Tip:** A recorded sample may have some silence at the beginning or end, which makes it difficult to time it correctly in a musical context. Fix this by adjusting the start point. You can also adjust end point to remove any extra silence or unwanted audio at the end. In addition to making your workflow easier, having a “tight,” well-edited sample can enhance your production or performance.

Loop is the loop point of the sample or currently selected slice, which appears as a solid vertical line in the waveform. When the Loop feature is on, the region of the sample between the loop point and end point will repeat. This is useful when trying to find an ideal spot to begin the sample. The loop cannot be earlier than the start point.

To change the loop point, do either of the following:

- Use this field.
- Use the third column of Q-Link knobs. The top-most Q-Link knob (15) provides coarse adjustment. The bottom-most Q-Link knobs (3) provides fine adjustment.

Slice is which slice of the sample you are editing. You must have already created slices in Chop Mode to use this. 0 corresponds to All.

To select a slice to edit (after you have created slices in Chop Mode), use this field or turn Q-Link Knob 16.

BPM is the tempo of the sample.

To enter a tempo manually, use the integer or decimal field.

To detect the tempo automatically, select the integer or decimal field, and then press Window. Use the fields and buttons in the Edit BPM window that appears:

- Use the integer or decimal BPM field to enter a tempo manually.
- F2/Detect detects the tempo of the sample automatically.
- Press F3/Tap Tempo at the desired rate to use it as the tempo. You can play a sequence in the background to help with your timing.
- F5/Close returns to the previous screen.

**Note:** Before detecting tempo, it is recommended that you Normalize samples for best results.

Note is the root note of the sample. This determines which note will play the sample at its original pitch when in a keygroup program.

To set the root note, use this field.
Loop determines how the sample is currently being looped. When the Loop feature is on, the region of the sample between the loop point and end point will repeat. This is useful when trying to find an ideal spot to begin the sample. The loop cannot be earlier than the start point.

To set how the sample loops, use this field to select an option:

- **Off**: The sample will not loop.
- **Forward (Fwd)**: When the loop reaches its end point, it will start playing again from the loop point.
- **Alternating (Alt)**: When the loop reaches its end point, it will play in reverse. When it reaches the loop point again, it will start playing forward again from the loop point.
- **Reverse (Rev)**: When the loop reaches its end point, it will play in reverse. When it reaches the loop point again, it will return to the end point and continue playing in reverse.

To switch between Fwd and Off, press Shift+F4/Loop.

Tune determines the sample’s tuning relative to its original pitch.

To tune the sample manually, use the integer or decimal field.

To tune the sample automatically, select the integer or decimal field, and then press Window. Use the fields and buttons in the Edit Tuning window that appears:

- **Number Of Beats** defines how many beats are in the sample according to the tempo.
- **F4/Match** automatically tunes the sample to the sequence and returns to the previous screen.
- **F2/To Seq** automatically tunes the sample to the sequence, returns to the previous screen, and matches the sequence’s tempo to the Tempo value from this screen.
- Use the integer or decimal **Tune** field to tune the sample manually.
- **F5/Close** returns to the previous screen.

0 Snap forces start points, end points, and loop points to occur only at the waveform’s “zero-crossings.” This can help prevent clicks and glitches when playing a sample.

To enable or disable 0 Snap, press Shift+F3/0 Snap.
Use your MPC hardware pads to play certain parts of the selected sample:

- **Play Loop** (Pad 13)
- **Play to Loop Start** (Pad 14)
- **Play from Loop Start** (Pad 15)
- **Play Loop Continuous** (Pad 16)
- **Play All** (Pad 9)
- **Play Sample (One Shot)** (Pads 10–12)
- **Play Sample (Note On)** (Pads 10–12)
- **No function** (Pads 10–12)
- **Play from Start (Note On)** (Pads 05–08)
- **Play to Start (Note On)** (Pads 05–08)
- **Play to End (Note On)** (Pads 05–08)
- **Play from End (Note On)** (Pads 05–08)
- **Play from Start (One Shot)** (Pads 01–04)
- **Play to Start (One Shot)** (Pads 01–04)
- **Play to End (One Shot)** (Pads 01–04)
- **Play from End (One Shot)** (Pads 01–04)

**Play Sample (One Shot)** (Pad 10) plays the sample once from the start point to the end point. Press the pad once to play it.

**Play Sample (Note On)** (Pad 11) plays the sample once from the start point to the end point. Press and hold the pad to play it, and release the pad to stop playing it.

**Play Loop Continuous** (Pad 16) plays the sample repeatedly using the mode set by the Loop button (Forward, Reverse, or Alternating; if the Loop button is off, the sample will loop forward repeatedly).

**Play Loop** (Pad 13) plays the sample repeatedly using the mode set by the Loop button (Forward, Reverse, or Alternating; if the Loop button is off, the sample will loop forward repeatedly). Press and hold the pad to play it, and release the pad to stop playing it.

**Play to Loop Start** (Pad 14) plays the part of the sample just before the loop point. Press and hold the pad to play it, and release the pad to stop playing it.

**Play from Loop Start** (Pad 15) plays the sample from the loop point to the end of the sample regardless of the end point. Press and hold the pad to play it, and release the pad to stop playing it.

**Play All** (Pad 9) plays the entire sample.

**Pads 1–4** have the same respective functions as Pads 5–8, but Pads 1–4 play the sample part as “One Shots” (pressing the pad once will play the entire part) while Pads 5–8 play the sample part as “Note Ons” (pressing the pad and holding it will play the part; releasing it will stop playback):

- **Play from Start** (Pad 1, Pad 5) plays the sample from the start point to the end point.
- **Play to Start** (Pad 2, Pad 6) plays the part of the sample just before the start point to the start point.
- **Play to End** (Pad 3, Pad 7) plays the part of the sample just before the end point to the end point.
- **Play from End** (Pad 4, Pad 8) plays the part of the sample from the end point to the end of the sample.
Assigning Samples

You can assign your new sample directly to a pad from Trim Mode.

**Important:** Assigning a sample to a pad in this way will replace the sample on the first layer of the pad.

To assign a sample, press F5/Assign, and use the fields and buttons in the Assign Sample window that appears.

**Assign To** determines how the sample will be assigned.

Assign slice to a pad refers the pad to the slice in this sample instead of creating a new sample. This is useful for reducing clutter in your project.

**Pad** determines the pad to which the slice will be assigned. You can also press a pad to select it.

**Slice Type** determines how the pad’s layer settings will be set when the slice is assigned to it (see Program Edit Mode to learn more about the parameters mentioned below):

- **Non-Destructive Slice** sets each pad’s Slice setting to the slice number.
- **Pad Parameters** sets each pad’s Slice setting to Pad. The pad Start and End parameters will be set to the slice’s start point and end point values, and the Loop position parameter will be set to the slice’s start point but with Pad Loop deactivated.

**Program** determines the program to which the slice will be added.

Make new sample creates a new sample in your project. The original sample will remain as it is.

**Pad** determines the pad to which the slice will be assigned. You can also press a pad to select it.

**Crop Sample** determines whether or not the sample will be cropped. When set to ON, the unused parts of the sample will be deleted when it is created and assigned. This feature is destructive, though the project will still contain your original sample. When set to OFF, the sample will not be cropped, enabling you to edit the sample further even if you are using only part of it at the moment.

**Program** determines the program to which the slice will be added.

F5/Do It assigns the sample and returns to the previous screen.

F4/Close returns to the previous screen without assigning the sample.
Processing Slices & Samples

To apply various editing processes to the sample, press F6/Process, and use the fields and buttons in the Process Slice window that appears.

Function determines how the sample will be processed.

Note: Almost all processes will affect only the part of the sample between the start point and the end point. Only Bit Reduce and Stereo -> Mono will affect the entire sample regardless of its start point or end point.

- **Discard** deletes the regions before the start point and after the end point.
- **Delete** deletes the region between the start point and end point and closes the gap between them.
- **Silence** replaces the region between the start point and end point with silence.
- **Extract** deletes the regions before the start point and after the end point and saves it as a new sample in your current project.
  
  Tip: This is useful if you recorded a drum loop and wanted to remove just a snare drum hit, a kick drum hit, etc. to use separately in the project.

- **Normalize** increases a sample’s level to the highest level possible without distortion. This is essentially a kind of digital gain optimization, so you do not have to worry about excessive level settings when working with samples with a wide range of amplitudes.

- **Reverse** reverses the region between the start point and end point.

  **Fade In** sets a fade-in between the start point and end point. Use the **Type** field to set the curve of the fade:
  
  - **Linear** fades the audio in with a linear curve—a straight line between the start and end.
  - **Log** fades the audio in with a logarithmic curve—quickly rising at the start and flattening out towards the end.
  - **Exp** fades the audio in with an exponential curve—slowly rising in the beginning and growing steeper towards the end.

  **Fade Out** sets a fade-out between the start point and end point. Use the **Type** field to set the curve of the fade:
  
  - **Linear** fades the audio out with a linear curve—a straight line between the start and end.
  - **Log** fades the audio out with a logarithmic curve—quickly rising at the start and flattening out towards the end.
  - **Exp** fades the audio out with an exponential curve—slowly rising in the beginning and growing steeper towards the end.

  **Pitch Shift** changes the pitch of the sample without changing its length. This lets you set the sample’s pitch to your sequence without affecting the sample’s tempo or duration. Use the **Pitch** field to determine the amount: **-12.00 to 12.00** semitones. **0** corresponds to no pitch shift. Keep in mind that the audio quality may decrease at more extreme settings.
Time Stretch lengthens or shortens the sample without changing its pitch. This is useful for matching the durations of two samples with different pitches.

- **Number Of Beats** determines the desired number of beats according to the new tempo.
- **New** determines the new tempo (**Ratio** will then automatically show the time stretch factor).
- **Ratio** is the time-stretch factor of the process (**New** will then automatically change based on this time stretch factor).

Gain Change raises or lowers the volume of the sample. Use the **Gain Amount** field to determine the amount: -18 to 18 dB. 0 corresponds to no gain change. This function is different than Normalize because it will allow volumes beyond clipping level. This may be a desired effect, but remember to watch your output level!

Copy saves a copy of the sample.

Bit Reduce lowers the bit resolution of a sample, effectively reducing its degree of faithful reproduction. Use the **Bit Depth** field to determine the bit depth of the resulting sample: 1–16 bits. The sound is similar to the Resampler effect, but Bit Reduce will permanently alter the sample.

Tip: Use this on drum loops to get a dirty, "old-school" sizzle but with a digital "edge."

Note: This process affects the entire sample regardless of its start point or end point.

Stereo -> Mono converts a stereo sample to a new mono sample and saves it as a new sample. Use the **Source** field to determine which channels are converted:

- **Left** converts the left channel only.
- **Right** converts the right channel only.
- **Sum** combines the left and right audio channels to a single mono channel.

Note: This process affects the entire sample regardless of its start point or end point.

F5/Do It applies the process to sample and returns to the previous screen.

F4/Cancel returns to the previous screen without applying any process.
Chop Mode

Whereas Trim Mode crops only the start and/or end off of a sample, Chop Mode divides the sample into multiple regions called slices. We recommend using Chop Mode when working with a long sample with different sounds throughout (e.g., a drum loop or a long melodic or harmonic passage).

To enter Chop Mode, press F1/Trim/Chop.

These are the buttons under the screen in Chop Mode:

- **F1 Chop** Press this button to switch between Trim Mode and Chop Mode. See Trim Mode to learn about it.
- **F2 Program** Press this button to enter Program Mode. See Program Mode to learn more.
- **F3 Zoom Out** Press this button to zoom out of the waveform.
- **F4 Zoom In** Press this button to zoom in on the waveform.
- **F5 Play Cue** Press this button to play the sample from the cue playhead.
- **F6 Slice +** Press this button to create a slice marker at the cue playhead position. You can do this at any point during sample playback.

**Shift+F1 One Shot** Press these buttons to enable or disable the One Shot feature. When enabled, pressing a pad once plays the entire slice. When disabled, pressing the pad and holding it plays the slice and releasing it stops playback.

**Shift+F2 0 Snap** Press these buttons to activate or deactivate 0 Snap, which forces start points, end points, and loop points to occur only at the waveform’s “zero-crossings.” This can help prevent clicks and glitches when playing a sample.

**Shift+F3 Process** Press these buttons to show the Process Slice screen, where you can select different ways in which to process the slice. See Chop Mode > Processing Slices to learn more.

**Shift+F4 Convert** Press these buttons to show the Convert or Assign Slices screen, where you can convert and assign the sample to a program or pad. See Chop Mode > Converting or Assigning Slices to learn more.

**Shift+F5 Clear All** Press these buttons to remove all slice markers from the sample.

**Shift+F6 Slice –** Press these buttons to remove the slice marker before the current playhead position from the sample.

Sample is the sample you are currently editing.

To select a sample, use this field.
Link determines whether or not the Link feature is activated. When activated (ON), changing the start point of a slice will also change the end point of the previous slice—and similarly, changing the end point of a slice will also change the start point of the next slice. You must have already created slices in Chop Mode to use this. Set Link to OFF if you are trying to create slices that use non-contiguous parts of the sample.

To enable or disable Link, set this field to ON or OFF (respectively).

**Important**: Link must be disabled (OFF) to make slices non-sequential, non-contiguous, or overlapping.

The waveform shows the “active” section of the sample’s waveform. The highlighted section of the waveform is the currently selected part.

To zoom in on or zoom out of the waveform, press F4/Zoom In or F3/Zoom Out (respectively), or turn Q-Link Knob 4 (MPC Renaissance) or the fourth Q-Link knob in the fourth column (MPC Studio).

To scroll through the waveform, turn Q-Link Knob 8 (MPC Renaissance) or the third Q-Link knob in the fourth column (MPC Studio).

Start is where the currently selected slice starts in the sample.

End is where the currently selected slice ends in the sample.

To change the start point or end point, do either of the following:

- Use the Start or End fields (respectively).
- Use the first or second column of Q-Link knobs (respectively). The top-most Q-Link knob (13 and 14) in each column provides coarse adjustment. The bottom-most Q-Link knobs (1 and 2) provide fine adjustment.

**Tip**: A recorded sample may have some silence at the beginning or end, which makes it difficult to time it correctly in a musical context. Fix this by adjusting the start point. You can also adjust end point to remove any extra silence or unwanted audio at the end. In addition to making your workflow easier, having a “tight,” well-edited sample can enhance your production or performance.

Cue is the position of the cue playhead, which appears as a dotted vertical line in the waveform. This is useful when manually inserting slice markers. You can set its position and behavior to suit your workflow.

To set the position of cue playhead, use this field.

To play the sample from the cue playhead, press F5/Play Cue.

To create a slice marker at the cue playhead position, press F6/Slice +.

To set how the cue playhead behaves, select Start, End, or Cue, and then press Window. Use the fields and button in the Cue Play Mode screen that appears:

- **Cue Play Mode** determines how the cue playhead will play audio. When set to One Shot, pressing Play Cue will play the entire sample from the cue playhead. When set to Toggle, pressing Play Cue will start or stop playback from cue playhead.

- **Cue Preview** determines if/how audio plays as you move the cue playhead. As you move the cue playhead through the sample waveform, you can set it to play the small part of the sample before the cue playhead (Before), play the small part of the sample after the cue playhead (After), or not play at all (Off).

- **Slice Preview** determines if/how audio plays as you move a slice marker. As you move a slice marker through the sample waveform, you can set it to play the small part of the sample before the slice marker (Before), play the small part of the sample after the slice marker (After), or not play at all (Off).

F4/Close returns to the previous screen.
**Slice** determines which slice of the sample you are editing. You must have already created slices in Chop Mode to use this. 0 corresponds to **All**.

**To select a slice to edit** (after you have created slices in Chop Mode), use this field or turn **Q-Link Knob 16** (MPC Renaissance) or the **first Q-Link knob** in the **fourth column** (MPC Studio).

**To split or combine slices**, select this field, and then press **Window**. Use the buttons in the **Split/Combine Slice** screen that appears:
- **Split** places a slice marker halfway through the current slice, dividing it into two equal slices.
- **Combine** removes the start point of the current slice, consolidating it with the slice before it.
- **Back** returns to the previous screen without splitting or combining any slices.

**Chop To** determines how you want to use Chop Mode:

**To select a method**, select this field, and then press **Window**. Use the field in the **Chop Mode** screen that appears, and then press **F5/Do It** to continue or **F4/Close** to return to the previous screen.
- **Manual** lets you insert slices at locations you select.
- **Threshold** uses an adjustable detection algorithm that derives the number of slices created from the volume levels present in the sample.
- **Regions** divides a sample into several slices of equal length.
- **BPM** divides a sample into several slices based on the tempo (beats per minute).

The screen may show additional fields, depending on the type of program:
- **Manual**: (no additional fields)
- **Threshold**:
  - **Threshold** determines the threshold level. The higher the selected value, the more slices will be created.
  - **To set the threshold**, use this field or turn **Q-Link Knob 11** (MPC Renaissance) or the **second Q-Link knob** in the **third column** (MPC Studio).
  - **Min Time** determines the minimum length of a slice in milliseconds.
  - **To set the minimum time**, use this field.
- **Regions**:
  - **Regions** determines how many slices into which the sample will be divided. The higher the selected value, the more slices will be created.
  - **To set the number of regions**, use this field or turn **Q-Link Knob 11** (MPC Renaissance) or the **second Q-Link knob** in the **third column** (MPC Studio).
- **BPM**:
  - **Bars** determines how many bars are in the sample.
  - **To set the number of bars**, use this field or turn **Q-Link Knob 11** (MPC Renaissance) or the **second Q-Link knob** in the **third column** (MPC Studio).
  - **Beats** determines how many beats are in each bar.
  - **To set the number of beats**, use this field or turn **Q-Link Knob 7** (MPC Renaissance) or the **third Q-Link knob** in the **third column** (MPC Studio).
  - **Time Div** shows the note division. The slice markers will be placed according to this setting. You can select 1/4, 1/8, 1/16, or 1/32. (In most cases, you should set this parameter to 1/16.)
  - **To set the time division**, use this field or turn **Q-Link Knob 3** (MPC Renaissance) or the **fourth Q-Link knob** in the **third column** (MPC Studio).

**One Shot** determines how a slice is played when you press its corresponding pad. When enabled, pressing a pad once plays the entire slice. When disabled, pressing the pad and holding it plays the slice and releasing it stops playback.

To enable or disable **One Shot**, press **Shift+F4/One Shot**.

**0 Snap** forces start points, end points, and loop points to occur only at the waveform’s “zero-crossings.” This can help prevent clicks and glitches when playing a sample.

To enable or disable **0 Snap**, press **Shift+F3/0 Snap**.
You can create or remove slice markers at the current cue playhead position while your sample is playing or stopped.

To create a slice marker at the cue playhead position, press F6/Slice +.

To remove the slice marker before the current playhead position from the sample, press Shift+F6/Slice –.

To remove all slice markers from a sample, press Shift+F5/Clear All.

To insert a slice marker during sample playback, press an unlit pad (usually Pad 1) to start playback of the sample, and then press an unlit pad during playback to place a slice marker at each location of the playhead. (If you press a lit pad, playback will restart from that pad’s corresponding slice marker.) The number of the pad that is lit green is the number of the most-recently inserted slice marker. The numbers of the pads that are lit yellow are the numbers of the slice markers that are already inserted.
Converting or Assigning Slices

You can assign your new sample directly to a pad from Chop Mode. You can also convert it into a new program or patched phrase.

**To convert or assign a sample,** press **Shift+F4/Convert**, and use the fields and buttons in the **Convert or Assign Slices** window that appears.

**Convert To** determines how the sample will be assigned.

**New drum program using slices** creates a new drum program and assign the sample’s slices to its pads. The pads will simply refer to the slices in this sample instead of creating new samples. This is useful for reducing clutter in your project. The new program will be named after the sample and appended with **ch**.

- **Slice Type** determines how each pad’s layer settings will be set when the slices are assigned to them (see **Program Edit Mode** to learn more):
  - **Non-Destructive Slice** sets each pad’s **Slice** setting to the slice number.
  - **Pad Parameters** sets each pad’s **Slice** setting to **Pad**. The pad **Start** and **End** parameters will be set to the slice’s start point and end point values, and the **Loop** position parameter will be set to the slice’s start point but with **Pad Loop** deactivated.

- **Create Events**, when set to **ON**, automatically creates a new track for the new program in which each pad plays its corresponding slice in ascending sequence by pad number. When set to **OFF**, the program will be added to the project without a track.

- **Number Of Bars** determines how many bars the slices’ events will occupy. This is available only if **Create Events** is set to **ON**.

**New clip program** creates a new clip program and assigns the sample’s slices to its pads as clips. The pads will simply refer to the slices in this sample instead of creating new samples. This is useful for reducing clutter in your project. The new program will be named after the sample and appended with **ch**.

- **Tempo** is the tempo of the clips in the new program.

- **Create Events**, when set to **ON**, automatically creates a new track for the new program in which each pad plays its corresponding slice in ascending sequence by pad number. When set to **OFF**, the program will be added to the project without a track.

- **Number Of Bars** determines how many bars the slices’ events will occupy. This is available only if **Create Events** is set to **ON**.
New program with new samples creates a new sample from each slice and assigns them to pads in a new program. The new program (if Create New Program is set to ON) will be named after the sample and appended with ch. The new samples will be appended with SI-# (where # is a consecutive number).

Crop Samples determines whether or not the sample will be cropped. When set to ON, the unused parts of the sample will be deleted when it is created and assigned. This feature is destructive, though the project will still contain your original sample. When set to OFF, the sample will not be cropped, enabling you to edit the sample further even if you are using only part of it at the moment.

Create New Program, when set to ON, creates a new drum program and assigns the sample’s slices to its pads. When set to OFF, each slice will be converted into a sample that is placed in the project’s sample pool but not assigned to a program or pad.

Create Events, when set to ON, automatically creates a new track for the new program in which each pad plays its corresponding slice in ascending sequence by pad number. When set to OFF, the program will be added to the project without a track. This is available only if Create New Program is set to ON.

Number Of Bars determines how many bars the slices’ events will occupy. This is available only if Create Events is set to ON.

Assign Slice to Pad sets a pad to simply refer to the slice in this sample instead of creating a new sample. This is useful for reducing clutter in your project.

Important: Assigning a sample to a pad in this way will replace the sample on the first layer of the pad.

Pad is the desired pad. (You can also press the desired pad to select it.)

Slice Type determines how each pad’s layer settings will be set when the slices are assigned to them (see Program Edit Mode to learn more):

- Non-Destructive Slice sets each pad’s Slice setting to the slice number.
- Pad Parameters sets each pad’s Slice setting to Pad. The pad Start and End parameters will be set to the slice’s start point and end point values, and the Loop position parameter will be set to the slice’s start point but with Pad Loop deactivated.

Program is the program to which you want to add the slice.
New Sample to Pad creates a new sample in your project. The original sample will remain as it is.

**Important:** Assigning a sample to a pad in this way will replace the sample on the first layer of the pad.

**Pad** is the desired pad. (You can also press the desired pad to select it.)

**Crop Sample** determines whether or not the sample will be cropped. When set to **ON**, the unused parts of the sample will be deleted when it is created and assigned. This feature is destructive, though the project will still contain your original sample. When set to **OFF**, the sample will not be cropped, enabling you to edit the sample further even if you are using only part of it at the moment.

**Program** is the program to which you want to add the sample.

Patched Phrase creates a new sample that will play based on the tempo of your sequence and places it in the current project. The patched phrase will have the same name as the original sample but appended with **pp** and will use a different icon when viewing your project information.

**Bars** determines how many bars long the patched phrase is meant to be.

**F5/Do It** converts the sample and returns to the previous screen.

**F4/Cancel** returns to the previous screen without converting the sample.
Processing Slices

To apply various editing processes to the slice, press Shift + F3/Process, and use the fields and buttons in the Process Slice window that appears.

**Note:** All processes here will affect the currently selected slice only.

---

**Function** determines how the slice will be processed (This has fewer options than Trim Mode.).

**Important:** Chop Mode is non-destructive: You can choose the slice/edit behavior without destroying your original sample, giving you more control over sample playback; you can save your sliced sample and also reuse all of the slice data in another project. See the Program Edit Mode chapter to learn more about setting a pad to play the entire sample, a specific slice of a sample, or a specific region of the sample (independent of its slice markers).

- **Silence** replaces the region between the start point and end point with silence.
- **Extract** deletes the regions before the start point and after the end point and saves it as a new sample in your current project.
- **Tip:** This is useful if you recorded a drum loop and wanted to remove just a snare drum hit, a kick drum hit, etc. to use separately in the project.

- **Normalize** increases a slice's level to the highest level possible without distortion. This is essentially a kind of digital gain optimization, so you do not have to worry about excessive level settings when working with samples with a wide range of amplitudes.
- **Reverse** reverses the region between the start point and end point.
- **Tip:** This is useful if you recorded a drum loop and wanted to remove just a snare drum hit, a kick drum hit, etc. to use separately in the project.

- **Fade In** sets a fade-in between the start point and end point. Use the **Type** field to set the curve of the fade:
  - **Linear** fades the audio in with a linear curve—a straight line between the start and end.
  - **Log** fades the audio in with a logarithmic curve—quickly rising at the start and flattening out towards the end.
  - **Exp** fades the audio in with an exponential curve—slowly rising in the beginning and growing steeper towards the end.

- **Fade Out** sets a fade-out between the start point and end point. Use the **Type** field to set the curve of the fade:
  - **Linear** fades the audio out with a linear curve—a straight line between the start and end.
  - **Log** fades the audio out with a logarithmic curve—quickly rising at the start and flattening out towards the end.
  - **Exp** fades the audio out with an exponential curve—slowly rising in the beginning and growing steeper towards the end.

- **Pitch Shift** changes the pitch of the slice without changing its length. This lets you set the slice’s pitch to your sequence without affecting the sample’s tempo or duration. Use the **Pitch** field to determine the amount: **-12.00** to **12.00** semitones. **0** corresponds to no pitch shift. Keep in mind that the audio quality may decrease at more extreme settings.

- **Gain Change** raises or lowers the volume of the slice. Use the **Gain Amount** field to determine the amount: **-18** to **18 dB.** **0** corresponds to no gain change. This function is different than Normalize because it will allow volumes beyond clipping level. This may be a desired effect, but remember to watch your output level!

F5/Do It applies the process to sample and returns to the previous screen.

F4/Cancel returns to the previous screen without applying any process.
Program Mode

Program Mode lets you edit a sample in the context of the program in which you’ll use it. You can adjust the pad parameters as though you were in Program Edit Mode, auditioning and hearing how it will sound in the program’s audio path.

To enter Program Mode, press F2/Program.

These are the buttons under the screen in Program Mode:

- **F1 Trim**: Press this button to switch between Trim Mode and Chop Mode. See Trim Mode and Chop Mode to learn about each one.
- **F2 Program**: Press this button to enter Program Mode.
- **F3 Zoom Out**: Press this button to zoom out of the waveform.
- **F4 Zoom In**: Press this button to zoom in on the waveform.
- **F5 Assign**: Press this button to show the Assign Sample screen, where you can assign the sample to a program or pad. See Trim Mode > Assigning Samples to learn more.
- **F6 Process**: Press this button to show the Process Slice screen, where you can select different ways in which to process the slice. See Trim Mode > Processing Slices & Samples to learn more.

**Shift+F3 0 Snap**: Press these buttons to activate or deactivate 0 Snap, which forces start points, end points, and loop points to occur only at the waveform’s “zero-crossings.” This can help prevent clicks and glitches when playing a sample.

**Shift+F4 Loop**: Press these buttons to switch the loop function between Fwd and Off. See the loop function described here.

**Shift+F6 To Pad/To All**: Press these buttons to switch the Slice setting between Pad and All.

Press each pad to hear its sample/samples. The sample on its first layer will automatically appear in the waveform display for editing.

**Sample** is the sample you are currently editing.

To select a sample, use this field.

**Loop Lock** determines whether or not the Loop Lock feature is on. When set to ON, the sample’s loop point is the same as the start point. When set to OFF, the loop point is independent from the start point and indicated by a separate marker.

To turn Loop Lock on or off, set this field to ON or OFF (respectively).

The waveform shows the “active” section of the sample’s waveform. The highlighted section of the waveform is the currently selected part.

To zoom in on or zoom out of the waveform, press F4/Zoom In or F3/Zoom Out (respectively). Alternatively, turn Q-Link Knob 4 (MPC Renaissance) or the fourth Q-Link knob in the fourth column (MPC Studio).

To scroll through the waveform, turn Q-Link Knob 8 (MPC Renaissance) or the third Q-Link knob in the fourth column (MPC Studio).
Start is the start point of the sample or currently selected slice. This is shown if Slice is set to All.

PStart is the start point of the sample or currently selected slice. This is shown if Slice is set to Pad.

End is the end point of the sample or currently selected slice. This is shown if Slice is set to All.

PEnd is the end point of the sample or currently selected slice. This is shown if Slice is set to Pad.

To change the start point or end point (when Slice is set to All), do either of the following:

- Use the Start or End field.
- Use the first column of Q-Link knobs. The top-most Q-Link knobs (13 and 14) provide coarse adjustment. The bottom-most Q-Link knobs (1 and 2) provide fine adjustment.

Tip: A recorded sample may have some silence at the beginning or end, which makes it difficult to time it correctly in a musical context. Fix this by adjusting the start point. You can also adjust end point to remove any extra silence or unwanted audio at the end. In addition to making your workflow easier, having a “tight,” well-edited sample can enhance your production or performance.

Loop is the loop point of the sample or currently selected slice, which appears as a solid vertical line in the waveform. When the Loop feature is on, the region of the sample between the loop point and end point will repeat. This is useful when trying to find an ideal spot to begin the sample. The loop cannot be earlier than the start point.

To change the loop point, do either of the following:

- Use this field.
- Use the third column of Q-Link knobs. The top-most Q-Link knob (15) provides coarse adjustment. The bottom-most Q-Link knobs (3) provides fine adjustment.

Slice determines whether the waveform shows the sample as it has been edited (Pad) or the entire sample (All). When set to All, you can display the sample as it has been edited but keep the start point and end point.

To show the edited sample, set this field to Pad, or press Shift+F6/To Pad. PStart, PEnd, and PLoop will show the start, end, and loop points (respectively) of the edited sample, which will remain in their current positions.

To show the entire sample, set this field to All, or press Shift+F6/To All. Start, End, and Loop will show the start, end, and loop points (respectively) of the edited sample.

Loop determines how the sample is currently being looped. When the Loop feature is on, the region of the sample between the loop point and end point will repeat. This is useful when trying to find an ideal spot to begin the sample. The loop cannot be earlier than the start point.

To set how the sample loops, use this field to select an option:

- Off: The sample will not loop.
- Forward (Fwd): When the loop reaches its end point, it will start playing again from the loop point.
- Alternating (Alt): When the loop reaches its end point, it will play in reverse. When it reaches the loop point again, it will start playing forward again from the loop point.
- Reverse (Rev): When the loop reaches its end point, it will play in reverse. When it reaches the loop point again, it will return to the end point and continue playing in reverse.

To switch between Fwd and Off, press Shift+F4/Loop.

0 Snap forces start points, end points, and loop points to occur only at the waveform’s “zero-crossings.” This can help prevent clicks and glitches when playing a sample.

To enable or disable 0 Snap, press Shift+F3/0 Snap.
Assigning Samples

You can assign your new sample directly to a pad from Program Mode.

**Important:** Assigning a sample to a pad in this way will replace the sample on the first layer of the pad.

To assign a sample, press F5/Assign, and use the fields and buttons in the Assign Sample window that appears.

**Assign To** determines how the sample will be assigned.

**Assign slice to a pad** refers the pad to the slice in this sample instead of creating a new sample. This is useful for reducing clutter in your project.

- **Pad** determines the pad to which the slice will be assigned. You can also press a pad to select it.
- **Slice Type** determines how the pad’s layer settings will be set when the slice is assigned to it (see Program Edit Mode to learn more about the parameters mentioned below):
  - **Non-Destructive Slice** sets each pad’s Slice setting to the slice number.
  - **Pad Parameters** sets each pad’s Slice setting to Pad. The pad Start and End parameters will be set to the slice’s start point and end point values, and the Loop position parameter will be set to the slice’s start point but with Pad Loop deactivated.

**Program** determines the program to which the slice will be added.

**Make new sample** creates a new sample in your project. The original sample will remain as it is.

- **Pad** determines the pad to which the slice will be assigned. You can also press a pad to select it.
- **Crop Sample** determines whether or not the sample will be cropped. When set to ON, the unused parts of the sample will be deleted when it is created and assigned. This feature is destructive, though the project will still contain your original sample. When set to OFF, the sample will not be cropped, enabling you to edit the sample further even if you are using only part of it at the moment.

**Program** determines the program to which the slice will be added.

F5/Do It assigns the sample and returns to the previous screen.

F4/Close returns to the previous screen without assigning the sample.
Processing Slices

To apply various editing processes to the sample, press F6/Process, and use the fields and buttons in the Process Slice window that appears. You can process the sample only if Slice is set to All.

**Important:** Program Mode is non-destructive: You can choose the slice/edit behavior without destroying your original sample, giving you more control over sample playback; you can save your sliced sample and but also reuse all of the slice data in another project. See the Program Edit Mode chapter to learn more about setting a pad to play the entire sample, a specific slice of a sample, or a specific region of the sample (independent of its slice markers).

Function determines how the sample will be processed.

**Note:** Almost all processes will affect only the part of the sample between the start point and the end point. Only Bit Reduce and Stereo -> Mono will affect the entire sample regardless of its start point or end point.

- **Discard** deletes the regions before the start point and after the end point.
- **Delete** deletes the region between the start point and end point and closes the gap between them.
- **Silence** replaces the region between the start point and end point with silence.
- **Extract** deletes the regions before the start point and after the end point and saves it as a new sample in your current project.
- **Tip:** This is useful if you recorded a drum loop and wanted to remove just a snare drum hit, a kick drum hit, etc. to use separately in the project.

**Normalize** increases a sample’s level to the highest level possible without distortion. This is essentially a kind of digital gain optimization, so you do not have to worry about excessive level settings when working with samples with a wide range of amplitudes.

**Reverse** reverses the region between the start point and end point.

**Fade In** sets a fade-in between the start point and end point. Use the **Type** field to set the curve of the fade:

- **Linear** fades the audio in with a linear curve—a straight line between the start and end.
- **Log** fades the audio in with a logarithmic curve—quickly rising at the start and flattening out towards the end.
- **Exp** fades the audio in with an exponential curve—slowly rising in the beginning and growing steeper towards the end.

**Fade Out** sets a fade-out between the start point and end point. Use the **Type** field to set the curve of the fade:

- **Linear** fades the audio out with a linear curve—a straight line between the start and end.
- **Log** fades the audio out with a logarithmic curve—quickly rising at the start and flattening out towards the end.
- **Exp** fades the audio out with an exponential curve—slowly rising in the beginning and growing steeper towards the end.
**Pitch Shift** changes the pitch of the sample without changing its length. This lets you set the sample’s pitch to your sequence without affecting the sample’s tempo or duration. Use the **Pitch** field to determine the amount: **-12.00 to 12.00** semitones. **0** corresponds to no pitch shift. Keep in mind that the audio quality may decrease at more extreme settings.

**Time Stretch** lengthens or shortens the sample without changing its pitch. This is useful for matching the durations of two samples with different pitches.

- **Number Of Beats** determines the desired number of beats according to the new tempo.
- **New** determines the new tempo (**Ratio** will then automatically show the time stretch factor).
- **Ratio** is the time-stretch factor of the process (**New** will then automatically change based on this time stretch factor).

**Gain Change** raises or lowers the volume of the sample. Use the **Gain Amount** field to determine the amount: **-18 to 18 dB**. **0** corresponds to no gain change. This function is different than Normalize because it will allow volumes beyond clipping level. This may be a desired effect, but remember to watch your output level!

**Copy** saves a copy of the sample.

**Bit Reduce** lowers the bit resolution of a sample, effectively reducing its degree of faithful reproduction. Use the **Bit Depth** field to determine the bit depth of the resulting sample: **1–16** bits. The sound is similar to the Resampler effect, but Bit Reduce will permanently alter the sample.

**Tip:** Use this on drum loops to get a dirty, “old-school” sizzle but with a digital “edge.”

**Note:** This process affects the **entire** sample regardless of its start point or end point.

**Stereo -> Mono** converts a stereo sample to a new mono sample and saves it as a new sample. Use the **Source** field to determine which channels are converted:

- **Left** converts the left channel only.
- **Right** converts the right channel only.
- **Sum** combines the left and right audio channels to a single mono channel.

**Note:** This process affects the **entire** sample regardless of its start point or end point.

F5/Do It applies the process to sample and returns to the previous screen.

F4/Cancel returns to the previous screen without applying any process.
Program Edit Mode

Program Edit Mode contains all parameters for editing your programs.

To enter Program Edit Mode, press Prog Edit.

Use the cursors to select each field, and then use the data dial or +/- buttons to change the parameter. If the field is a number, you can use the numeric keypad to enter a number and then press Enter to confirm it.

The available parameters in this mode depend on the type of program you are editing.

For drum programs, this mode includes the parameters of four layers as well as all synthesis parameters and insert effect settings. See the Drum Programs section to learn more.

For keygroup programs, this mode contains slightly more parameters than drum programs. See the Keygroup Programs section to learn more.

For clip programs, this mode looks very different from that of other programs due to how clip launching works. See the Clip Programs section to learn more.

For plugin programs, skip to Plugin Programs to learn more.

For MIDI programs and CV programs, skip to MIDI Programs and CV Programs to learn more.

For more general information on the differences between the types of programs, please see General Features > Programs.

To select a program to edit, use the Program field at the top of the screen.
Drum Programs

When using drum programs, Program Edit Mode lets you edit the parameters for each pad.

To select a pad, press it. Its parameters will appear on the screen immediately.

These are the buttons under the screen for drum programs:

- **F1 Master** Press this button to view the Master tab, described [here](#).
- **F2 Samples** Press this button to cycle the three Samples tabs, described [here](#).
- **F3 Pan Vel** Press this button to view the Pan Vel (panning and velocity) tab, described [here](#).
- **F4 Flt Env** Press this button to view the Flt Env (filter envelope) tab, described [here](#).
- **F5 Lfo Mod** Press this button to view the Lfo Mod (LFO modulation) tab, described [here](#).
- **F6 Effects** Press this button to view the Effects tab, described [here](#).

You can edit one pad, multiple pads, or all pads of a drum program simultaneously while in Program Edit Mode.

To select how many pads and which pad/pads you are editing, select any parameter in Program Edit Mode except for the bottom-most eight parameters on the Flt Env tab, and then press Window. In the Edit Zones screen that appears, set the Edit Mode field:

- **Current**: Only the currently selected pad can be edited.
- **Multiple**: All selected pads can be edited simultaneously.
- **All**: All pads can be edited simultaneously.

Tip: You can immediately select or deselect multiple pads while on any tab in Program Edit Mode (regardless of the current Edit Mode setting). To do this, press Shift and each desired pad. Edit Mode will automatically change to the corresponding setting.
In the **Master** tab, you can configure playback settings and tuning for the program and pads.

<table>
<thead>
<tr>
<th>Program: Drums</th>
</tr>
</thead>
<tbody>
<tr>
<td>Poly: Poly: Poly Semi:</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>0:Fine: 0:</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Level: 71 Pan: C</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Sim Play 1: Off: 2: Off:</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Mute Tgt 1: Off: 2: Off:</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Master Samples Pan Vel Flt Env Lfo Mod Effects</td>
</tr>
</tbody>
</table>

**Poly** (Polyphony) is the playback mode of the pads in the program.

- **To set the playback mode of all pads in the program**, use this field to select an option:
  - **Mono**: Only one pad will sound at a time. If a pad is played while another (or the same one) is still playing its sample/samples, the new pad will immediately mute all other currently playing pads in that program.
  - **Poly**: Several pads can be triggered at the same time (limited only by the total number of voices available).

**Semi** is the coarse tuning of the program: **-36** to **+36** semitones. **0** corresponds to no coarse-tuning adjustment.

- **To set the coarse tuning of the program**, use this field.

**Fine** is the fine tuning of the program: **-99** to **+99** cents. **0** corresponds to no fine-tuning adjustment.

- **To set the fine tuning of the program**, use this field.

**Level** is the overall volume level of the loaded sample/samples of the current pad.

- **To set the volume level of the pad**, use this field.

**Pan** is the overall panning position of the loaded sample/samples of the current pad in the stereo field: **50L** (left) to **50R** (right). **C** indicates the center position.

- **To set the panning position of the pad**, use this field. If you use the numeric keypad to change this number, use values from **-50** to **+50**: **-50** corresponds to **50L**, **0** corresponds to **C**, and **+50** corresponds to **50R**.

**Sim Play 1–4** (Simultaneous Play) can be set to one to four pads (in the same program) that will be triggered by pressing the current pad—the pads will play simultaneously.

**Tips**: This feature is useful for triggering a stack of sounds such as layered kick drums.

- **To assign pads to play simultaneously with the current pad**, use these fields.

**Mute Tgt 1–4** (Mute Target) can be set to one to four pads (in the same program) for the currently selected pad. When the currently selected pad is played, it will immediately silence its mute targets.

- **To assign pads to the mute target of the current pad**, use these fields.

**Tips**:
- This feature is useful for programming realistic hi-hats, especially if only the open or closed hat should be heard.
- This feature is similar to the **mute group** feature, available for both drum programs and keygroup programs.
Samples

Each pad can trigger up to four samples, which are assigned in four individual layers. Each layer has identical, independently assignable parameters.

Press **F2**/Samples to cycle through its three available tabs.

**Important:** The parameters in the Samples tabs work in conjunction with Chop Mode (in Sample Edit Mode). Here’s how it works:

When working in Sample Edit Mode and using Chop Mode to divide a sample into slices for your pads, you can convert a slice using Non-Destructive Slice or Pad Parameters.

A Non-Destructive Slice will let its pad to refer to that slice when you press it; the original sample remains intact and each slice marker is like a “bookmark” for a pad. In Program Edit Mode, you’ll see that the layer to which it’s assigned has its Slice setting set to the corresponding slice number in the original sample. Playing that pad will cause it to refer to that slice marker like a “bookmark” instead of creating an entirely new sample of that slice. This means that you no longer have to clutter your project with a new sample for every slice (though you can still use this earlier method, if you prefer).

A slice converted using Pad Parameters is very similar to a non-destructive slice described above. The difference is that in Program Edit Mode, the layers they’re assigned to have their Slice settings set to Pad (instead of the slice number), and the start and end points will correspond to the slice markers in the original sample.

The first Samples tab contains controls for the pitch, timing, and playback of the current layer.

**Loop Lock** determines if the loop point of a sample layer is “linked to” or “unlinked from” the start point.

When set to **On**, the loop point is the same as the start point.

When set to **Off**, the loop point is independent from the start point and indicated by a separate loop marker. This is the same as the Loop Lock button in Sample Edit Mode.

To turn Loop Lock on or off, set this field to **On** or **Off** (respectively).

**Layer** is the layer you are editing within the current pad: 1–4.

To select a layer, use this field.

**Smpl** (Sample) is the name of the sample assigned to the current layer of the pad. Remember that the sample has to be loaded into the project’s sample pool beforehand. To learn how to load samples into a project, please see **Browser**.

To assign a sample, use this field.
Start and End define where the sample will start and stop playing when the pad is triggered.

To change the start point or end point, do either of the following:

- Use the Start or End field (respectively).
- Use the first or second column of Q-Link knobs (respectively). The top-most Q-Link knobs (13 and 14) provide coarse adjustment. The bottom-most Q-Link knobs (1 and 2) provide fine adjustment.

**Note:** When Loop Lock is set to ON, the loop position (as determined by the Loop field, if enabled) is the same as the sample’s start point. When set to OFF, the loop position is independent from the start point.

**Note:** The 0 Snap feature in Sample Edit Mode is helpful when used in conjunction with these settings. 0 Snap forces start points, end points, and loop points to occur only at the waveform’s “zero-crossings,” which can help prevent clicks and glitches when playing a sample. See this description to learn more.

**Tip:** A recorded sample may have some silence at the beginning or end, which makes it difficult to time it correctly in a musical context. Fix this by adjusting the start point. You can also adjust end point to remove any extra silence or unwanted audio at the end. In addition to making your workflow easier, having a “tight,” well-edited sample can enhance your production or performance.

Loop is where the sample will loop when the pad is triggered. When the Loop feature is on, the region of the sample between the loop point and end point will repeat. This is useful when trying to find an ideal spot to begin the sample. The loop cannot be earlier than the start point.

To change the loop point, use this field, or use the third column of Q-Link knobs. The top-most Q-Link knob (15) provides coarse adjustment. The bottom-most Q-Link knobs (3) provides fine adjustment.

Slice is which slice of the sample is assigned to the pad. You must have already created slices in Chop Mode (in Sample Edit Mode) to use this. 0 corresponds to All.

**Note:** The Link Slices setting in Sample Edit Mode is helpful when used in conjunction with this setting. Link Slices determines how the start point and end point of a slice in a larger sample is set. See this description to learn more.

To select a slice to edit (after you have created slices in Chop Mode in Sample Edit Mode), use this field or turn Q-Link Knob 16 (MPC Renaissance) or the first Q-Link knob in the fourth column (MPC Studio) to select an option:

- **All:** The entire sample will play.
- **Pad:** The sample will play from the Start position to the End position, described earlier. This also lets you activate Loop (if the Sample field in the Lfo Mod tab is set to NoteOn).
- **Slice 1, 2, 3, etc.:** If you have sliced the sample in Chop Mode (in Sample Edit Mode), you can select which slice will play when you trigger the pad.

Tune is the coarse and fine tuning of the sample when played by the pad. The first number is coarse tuning (-36 to +36 semitones) and the second number is fine tuning (-99 to +99 cents). 0 corresponds to no tuning adjustment.

**Note:** These settings will affect the length of the sample (if Warp is set to Off). Also, these are the same as Semi and Fine on the second Samples tab.

To adjust the tuning, use these fields.

Dir (Direction) determines which direction the sample will play.

To set the playback direction, use this field to select an option:

- **Forward (Fwd):** The sample will play in the normal forward direction.
- **Reverse (Rev):** The sample will play in reverse.
Loop determines how the sample will be looped. When the Loop feature is on, the region of the sample between the loop point (determined by the Loop field in the second row) and end point will repeat. This is useful when trying to find an ideal spot to begin the sample. The loop cannot be earlier than the start point.

Important: For Loop to work, you must (1) set the Sample field (in the Lfo Mod tab) to NoteOn instead of OneSht and (2) set the Slice field (in the first Samples tab) to Pad instead of All or a slice number.

To set how the sample loops, use this field to select an option:

- Off: The sample will not loop.
- Forward (Fwd): You can hold down the pad to cause that sample to repeat from the loop point to the end of the sample. Release the pad to stop the repeating playback.
- Alternating (Alt): You can hold down the pad to cause that sample to play from the loop point to the end of the sample and then play in reverse until it reaches the loop point again. This will repeat as long as you are holding the pad down. Release the pad to stop the repeating playback.
- Reverse (Rev): You can hold down the pad to cause that sample to play in reverse, repeating from the end of the sample to the loop point. Release the pad to stop the repeating playback.

Warp determines whether or not stretching the time of the sample will change its pitch and vice versa. When set to On, lengthening or shortening the sample (based on the BPM) will not change its pitch. When set to Off, lengthening or shortening the sample will also change its pitch and vice versa. Use the Stretch, BPM, and BPM Sync settings (described below) in conjunction with this feature. See the note below to learn how to minimize CPU requirements while using Warp.

To set whether or not the sample is warped, set this field to On or Off (respectively).

Stretch is the “stretch factor,” which affects how the sample is warped (if Warp is set to On). See the note below to learn how to minimize CPU requirements while using Warp.

To set the stretch factor, use this field.

BPM is the tempo used when a sample is warped (if Warp is set to On). See the note below to learn how to minimize CPU requirements while using Warp.

To set the tempo of the sample, use this field.

BPM Sync determines whether the tempo of the sample is linked to or independent of the tempo of the sequence. When BPM Sync and Warp are both set to On, the sample’s tempo will be “locked” to the tempo of the sequence. When BPM Sync is set to Off but Warp is set to On, the sample will be independent of the tempo of your sequence—use the Stretch field to lengthen or shorten a sample. See the note below to learn how to minimize CPU requirements while using Warp.

To enable or disable BPM Sync, set this field to On or Off (respectively).

Note: The Warp algorithms are very CPU-intensive and can result in audio drop-outs during playback if used too freely. Be mindful of how (and how often) you use the warp function. You can reduce the CPU resources required by doing any/all of the following:

- Avoid using extreme Stretch values.
- Minimize the amount of pitch adjustment (e.g., the Tune parameter) of warped audio.
- Avoid warping very small track regions.
- Warp as few tracks or track regions as possible (i.e., reduce the number of total number of voices of the polyphonic limit that use the Warp algorithm at a given time), especially instances where the warped regions start at the same time.
- Avoid rapidly triggering samples that are warped.

If you have warped samples used in a drum program, consider using the Flatten Pad function to consolidate the affected pad’s layers into one audio sample. After you flatten the pad, its sample/samples no longer need to be warped. To see the user guide in the MPC software and learn how to do this, click the Help menu, select MPC Help, and select MPC User Manual.
The second Samples tab contains controls for the pitch and volume level of each layer.

Loop Lock determines if the loop point of a sample layer is “linked to” or “unlink from” the start point. When set to On, the loop point is the same as the start point. When set to Off, the loop point is independent from the start point and indicated by a separate loop marker. This is the same as the Loop Lock button in Sample Edit Mode.

To turn Loop Lock on or off, set this field to On or Off (respectively).

S1–4 (Sample 1–4) is the name of the sample assigned to the current layer (1–4) of the pad. Remember that the sample has to be loaded into the project’s sample pool beforehand. To learn how to load samples into a project, please see Browser.

To assign a sample, use this field or turn the corresponding Q-Link knob (1, 5, 9, or 13 on MPC Renaissance or the first column of Q-Link knobs on MPC Studio).

Semi is the coarse tuning of the sample on each layer: -36 to +36 semitones. 0 corresponds to no coarse-tuning adjustment. This will affect the length of the sample (if Warp is set to Off).

To set the coarse tuning of the sample on each layer, use this field or turn the corresponding Q-Link knob (2, 6, 10, or 14 on MPC Renaissance or the second column of Q-Link knobs on MPC Studio).

Fine is the fine tuning of the sample on each layer: -99 to +99 cents. 0 corresponds to no fine-tuning adjustment. This will affect the length of the sample (if Warp is set to Off).

To set the fine tuning of the sample on each layer, use this field or turn the corresponding Q-Link knob (3, 7, 11, or 15 on MPC Renaissance or the third column of Q-Link knobs on MPC Studio).

Level is the volume of the sample on each layer, enabling you to control the “balance” of the samples assigned to the pad.

To set the volume level of the sample on each layer, use this field or turn the corresponding Q-Link knob (4, 8, 12, or 16 on MPC Renaissance or the fourth column of Q-Link knobs on MPC Studio).
The **third Samples** tab contains a control for the offset of the sample on each layer.

Loop Lock determines if the loop point of a sample layer is “linked to” or “unlinked from” the start point. When set to On, the loop point is the same as the start point. When set to Off, the loop point is independent from the start point and indicated by a separate loop marker. This is the same as the Loop Lock button in Sample Edit Mode.

To turn Loop Lock on or off, set this field to On or Off (respectively).

S1–4 (Sample 1–4) is the name of the sample assigned to the current layer (1–4) of the pad. Remember that the sample has to be loaded into the project’s sample pool beforehand. To learn how to load samples into a project, please see Browser.

To assign a sample, use this field or turn the corresponding Q-Link knob (1, 5, 9, or 13 on MPC Renaissance or the first column of Q-Link knobs on MPC Studio).

Offset is the time offset of the sample’s playback on each layer. When this setting is a positive value, playing the pad will immediately trigger the sample on that layer but at a later point in the sample (specified by this setting). When this setting is a negative value, the sample playback on that layer will be delayed by the amount specified by this setting.

To set the offset of the sample on each layer, use this field or turn the corresponding Q-Link knob (2, 6, 10, or 14 on MPC Renaissance or the second column of Q-Link knobs on MPC Studio).

Panning & Velocity

The **Pan Vel** tab contains settings that determine the stereo placement and velocity ranges of each layer of the pad.

Pan is the panning position of the sample on each layer in the stereo field: 50L (left) to 50R (right). C indicates the center position.

To set the panning position of the sample on each layer, use this field or turn the corresponding Q-Link knob (1, 5, 9, or 13 on MPC Renaissance or the first column of Q-Link knobs on MPC Studio). If you use the numeric keypad to change this number, use values from -50 to +50: -50 corresponds to 50L, 0 corresponds to C, and +50 corresponds to 50R.

Low and High determine the lowest and highest velocities (respectively) that will trigger the sample on each layer. A range from 0 to 127 lets the layer respond to the entire velocity range which is input from the respective pad, while, for example, a range from 100 to 127 lets the layer respond only to higher velocity levels. By assigning several samples of one instrument, you can create a realistic-sounding “multi-sample” by adjusting the velocity ranges of each layer accordingly. For example, you may have three samples of a drum hit with low force, medium force, and high force. You can set each sample to a layer and set the velocity ranges so only low velocities trigger the low-force sample, only mid-range velocities trigger the medium-force sample, and only high velocities trigger the high-force sample.

To set the velocity range of the sample on each layer, use these fields or turn the corresponding Q-Link knob: for low velocities, turn Q-Link Knob 2, 6, 10, or 14 (MPC Renaissance) or the second column of Q-Link knobs (MPC Studio); for high velocities Q-Link Knob 3, 7, 11, or 15 (MPC Renaissance) or the third column of Q-Link knobs (MPC Studio).
Filter Envelope

The Flt Env tab contains settings for the filter and amp envelopes that affect the pad.

![Program: Drums](image)

**Type** determines the filter that is applied to the selected pad. See Appendix > Glossary > Filter for an explanation of the available filter types.

To set the filter type, use this field or turn Q-Link Knob 13 (MPC Renaissance) or the first Q-Link knob in the first row (MPC Studio).

**Cutoff** is the cutoff frequency for low-pass and high-pass filter types or the center frequency for band-pass and band-stop filter types. See Appendix > Glossary > Filter for an explanation of the available filter types.

To set the filter cutoff frequency, use this field or turn Q-Link Knob 14 (MPC Renaissance) or the second Q-Link knob in the first row (MPC Studio).

**Reso** (Resonance) is the emphasis of the frequencies around the cutoff point.

**Tip**: Use values lower than 80 to give more brilliance to the sound. At values higher than 80, the sound will result in a strong audible boost around the cutoff frequency.

To set the filter resonance, use this field or turn Q-Link Knob 15 (MPC Renaissance) or the third Q-Link knob in the first row (MPC Studio).

**Env** (Envelope) determines the amount of influence the filter envelope has on the cutoff frequency. Higher settings will increase the modulation of the filter by the envelope; lower settings will result in only subtle changes of the filter Cutoff over time.

**Tip**: To give a sound a more distinctive attack, increase the Env setting and set low Atk and Dec values as well as a medium-low Sust value of the filter envelope (Flt). This will start a sound with the filter opened and close it shortly afterward, giving it a bright start followed by a darker sustain. String sounds, on the other hand, can sound much more “alive” with low Env settings and a high Atk value, resulting in a slight fade-in of the higher frequencies.

To set the filter envelope amount, use this field or turn Q-Link Knob 16 (MPC Renaissance) or the fourth Q-Link knob in the first row (MPC Studio).

**V>Start** (Velocity→Start) determines how much velocity is needed (for a triggered pad) to modulate the sample start point.

To set the “velocity to start,” use this field or turn Q-Link Knob 9 (MPC Renaissance) or the first Q-Link knob in the second row (MPC Studio).

**V>Attack** (Velocity→Attack) determines how much velocity is needed (for a triggered pad) to modulate the Attack (Atk) phase for the Amp envelope.

To set the “velocity to filter attack,” use this field or turn Q-Link Knob 10 (MPC Renaissance) or the second Q-Link knob in the second row (MPC Studio).

**V>Env** (Velocity→Envelope) determines to what degree velocity information affects the amount of the filter envelope’s effect on the cutoff frequency.

To set the “velocity to envelope amount,” use this field or turn Q-Link Knob 11 (MPC Renaissance) or the third Q-Link knob in the second row (MPC Studio).

**V>Filter** (Velocity→Filter) determines to what degree the velocity of a pad modulates the cutoff frequency directly.

To set the “velocity to filter cutoff,” use this field or turn Q-Link Knob 12 (MPC Renaissance) or the fourth Q-Link knob in the second row (MPC Studio).
The third row of parameters determine how the filter envelope affects the filter frequency over a period of time. There are three possible sets of parameters, depending on the type of envelope:

- **AD** (attack-decay) envelope: Flt Atk (filter attack), Flt Dec (filter decay), and Dec Type (decay type)
- **AHDS** (attack-hold-decay-sustain) envelope: Flt Atk (filter attack), Flt Hold (filter hold), Flt Dec (filter decay), and Flt Sust (filter sustain)
- **ADSR** (attack-decay-sustain-release) envelope: Flt Atk (filter attack), Flt Dec (filter decay), Flt Sust (filter sustain), and Flt Rel (filter release)

See the later *Anatomy of an Envelope* section to learn about these envelope parameters.

To adjust the filter envelope parameters, use these fields or turn the corresponding Q-Link knob (5–8 on MPC Renaissance or the Q-Link knobs in the third row on MPC Studio).

To set the envelope type, press F5/Lfo Mod and set Sample to One Shot (OneSht), if you want to select an AD or AHDS envelope, or Note On (NoteOn), if you want to use ADSR envelopes only. To select an AD or AHDS envelope, press F4/Flt Env, select one of the eight bottom-most parameters, and then press Window. Use the Filter Envelope AD Mode field in the screen that appears to select an AD envelope (On) or AHDS (Off), and then press F4/Close.

The fourth row of parameters determine how the amp envelope affects the volume level over a period of time. There are three possible sets of parameters, depending on the type of envelope:

- **AD** (attack-decay) envelope: Amp Atk (amp attack), Amp Dec (amp decay), and Dec Type (decay type)
- **AHDS** (attack-hold-decay-sustain) envelope: Amp Atk (amp attack), Amp Hold (amp hold), Amp Dec (amp decay), and Amp Sust (amp sustain)
- **ADSR** (attack-decay-sustain-release) envelope: Amp Atk (amp attack), Amp Dec (amp decay), Amp Sust (amp sustain), and Amp Rel (amp release)

See the later *Anatomy of an Envelope* section to learn about these envelope parameters.

To adjust the amp envelope parameters, use these fields or turn the corresponding Q-Link knob (1–4 on MPC Renaissance or the Q-Link knobs in the fourth row on MPC Studio).

To set the envelope type, press F5/Lfo Mod and set Sample to One Shot (OneSht), if you want to select an AD or AHDS envelope, or Note On (NoteOn), if you want to use ADSR envelopes only. To select an AD or AHDS envelope, press F4/Flt Env, select one of the eight bottom-most parameters, and then press Window. Use the Volume Envelope AD Mode field in the screen that appears to select an AD envelope (On) or AHDS (Off), and then press F4/Close.
LFO Modulation

The Lfo Mod tab contains settings that determine sample playback and low-frequency oscillator of the pad.

**Mute Group** determines if the pad is assigned to a mute group: 1–32 or Off (no mute group). When pads assigned to the same mute group receive MIDI notes, the last pad played will silence all other pads in that mute group. A mute group affects pads within that program only; mute groups do not affect pads in other programs.

**Tip:** This feature is useful for programming realistic hi-hats, especially if only the open or closed hat should be heard.

To set the mute group, use this field or turn Q-Link Knob 13 (MPC Renaissance) or the first Q-Link knob in the first row (MPC Studio).

**Layer** determines how multiple samples assigned to the pad are played:

To set the layer playback option, use this field or turn Q-Link Knob 14 (MPC Renaissance) or the second Q-Link knob in the first row (MPC Studio) to select an option:

- **Cycle (Cyc):** Each time the pad is played, it will play the next layer’s sample. In other words, the samples will cycle through the layers as follows: 1, 2, 3, 4, 1, 2, 3, 4… etc.
- **Velocity (Vel):** The pad will switch between layers depending on how hard you press a pad.
- **Random (Ran):** Each time the pad is played, it will play one of its layer’s samples at random.

**Sample** determines how much of the samples assigned to the pad are played.

To set the playback amount of the samples on the pad, set this field to OneSht or NoteOn, or turn Q-Link Knob 15 (MPC Renaissance) or the third Q-Link knob in the first row (MPC Studio), to select an option:

- **One Shot (OneSht):** The samples will play from start to end when the pad is pressed. Use this when you want to play short sounds.
- **Note On (NoteOn):** The samples will play only as long as the pad is held down. This is better for longer samples so you can control a sound’s duration by pressing and holding its corresponding pad.

**Poly** (Polyphony) determines how the pad’s sound behaves when multiple hits are registered.

To set the polyphony of the pad, set this field to Mono or Poly, or turn Q-Link Knob 16 (MPC Renaissance) or the fourth Q-Link knob in the first row (MPC Studio), to select an option:

- **Mono:** Only one pad will sound at a time. If a pad is played while another (or the same one) is still playing its sample/samples, the new pad will immediately mute all other currently playing pads in that program.
- **Poly:** Several pads can be triggered at the same time (limited only by the total number of voices available). You can also select a specific number of pads (2–32) so that you can trigger up to this many pads at the same time (unless they exceed the total number of voices available).

**V>Pitch** (Velocity→Pitch), **V>Atk** (Velocity→Attack), **V>Amp** (Velocity→Amp), and **V>Pan** (Velocity→Panning) determine how much the velocity affects the pitch of the sound (Pitch), the attack of the filter envelope (Atk), the volume level of the filter envelope (Amp) and or the panning of the sound (Pan). When you press a pad softly, only minimal modulation is applied. When you press it harder, the modulation amount also gets stronger depending on the setting of the corresponding knob.

To adjust the velocity sensitivity of the pad, use these fields or turn the corresponding Q-Link knob (9–12 on MPC Renaissance or the Q-Link knobs in the second row (MPC Studio).
A low-frequency oscillator (LFO) generates a periodic waveform with an adjustable frequency and shape which can be used for modulation purposes. The seven settings in the lower half of the screen affect the LFO applied to the pad.

**Wave** is the type of waveform the LFO uses.

To select the waveform of the LFO, use this field or turn Q-Link Knob 5 (MPC Renaissance) or the first Q-Link knob in the third row (MPC Studio) to select an option:

- Sine (best suited for smooth modulations)
- Triangle (best suited for smooth modulations)
- S&H (samples a random value and holds it until the next value is generated)
- Saw (can generate interesting filter or volume changes)
- Saw Down (can generate interesting filter or volume changes)
- Square (interesting results with hard-panning modulations)
- Noise (generates random values and glides)

**Rate** is the LFO frequency when Sync is on. At lower values, it might take some time for the LFO to complete a cycle, while higher values will come closer to audible range.

To set the frequency of the LFO, use this field or turn Q-Link Knob 6 (MPC Renaissance) or the second Q-Link knob in the third row (MPC Studio).

Sync determines if or how the LFO’s rate is synchronized with the tempo. You can select one of several time divisions (a . indicates a dotted note; a T indicates a triplet-based time division). When None is selected, Sync is off.

To set the synchronization of the LFO, use this field or turn Q-Link Knob 7 (MPC Renaissance) or the third Q-Link knob in the third row (MPC Studio).

L>Pitch (LFO→Pitch), L>Filter (LFO→Filter), L>Amp (LFO→Amp), and L>Pan (LFO→Panning) determine how much the LFO affects the pitch of the sound (Pitch), the cutoff frequency of the filter (Filter), the volume level of the sound (Amp), and the panning of the sound (Pan). When you press a pad softly, only minimal modulation is applied. When you press it harder, the modulation amount also gets stronger depending on the setting of the corresponding knob.

To adjust the LFO destinations of the pad, use these fields or turn the corresponding Q-Link knob (1–4 on MPC Renaissance or the Q-Link knobs in the fourth row (MPC Studio).
Effects

Effects shows the insert effects and send effect levels for the pad. You can select up to four insert effects for each pad. Additionally, each pad can be sent to up to four return channels, each of which can have up to four insert effects of their own. Their audio will be routed through the insert effects on those returns, and the processed audio will be sent to a master output.

Please see General Features > Effects to learn more about using insert and send effects.

Inserts determines whether insert effects are activated (ON) or deactivated (OFF) for the pad.

To activate or deactivate all four insert effects, set this field to ON or OFF (respectively).

Insert 1–4 are the four available slots for insert effects on that pad.

To load an effect, select an Insert field, and then use the data dial or +/- buttons. In the Select Effect screen that appears, select an effect. Press F4/Select to load the selected effect or F3/Back to return to the previous screen.

To change the settings of a loaded effect, select an Insert field with an effect, and press Window. In the screen that appears, you can select and change each parameter (you can use the numeric keypad on some of them). Press F4/Close to return to the previous screen.

To activate or deactivate an effect, select its Insert field, and press Window. In the screen that appears, press F6/On/Off to activate or deactivate the effect. Press F4/Close to return to the previous screen.

To activate or deactivate all four insert effects, set the Inserts field to ON or OFF (respectively).

Send 1–4 are the audio signal levels that the pad sends to the four return channels, each of which can have up to four insert effects—these are send effects. The send effects will then send the audio to the assigned master output at the designated return levels.

To adjust the send levels, turn their corresponding Q-Link knobs (4, 8, 12, or 16 on MPC Renaissance or the Q-Link knobs in the fourth column on MPC Studio).

Important: To edit the send effects, use the Channel Mixer. See Channel Mixer > Returns to learn more how to do this.
Keygroup Programs

When using keygroup programs, Program Edit Mode lets you edit the parameters for each keygroup.

To select a keygroup to edit, press F1/Master and use the Kg Select field or turn Q-Link Knob 9 (MPC Renaissance) or the first Q-Link knob in the second row (MPC Studio). You can select All to edit all keygroups simultaneously. The current settings will appear on the screen immediately.

These are the buttons under the screen for keygroup programs:

- F1 Master: Press this button to view the Master tab, described here.
- F2 Samples: Press this button to cycle the three Samples tabs, described here.
- F3 Pan Vel: Press this button to view the Pan Vel (panning and velocity) tab, described here.
- F4 Flt Env: Press this button to view the Flt Env (filter envelope) tab, described here.
- F5 Lfo Mod: Press this button to view the Lfo Mod (LFO modulation) tab, described here.
- F6 Effects: Press this button to view the Effects tab, described here.

You can create up to 128 keygroups within a keygroup program. This is useful when working with multi-samples. For example, if you want to create a realistic piano, you can use different keygroups (e.g., 88 for a grand piano) with every keygroup containing its own sampled note (with up to four possible velocity layers).

To set the number of keygroups in the program, select any parameter in Program Edit Mode except for the bottom-most eight parameters on the Flt Env tab, and then press Window. In the Set Number of Keygroups screen that appears, set the Num Keygroups field to the desired number of keygroups (1–128).

To select a keygroup to edit, press F1/Master and use the Kg Select field or turn Q-Link Knob 9 (MPC Renaissance) or the first Q-Link knob in the second row (MPC Studio). You can select All to edit all keygroups simultaneously. The current settings will appear on the screen immediately.
Master

In the Master tab, you can set the playback mode and tuning for the overall program.

Tip: The Samples and Pan Vel tabs have some parameters similar to those in this section (Level, Pan, Semi, Fine, etc.). Remember that there are parameters that control the settings for the entire program, while other parameters control the settings for the current keygroup, and other parameters control the settings for each sample layer (up to 4).

Poly (Polyphony) is the playback mode of the program’s keygroups.

To set the playback mode of all keygroups in the program, use this field or turn Q-Link Knob 13 (MPC Renaissance) or the first Q-Link knob in the first row (MPC Studio) to select an option:

- **Mono**: Only one keygroup will sound at a time. If a keygroup is played while another (or the same one) is still playing its sample/samples, the new keygroup will immediately mute all other currently playing keygroups in that program.
- **Poly**: Several keygroups can be triggered at the same time (limited only by the total number of voices available).

Semi is the coarse tuning of the program: -36 to +36 semitones. 0 corresponds to no coarse-tuning adjustment.

To set the coarse tuning of the program, use this field or turn Q-Link Knob 14 (MPC Renaissance) or the second Q-Link knob in the first row (MPC Studio).

Fine is the fine tuning of the program: -99 to +99 cents. 0 corresponds to no fine-tuning adjustment.

To set the fine tuning of the program, use this field or turn Q-Link Knob 15 (MPC Renaissance) or the third Q-Link knob in the third column (MPC Studio).

Trans shifts the pitch of the MIDI notes sent to the program: -36 to +36 semitones. 0 corresponds to no transposition.

To set the transposition of the program, use this field or turn Q-Link Knob 16 (MPC Renaissance) or the fourth Q-Link knob in the first row (MPC Studio).

Kg Select (Keygroup Select) is the keygroup you are currently editing. This parameter works in conjunction with the Num Keygroups setting in (the Set Number of Keygroups window), which lets you create up to 128 keygroups within one keygroup program. A default keygroup program contains only one single keygroup. When set to All, you are editing all keygroups in the program simultaneously.

To select a keygroup to edit, press F1/Master and use the Kg Select field or turn Q-Link Knob 9 (MPC Renaissance) or the first Q-Link knob in the second row (MPC Studio). You can select All to edit all keygroups simultaneously. The current settings will appear on the screen immediately.

To set the number of keygroups in the program, select any parameter in Program Edit Mode except for the bottom-most eight parameters on the Flt Env tab, and then press Window. In the Set Number of Keygroups screen that appears, set the Num Keygroups field to the desired number of keygroups (1–128).

Key Trk (Key Track) allows you to switch automatic transposition on or off. When set to On, the sample/samples in the current keygroup will play using their assigned transposition. When set to Off, the sample/samples will always play at the original pitch, no matter which note is triggered by pads or a connected MIDI keyboard.

To enable or disable Key Track, set this field to On or Off (respectively) or turn Q-Link Knob 10 (MPC Renaissance) or the second Q-Link knob in the second row (MPC Studio).
Level is the overall volume level of the loaded sample/samples of the current keygroup.

To set the volume level of the keygroup, use this field or turn Q-Link Knob 11 (MPC Renaissance) or the third Q-Link knob in the second row (MPC Studio).

Pan is the overall panning position of the loaded sample/samples of the current keygroup in the stereo field: 50L (left) to 50R (right). C indicates the center position.

To set the panning position of the keygroup, use this field or turn Q-Link Knob 12 (MPC Renaissance) or the fourth Q-Link knob in the second row (MPC Studio). If you use the numeric keypad to change this number, use values from -50 to +50: -50 corresponds to 50L, 0 corresponds to C, and +50 corresponds to 50R.

Low Note and High Note determine the note range of the current keygroup. This lets you restrict the key range used for a sample’s playback. Only notes with a key number higher or equal (Low Key) or lower and equal (High Key) to the selected value will trigger a sound.

Tip: Set Low Note to A0 and High Note to C8 to emulate the range of a standard 88-key piano.

To set the note range of the keygroup, use these fields or turn Q-Link Knobs 5 and 6 (MPC Renaissance) or the first and second Q-Link knobs in the third row (MPC Studio).

Kg Semi is the coarse tuning of the keygroup: -36 to +36 semitones. 0 corresponds to no coarse-tuning adjustment.

To set the coarse tuning of the keygroup, use this field or turn Q-Link Knob 7 (MPC Renaissance) or the third Q-Link knob in the third row (MPC Studio)

Kg Fine is the fine tuning of the program: -99 to +99 cents. 0 corresponds to no fine-tuning adjustment.

To set the fine tuning of the keygroup, use this field or turn Q-Link Knob 8 (MPC Renaissance) or the fourth Q-Link knob in the third row (MPC Studio).

Kg Ply (keygroup polyphony) field to determine how the keygroup will play.

To set the playback mode of the keygroup, use this field or turn Q-Link Knob 1 (MPC Renaissance) or the first Q-Link knob in the fourth row (MPC Studio) to select an option:

- Mono: Only one pad will sound at a time. If a pad is played while another (or the same one) is still playing its sample/samples, the new pad will immediately mute all other currently playing pads in that program.
- Poly: Several pads can be triggered at the same time, limited only by the total number of voices available. You can also select a specific number of pads (2–32) so that you can play up to this many pads at the same time (unless they exceed the total number of voices available).

Mute Group determines if the keygroup is assigned to a mute group: 1–32 or Off (no mute group). When keygroups assigned to the same mute group receive MIDI notes, the last keygroup played will silence all other keygroups in that mute group. A mute group affects keygroup within that program only; mute groups do not affect keygroups in other programs.

To set the mute group, use this field or turn Q-Link Knob 2 (MPC Renaissance) or the second Q-Link knob in the fourth row (MPC Studio).

Layer determines how multiple samples assigned to the keygroup are played:

To set the layer playback option, use this field or turn Q-Link Knob 3 (MPC Renaissance) or the third Q-Link knob in the fourth row (MPC Studio) to select an option:

- Cycle (Cyc): Each time the keygroup is played, it will play the next layer’s sample. In other words, the samples will cycle through the layers as follows: 1, 2, 3, 4, 1, 2, 3, 4… etc.
- Velocity (Vel): The keygroup will switch between layers depending on how hard you press a pad.
- Random (Ran): Each time the keygroup is played, it will play one of its layer’s samples at random.

Sample determines how much of the samples assigned to the keygroup are played.

To set the playback amount of the samples, use this field or turn Q-Link Knob 4 (MPC Renaissance) or the fourth Q-Link knob in the fourth row (MPC Studio) to select an option:

- One Shot (OneSh): The samples will play from start to end when a pad in the keygroup is pressed. Use this when you want to play short sounds.
- Note On (NoteOn): The samples will play only as long as a pad in the keygroup is held down. This is better for longer samples so you can control a sound’s duration by pressing and holding its corresponding pad.
Samples

Each keygroup can trigger up to four samples, which are assigned in four individual layers. Each layer has identical, independently assignable parameters.

Press F2/Samples to cycle through its three available tabs.

**Important:** The parameters in the Samples tabs work in conjunction with Chop Mode (in Sample Edit Mode). Here’s how it works:

When working in Sample Edit Mode and using Chop Mode to divide a sample into slices for your pads, you can convert a slice using Non-Destructive Slice or Pad Parameters.

A Non-Destructive Slice will let its keygroup to refer to that slice when you press a pad in that keygroup; the original sample remains intact and each slice marker is like a “bookmark” for a keygroup. In Program Edit Mode, you’ll see that the layer to which it’s assigned has its Slice setting set to the corresponding slice number in the original sample. Playing that keygroup will cause it to refer to that slice marker like a “bookmark” instead of creating an entirely new sample of that slice. This means that you no longer have to clutter your project with a new sample for every slice (though you can still use this earlier method, if you prefer).

A slice converted using Pad Parameters is very similar to a non-destructive slice described above. The difference is that in Program Edit Mode, the pads/layers they’re assigned to have their Slice setting set to Pad (instead of the slice number), and the start and end points will correspond to the slice markers in the original sample.

The first Samples tab contains controls for its pitch, timing, and playback of the current layer.

Loop Lock determines if the loop point of a sample layer is “linked to” or “unlinked from” the start point. When set to On, the loop point is the same as the start point. When set to Off, the loop point is independent from the start point and indicated by a separate loop marker. This is the same as the Loop Lock button in Sample Edit Mode.

To turn Loop Lock on or off, set this field to On or Off (respectively).

Layer is the layer you are editing within the current keygroup: 1–4.

To select a layer, use this field.

Smpl (Sample) is the name of the sample assigned to the current layer of the keygroup. Remember that the sample has to be loaded into the project’s sample pool beforehand. To learn how to load samples into a project, please see Browser.

To assign a sample, use this field.
Start and End define where the sample will start and stop playing when a pad in the keygroup is triggered.

To change the start point or end point, do either of the following:

- Use the Start or End field (respectively).
- Use the first or second column of Q-Link knobs (respectively). The top-most Q-Link knobs (13 and 14) provide coarse adjustment. The bottom-most Q-Link knobs (1 and 2) provide fine adjustment.

**Note:** When Loop Lock is set to ON, the loop position (as determined by the Loop field, if enabled) is the same as the sample’s start point. When set to OFF, the loop position is independent from the start point.

**Tip:** A recorded sample may have some silence at the beginning or end, which makes it difficult to time it correctly in a musical context. Fix this by adjusting the start point. You can also adjust end point to remove any extra silence or unwanted audio at the end. In addition to making your workflow easier, having a “tight,” well-edited sample can enhance your production or performance.

Loop is where the sample will loop when a pad in the keygroup is triggered. When the Loop feature is on, the region of the sample between the loop point and end point will repeat. This is useful when trying to find an ideal spot to begin the sample. The loop cannot be earlier than the start point.

To change the loop point, use this field, or use the third column of Q-Link knobs. The top-most Q-Link knob (15) provides coarse adjustment. The bottom-most Q-Link knobs (3) provides fine adjustment.

Slice is which slice of the sample is assigned to the keygroup. You must have already created slices in Chop Mode (in Sample Edit Mode) to use this. 0 corresponds to All.

To select a slice to edit (after you have created slices in Chop Mode in Sample Edit Mode), use this field or turn Q-Link Knob 16 (MPC Renaissance) or the fourth Q-Link knob in the fourth column (MPC Studio) to select an option:

- **All:** The entire sample will play.
- **Pad:** The sample will play from the Start position to the End position, described earlier. This also lets you activate Loop (if the Sample field in the Lfo Mod tab is set to NoteOn).
- **Slice 1, 2, 3, etc.:** If you have sliced the sample in Chop Mode (in Sample Edit Mode), you can select which slice will play when you trigger a pad in the keygroup.

Tune is the coarse and fine tuning of the sample when played by a pad in the keygroup. The first number is coarse tuning (-36 to +36 semitones) and the second number is fine tuning (-99 to +99 cents). 0 corresponds to no tuning adjustment.

**Note:** These settings will affect the length of the sample (if Warp is set to Off). Also, these are the same as Semi and Fine on the second Samples tab.

To adjust the tuning, use these fields.

Dir (Direction) determines which direction the sample will play.

To set the playback direction, use this field to select an option:

- **Forward (Fwd):** The sample will play in the normal forward direction.
- **Reverse (Rev):** The sample will play in reverse.
Loop determines how the sample will be looped. When the Loop feature is on, the region of the sample between the loop point (determined by the Loop field in the second row) and end point will repeat. This is useful when trying to find an ideal spot to begin the sample. The loop cannot be earlier than the start point.

Important: For Loop to work, you must (1) set the Sample field (in the Lfo Mod tab) to NoteOn instead of OneSht and (2) set the Slice field (in the first Samples tab) to Pad instead of All or a slice number.

To set how the sample loops, use this field to select an option:

- Off: The sample will not loop.
- Forward (Fwd): You can hold down a pad in the keygroup to cause that sample to repeat from the loop point to the end of the sample. Release the pad to stop the repeating playback.
- Alternating (Alt): You can hold down a pad in the keygroup to cause that sample to play from the loop point to the end of the sample and then play in reverse until it reaches the loop point again. This will repeat as long as you are holding the pad down. Release the pad to stop the repeating playback.
- Reverse (Rev): You can hold down a pad in the keygroup to cause that sample to play in reverse, repeating from the end of the sample to the loop point. Release the pad to stop the repeating playback.

Warp determines whether or not stretching the time of the sample will change its pitch and vice versa. When set to On, lengthening or shortening the sample (based on the BPM) will not change its pitch.

When set to Off, lengthening or shortening the sample will also change its pitch and vice versa. Use the Stretch, BPM, and BPM Sync settings (described below) in conjunction with this feature. See the note below to learn how to minimize CPU requirements while using Warp.

To set whether or not the sample is warped, set this field to On or Off (respectively).

Stretch is the “stretch factor,” which affects how the sample is warped (if Warp is set to On). See the note below to learn how to minimize CPU requirements while using Warp.

To set the stretch factor, use this field.

BPM is the tempo used when a sample is warped (if Warp is set to On). See the note below to learn how to minimize CPU requirements while using Warp.

To set the tempo of the sample, use this field.

BPM Sync determines whether the tempo of the sample is linked to or independent of the tempo of the sequence. When BPM Sync and Warp are both set to On, the sample’s tempo will be “locked” to the tempo of the sequence.

When BPM Sync is set to Off but Warp is set to On, the sample will be independent of the tempo of your sequence—use the Stretch field to lengthen or shorten a sample. See the note below to learn how to minimize CPU requirements while using Warp.

To enable or disable BPM Sync, set this field to On or Off (respectively).

Note: The Warp algorithms are very CPU-intensive and can result in audio drop-outs during playback if used too freely. Be mindful of how (and how often) you use the warp function. You can reduce the CPU resources required by doing any/all of the following:

- Avoid using extreme Stretch values.
- Minimize the amount of pitch adjustment (e.g., the Tune parameter) of warped audio.
- Avoid warping very small track regions.
- Warp as few tracks or track regions as possible (i.e., reduce the number of total number of voices of the polyphonic limit that use the Warp algorithm at a given time), especially instances where the warped regions start at the same time.
- Avoid rapidly triggering samples that are warped.

If you have warped samples used in a drum program, consider using the Flatten Pad function to consolidate the affected pad’s layers into one audio sample. After you flatten the pad, its sample/samples no longer need to be warped. To see the user guide in the MPC software and learn how to do this, click the Help menu, select MPC Help, and select MPC User Manual.
The second Samples tab contains controls for the pitch and volume level of each layer.

<table>
<thead>
<tr>
<th>Program: Bass</th>
<th>Loop Lock: ON</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1: Bass 01: Semi: 0 Fine: -1 Level: 127</td>
<td></td>
</tr>
<tr>
<td>S2: Bass 02: Semi: 0 Fine: 0 Level: 107</td>
<td></td>
</tr>
<tr>
<td>S3: REVO. ON 01: Semi: 2 Fine: 0 Level: 84</td>
<td></td>
</tr>
<tr>
<td>S4: Semi: 0 Fine: 0 Level: 127</td>
<td></td>
</tr>
</tbody>
</table>

**Loop Lock** determines if the loop point of a sample layer is “linked to” or “unlinked from” the start point. When set to **On**, the loop point is the same as the start point. When set to **Off**, the loop point is independent from the start point and indicated by a separate loop marker. This is the same as the Loop Lock button in Sample Edit Mode.

To turn Loop Lock on or off, set this field to **On** or **Off** (respectively).

**S1–4** (Sample 1–4) is the name of the sample assigned to the current layer (1–4) of the keygroup. Remember that the sample has to be loaded into the project’s sample pool beforehand. To learn how to load samples into a project, please see **Browser**.

To assign a sample, use this field or turn the corresponding **Q-Link knob** (1, 5, 9, or 13 on MPC Renaissance or the **Q-Link knobs** in the first column on MPC Studio).

**Semi** is the coarse tuning of the sample on each layer: -36 to +36 semitones. 0 corresponds to no coarse-tuning adjustment. This will affect the length of the sample (if **Warp** is set to **Off**).

To set the coarse tuning of the sample on each layer, use this field or turn the corresponding **Q-Link knob** (2, 6, 10, or 14 on MPC Renaissance or the **Q-Link knobs** in the second column on MPC Studio).

**Fine** is the fine tuning of the sample on each layer: -99 to +99 cents. 0 corresponds to no fine-tuning adjustment. This will affect the length of the sample (if **Warp** is set to **Off**).

To set the fine tuning of the sample on each layer, use this field or turn the corresponding **Q-Link knob** (3, 7, 11, or 15 on MPC Renaissance or the **Q-Link knobs** in the third column on MPC Studio).

**Level** is the volume of the sample on each layer, enabling you to control the “balance” of the samples assigned to the pad.

To set the volume level of the sample on each layer, use this field or turn the corresponding **Q-Link knob** (4, 8, 12, or 16 on MPC Renaissance or the **Q-Link knobs** in the fourth column on MPC Studio).
The **third Samples** tab contains a control for the offset of the sample on each layer.

<table>
<thead>
<tr>
<th></th>
<th>Program</th>
<th>Bass</th>
<th>Offset</th>
<th>Loop Lock</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>Bass 01</td>
<td>Offset:</td>
<td>0:</td>
<td>ON</td>
</tr>
<tr>
<td>S2</td>
<td>Bass 02</td>
<td>Offset:</td>
<td>-1:</td>
<td></td>
</tr>
<tr>
<td>S3</td>
<td>REVO. ON C1</td>
<td>Offset:</td>
<td>10:</td>
<td></td>
</tr>
<tr>
<td>S4</td>
<td>Offset:</td>
<td>0:</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Loop Lock** determines if the loop point of a sample layer is “linked to” or “unlinked from” the start point.

When set to **On**, the loop point is the same as the start point.

When set to **Off**, the loop point is independent from the start point and indicated by a separate loop marker. This is the same as the **Loop Lock** button in Sample Edit Mode.

**To turn Loop Lock on or off**, set this field to **On** or **Off** (respectively).

**S1–4** (Sample 1–4) is the name of the sample assigned to the current layer (1–4) of the keygroup. Remember that the sample has to be loaded into the project’s sample pool beforehand. To learn how to load samples into a project, please see **Browser**.

**To assign a sample**, use this field or turn the corresponding **Q-Link knob** (1, 5, 9, or 13 on MPC Renaissance or the **Q-Link knobs** in the **first column** on MPC Studio).

**Offset** is the time offset of the sample's playback on each layer. When this setting is a positive value, playing a pad in the keygroup will immediately trigger the sample on that layer but at a later point in the sample (specified by this setting). When this setting is a negative value, the sample playback on that layer will be delayed by the amount specified by this setting.

**To set the offset of the sample on each layer**, use this field or turn the corresponding **Q-Link knob** (2, 6, 10, or 14 on MPC Renaissance or the **Q-Link knobs** in the **second column** on MPC Studio).
Panning & Velocity

The **Pan Vel** tab contains settings that determine the stereo placement and velocity ranges of each layer of the keygroup.

<table>
<thead>
<tr>
<th>Program</th>
<th>Bass</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1 Pan</td>
<td>28L:Low:</td>
</tr>
<tr>
<td>S2 Pan</td>
<td>3L:Low:</td>
</tr>
<tr>
<td>S3 Pan</td>
<td>3L:Low:</td>
</tr>
<tr>
<td>S4 Pan</td>
<td>0:Low:</td>
</tr>
</tbody>
</table>

**Pan** is the panning position of the sample on each layer in the stereo field: 50L (left) to 50R (right). C indicates the center position.

To set the panning position of the sample on each layer, use this field or turn the corresponding **Q-Link knob** (1, 5, 9, or 13 on MPC Renaissance or the **Q-Link knobs** in the first column on MPC Studio). If you use the **numeric keypad** to change this number, use values from 0 to 100: -50 corresponds to 50L, 0 corresponds to C, and +50 corresponds to 50R.

**Low** and **High** determine the lowest and highest velocities (respectively) that will trigger the sample on each layer. A range from 0 to 127 lets the layer respond to the entire velocity range which is input from a pad in the keygroup, while, for example, a range from 100 to 127 lets the layer respond only to higher velocity levels. By assigning several samples of one instrument, you can create a realistic-sounding “multi-sample” by adjusting the velocity ranges of each layer accordingly.

For example, you may have three samples of a piano key pressed with low force, medium force, and high force. You can set each sample to a layer and set the velocity ranges so only low velocities trigger the low-force sample, only mid-range velocities trigger the medium-force sample, and only high velocities trigger the high-force sample.

To set the velocity range of the sample on each layer, use these fields or turn the corresponding **Q-Link knob**: for low velocities, turn **Q-Link Knob** 2, 6, 10, or 14 (MPC Renaissance) or the **second column** of **Q-Link knobs** (MPC Studio); for high velocities **Q-Link Knob** 3, 7, 11, or 15 (MPC Renaissance) or the **third column** of **Q-Link knobs** (MPC Studio).

**Root** is the root note of the sample. This determines which note will play the sample at its original pitch when in a keygroup program. **Sample** denotes to the sample’s default pitch.

To set the root note of the sample, use this field or turn the corresponding **Q-Link knob** (4, 8, 12, or 16 on MPC Renaissance or the **Q-Link knobs** in the fourth column on MPC Studio). If you use the **numeric keypad** to change this number, use values from 0 to 100: -50 corresponds to 50L, 0 corresponds to C, and +50 corresponds to 50R.
Filter Envelope

The Flt Env tab contains settings for the filter and amp envelopes that affect the keygroup.

<table>
<thead>
<tr>
<th>Filter Type</th>
<th>Cutoff Frequency</th>
<th>Resonance</th>
<th>Env Amount</th>
<th>Keyboard to Flt</th>
<th>Velocity to Filter</th>
<th>Velocity to Envelope</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Type determines the filter that is applied to the selected keygroup. See Appendix > Glossary > Filter for an explanation of the available filter types.

To set the filter type, use this field or turn Q-Link Knob 13 (MPC Renaissance) or the first Q-Link knob in the first row (MPC Studio).

Cutoff is the cutoff frequency for low-pass and high-pass filter types or the center frequency for band-pass and band-stop filter types. See Appendix > Glossary > Filter for an explanation of the available filter types.

To set the filter cutoff frequency, use this field or turn Q-Link Knob 14 (MPC Renaissance) or the second Q-Link knob in the first row (MPC Studio).

Reso (Resonance) is the emphasis of the frequencies around the cutoff point.

Tip: Use values lower than 80 to give more brilliance to the sound. At values higher than 80, the sound will result in a strong audible boost around the cutoff frequency.

To set the filter resonance, use this field or turn Q-Link Knob 15 (MPC Renaissance) or the third Q-Link knob in the first row (MPC Studio).

Env (Envelope) determines the amount of influence the filter envelope has on the cutoff frequency. Higher settings will increase the modulation of the filter by the envelope; lower settings will result in only subtle changes of the filter Cutoff over time.

Tip: To give a sound a more distinctive attack, increase the Env setting and set low Atk and Dec values as well as a medium-low Sust value of the filter envelope (Flt). This will start a sound with the filter opened and close it shortly afterward, giving it a bright start followed by a darker sustain. String sounds, on the other hand, can sound much more “alive” with low Env settings and a high Atk value, resulting in a slight fade-in of the higher frequencies.

To set the filter envelope amount, use this field or turn Q-Link Knob 16 (MPC Renaissance) or the fourth Q-Link knob in the first row (MPC Studio).

Kbd>Flt (Keyboard►Filter) sets how much the note value will be added to the filter cutoff. This allows higher notes to sound brighter.

To set the “keyboard to filter,” use this field or turn Q-Link Knob 9 (MPC Renaissance) or the first Q-Link knob in the second row (MPC Studio).

V>Attack (Velocity►Attack) determines how much velocity is needed (for a triggered pad in the keygroup) to modulate the Attack (Atk) phase for the Amp envelope.

To set the “velocity to filter attack,” use this field or turn Q-Link Knob 10 (MPC Renaissance) or the second Q-Link knob in the second row (MPC Studio).

V>Env (Velocity►Envelope) determines to what degree velocity information affects the amount of the filter envelope’s effect on the cutoff frequency.

To set the “velocity to envelope amount,” use this field or turn Q-Link Knob 11 (MPC Renaissance) or the third Q-Link knob in the second row (MPC Studio).
V>Filter (Velocity◆Filter) determines to what degree the velocity of a pad modulates the cutoff frequency directly.

To set the “velocity to filter cutoff,” use this field or turn Q-Link Knob 12 (MPC Renaissance) or the fourth Q-Link knob in the second row (MPC Studio).

The third row of parameters determine how the filter envelope affects the filter frequency over a period of time. There are three possible sets of parameters, depending on the type of envelope:

- AD (attack-decay) envelope: Flt Atk (filter attack), Flt Dec (filter decay), and Dec Type (decay type)
- AHDS (attack-hold-decay-sustain) envelope: Flt Atk (filter attack), Flt Hold (filter hold), Flt Dec (filter decay), and Flt Sust (filter sustain)
- ADSR (attack-decay-sustain-release) envelope: Flt Atk (filter attack), Flt Dec (filter decay), Flt Sust (filter sustain), and Flt Rel (filter release)

See the later Anatomy of an Envelope section to learn about these envelope parameters.

To adjust the filter envelope parameters, use these fields or turn the corresponding Q-Link knob (5–8 on MPC Renaissance or the Q-Link knobs in the third row on MPC Studio).

To adjust the overall influence of the envelope on the filter frequency, use the Env field or turn Q-Link Knob 16 (MPC Renaissance) or the first Q-Link knob in the fourth column (MPC Studio).

To set the envelope type, press F1/Master and set Sample to One Shot (O.ht), if you want to select an AD or AHDS envelope, or Note On (N.On), if you want to use ADSR envelopes only. To select an AD or AHDS envelope, press F4/Flt Env, select one of the eight bottom-most parameters, and then press Window. Use the Filter Envelope AD Mode field in the screen that appears to select an AD envelope (On) or AHDS (Off), and then press F4/Close.

The fourth row of parameters determine how the amp envelope affects the volume level over a period of time. There are three possible sets of parameters, depending on the type of envelope:

- AD (attack-decay) envelope: Amp Atk (amp attack), Amp Dec (amp decay), and Dec Type (decay type)
- AHDS (attack-hold-decay-sustain) envelope: Amp Atk (amp attack), Amp Hold (amp hold), Amp Dec (amp decay), and Amp Sust (amp sustain)
- ADSR (attack-decay-sustain-release) envelope: Amp Atk (amp attack), Amp Dec (amp decay), Amp Sust (amp sustain), and Amp Rel (amp release)

See the later Anatomy of an Envelope section to learn about these envelope parameters.

To adjust the amp envelope parameters, use these fields or turn the corresponding Q-Link knob (9–12 on MPC Renaissance or the Q-Link knobs in the fourth row on MPC Studio).

To set the envelope type, press F1/Master and set Sample to One Shot (O.ht), if you want to select an AD or AHDS envelope, or Note On (N.On), if you want to use ADSR envelopes only. To select an AD or AHDS envelope, press F4/Flt Env, select one of the eight bottom-most parameters, and then press Window. Use the Volume Envelope AD Mode field in the screen that appears to select an AD envelope (On) or AHDS (Off), and then press F4/Close.
LFO Modulation

The LFO Mod tab contains settings that determine sample playback and low-frequency oscillator of the pad.

<table>
<thead>
<tr>
<th>Program</th>
<th>Bass</th>
</tr>
</thead>
<tbody>
<tr>
<td>U&gt;Pitch:</td>
<td>4</td>
</tr>
<tr>
<td>Wave:</td>
<td>Sine</td>
</tr>
<tr>
<td>L&gt;Pitch:</td>
<td>0</td>
</tr>
<tr>
<td>Pitch:</td>
<td>0</td>
</tr>
</tbody>
</table>

V>Pitch (Velocity➔Pitch), V>Atk (Velocity➔Attack), V>Amp (Velocity➔Amp), and V>Pan (Velocity➔Panning) determine how much the velocity affects the pitch of the sound (Pitch), the attack of the filter envelope (Atk), the volume level of the filter envelope (Amp) and or the panning of the sound (Pan). When you press a pad in the keygroup softly, only minimal modulation is applied. When you press it harder, the modulation amount also gets stronger depending on the setting of the corresponding knob.

To adjust the velocity sensitivity of the pad, use these fields or turn the corresponding Q-Link knob (13–16 on MPC Renaissance or the first row of Q-Link knobs on MPC Studio).

A low-frequency oscillator (LFO) generates a periodic waveform with an adjustable frequency and shape which can be used for modulation purposes. The seven settings in the lower half of the screen affect the LFO applied to the keygroup.

Wave is the type of waveform the LFO uses.

To select the waveform of the LFO, use this field or turn Q-Link Knob 9 (MPC Renaissance) or the first Q-Link knob in the second row (MPC Studio) to select an option:
- Sine (best suited for smooth modulations)
- Triangle (best suited for smooth modulations)
- S&H (samples a random value and holds it until the next value is generated)
- Saw (can generate interesting filter or volume changes)
- Saw Down (can generate interesting filter or volume changes)
- Square (interesting results with hard-panning modulations)
- Noise (generates random values and glides)

Rate is the LFO frequency when Sync is on. At lower values, it might take some time for the LFO to complete a cycle, while higher values will come closer to audible range.

To set the frequency of the LFO, use this field or turn Q-Link Knob 10 (MPC Renaissance) or the second Q-Link knob in the second row (MPC Studio).

Sync determines if or how the LFO’s rate is synchronized with the tempo. You can select one of several time divisions (a . indicates a dotted note; a T indicates a triplet-based time division). When None is selected, Sync is off.

To set the synchronization of the LFO, use this field or turn Q-Link Knob 11 (MPC Renaissance) or the third Q-Link knob in the second row (MPC Studio).

L>Pitch (LFO➔Pitch), L>Filter (LFO➔Filter), L>Amp (LFO➔Amp), and LFO>Pan (LFO➔Panning) determine how much the LFO affects the pitch of the sound (Pitch), the cutoff frequency of the filter (Filter), the volume level of the sound (Amp), and the panning of the sound (Pan). When you press a pad in the keygroup softly, only minimal modulation is applied. When you press it harder, the modulation amount also gets stronger depending on the setting of the corresponding knob.

To adjust the LFO destinations of the pad, use these fields or turn the corresponding Q-Link knob (5–8 on MPC Renaissance or the Q-Link knobs in the third row on MPC Studio).
Pitch determines the range (in semitones) of the pitch-bend wheel on a connected MIDI keyboard. (To use this feature, you must have a MIDI device that sends pitch-bend messages connected to your computer.)

To set the range of the pitch-bend wheel, use this field or turn Q-Link Knob 2 (MPC Renaissance) or the second Q-Link knob in the fourth row (MPC Studio).

WHL>LFO determines how much the modulation wheel on a connected MIDI keyboard affects the intensity of the LFO. (To use this feature, you must have a MIDI device that sends modulation messages connected to your computer.)

To set how much the modulation wheel affects the LFO, use this field or turn Q-Link Knob 3 (MPC Renaissance) or the third Q-Link knob in the fourth row (MPC Studio).

AFT>FILT (Aftertouch►Filter Cutoff) determines how much the filter cutoff frequency is affected by aftertouch messages from a connected MIDI keyboard. (To use this feature, you must have a MIDI device that sends aftertouch messages connected to your computer.)

To set how much the filter cutoff frequency affects the filter cutoff, use this field or turn Q-Link Knob 4 (MPC Renaissance) or the fourth Q-Link knob in the fourth row (MPC Studio).
Effects

Effects shows the insert effects and send effect levels for the keygroup. You can select up to four insert effects for each keygroup. Additionally, each keygroup can be sent to up four return channels, each of which can have up to four insert effects of their own. Their audio will be routed through the insert effects on those returns, and the processed audio will be sent to a master output.

Please see General Features > Effects to learn more about using insert and send effects.

Important: When using keygroup insert effects, they will be applied to that keygroup only. Keep this in mind if you load insert effects to multiple keygroups with overlapping note ranges—the effects will overlap in that range as well.

### Inserts

- **Inserts** determines whether insert effects are activated (ON) or deactivated (OFF) for the keygroup.
  - **To activate or deactivate all four insert effects**, set this field to ON or OFF (respectively).

#### Insert 1–4

- **Insert 1–4** are the four available slots for insert effects on that keygroup.
  - **To load an effect**, select an Insert field, and then use the data dial or +/- buttons. In the Select Effect screen that appears, select an effect. Press F4/Select to load the selected effect or F3/Back to return to the previous screen.
  - **To change the settings of a loaded effect**, select an Insert field with an effect, and press Window. In the screen that appears, you can select and change each parameter (you can use the numeric keypad on some of them). Press F4/Closed to return to the previous screen.
  - **To activate or deactivate an effect**, select its Insert field, and press Window. In the screen that appears, press F6/On/Off to activate or deactivate the effect. Press F4/Closed to return to the previous screen.
  - **To activate or deactivate all four insert effects**, set the Inserts field to ON or OFF (respectively).

#### Send 1–4

- **Send 1–4** are the audio signal levels that the keygroup sends to the four return channels, each of which can have up to four insert effects—these are send effects. The send effects will then send the audio to the assigned master output at the designated return levels. You can select up to four send effects for each keygroup, but remember that they will be applied to that keygroup only.
  - **To adjust the send levels**, turn their corresponding Q-Link knobs (4, 8, 12, or 16 on MPC Renaissance or the Q-Link knobs in the fourth column on MPC Studio).

Important: To edit the send effects, use the Channel Mixer. See Channel Mixer > Returns to learn more how to do this.
Clip Programs

When using clip programs, Program Edit Mode lets you assign a sample (a loop called a clip) to each pad in a single bank. You can also edit various settings to determine how each pad launches its assigned clip.

To select a pad, press it. Its parameters will appear on the screen immediately.

To view a specific tab of parameters, press F1/Program or F2/Pad. The Program tab is where you assign clips to pads (see Program in this section). The Pad tab is where you determine how each pad plays its clip (see Pad in this section).

Below is a brief step-by-step process so you can get familiar with setting up a clip. Continue reading the rest of this chapter to learn how to use the parameters in this window.

To assign a clip:

1. Press F2/Pad, and set the Sample field at the top of the screen to the desired clip. For example, start with a four-bar drum loop.
2. Note that the Tempo field has a value, which is automatically detected.
   - Set Warp to On if it is not already. The Warp function keeps the loop in time with the sequence tempo or the master tempo.
3. If you need to edit the loop’s tempo manually, use the Tempo field.
4. Set Fade to On if it is not already. This applies a very small fade-in and fade-out at the start and end of the clip to prevent “clicks” and glitches that can occur if the start or end points are not at “zero-crossings.”
5. If you need to edit the loop’s pitch manually, use the Semi and/or Fine fields, or turn Q-Link Knobs 1 and/or 2 (MPC Renaissance) or the first and second Q-Link knobs in the fourth row (MPC Studio), respectively. These adjust the pitch by semitones and cents. You will hear the tuning adjustments in real time.
These are the buttons under the screen for clip programs:

**F1  Program**  Press this button to view the Program tab, described here.

**F2  Pad**  Press this button to view the Pad tab, described here.

You can edit one pad, multiple pads, or all pads of a clip program simultaneously while in Program Edit Mode.

To select how many pads and which pad/pads you are editing, select any parameter in Program Edit Mode, and then press Window. In the Edit Zones screen that appears, set the Edit Mode field:

- **Current**: Only the currently selected pad can be edited.
- **Multiple**: All selected pads can be edited simultaneously.
- **All**: All pads can be edited simultaneously.

**Tip**: You can immediately select or deselect multiple pads while on any tab in Program Edit Mode (regardless of the current Edit Mode setting). To do this, press Shift and each desired pad. Edit Mode will automatically change to the corresponding setting.

**Program**

The Program tab enables you set the program’s overall tuning and quantization.

**Semi** is the coarse tuning of the program: -36 to +36 semitones. 0 corresponds to no coarse-tuning adjustment.

To set the coarse tuning of the program, use this field or turn Q-Link Knob 9 (MPC Renaissance) or the second Q-Link knob in the first column (MPC Studio).

**Fine** is the fine tuning of the program: -99 to +99 cents. 0 corresponds to no fine-tuning adjustment.

To set the fine tuning of the program, use this field or turn Q-Link Knob 5 (MPC Renaissance) or the third Q-Link knob in the first column (MPC Studio).

**Launch** is the quantization of the program in bars or subdivisions of a bar. When you launch any clips in the program, it will use this quantization. None denotes no quantization; when you launch a clip, it will start playing immediately.

To set the quantization of the program, use this field or turn Q-Link Knob 1 (MPC Renaissance) or the fourth Q-Link knob in the first column (MPC Studio).
The Pad tab contains settings to assign a clip to each pad and set its timing, tuning, and playback behavior.

Sample is the name of the sample assigned to the pad. Remember that the sample has to be loaded into the project’s sample pool beforehand. To learn how to load samples into a project, please see Browser. Select None to clear the pad’s assignment.

To assign a sample to the current pad, use this field.

Warp determines whether or not stretching the time of the sample will change its pitch and vice versa. When set to On, lengthening or shortening the sample (based on the BPM) will not change its pitch. When set to Off, lengthening or shortening the sample will also change its pitch and vice versa. Use the BPM setting (described below) in conjunction with this feature. See the note below to learn how to minimize CPU requirements while using Warp.

To set whether or not the sample is warped, set this field to On or Off (respectively).

Note: The Warp algorithms are very CPU-intensive and can result in audio drop-outs during playback if used too freely. Be mindful of how (and how often) you use the warp function. You can reduce the CPU resources required by doing any/all of the following:

- Avoid using extreme Stretch values.
- Minimize the amount of pitch adjustment (e.g., the Tune parameter) of warped audio.
- Avoid warping very small track regions.
- Warp as few tracks or track regions as possible (i.e., reduce the number of total number of voices of the polyphonic limit that use the Warp algorithm at a given time), especially instances where the warped regions start at the same time.
- Avoid rapidly triggering samples that are warped.

If you have warped samples used in a drum program, consider using the Flatten Pad function to consolidate the affected pad’s layers into one audio sample. After you flatten the pad, its sample/samples no longer need to be warped. To see the user guide in the MPC software and learn how to do this, click the Help menu, select MPC Help, and select MPC User Manual.

Tempo is the tempo used when a sample is warped (if Warp is set to On). See the note above to learn how to minimize CPU requirements while using Warp.

To set the tempo of the sample, use this field.

Play determines how the clip is played.

To set how the clip is played, use this field or turn Q-Link Knob 6 (MPC Renaissance) or the second Q-Link knob in the third row (MPC Studio) to select an option:

- **One Shot**: When you press the pad, the entire clip will play from start to end and then stop.
- **Toggle**: When you press the pad, the entire clip will play from start to end and loop indefinitely. Pressing it again—or launching another in the same mute group—will stop its playback. This is the most common usage.
Launch is the quantization of the pad in bars or subdivisions of a bar. When you launch this clip, it will use this quantization instead of the program’s quantization (set in the Program tab). When set to PGM, the pad will use the program’s quantization (this is the default setting). None denotes no quantization; when you launch a clip, it will start playing immediately.

To set the quantization of the pad, use this field or turn Q-Link Knob 7 (MPC Renaissance) or the third Q-Link knob in the third row (MPC Studio).

Dir (Direction) determines which direction the sample will play.

To set the playback direction, use this field to select an option:

- Forward (Fwd): The sample will play in the normal forward direction.
- Reverse (Rev): The sample will play in reverse.

Alternatively, turn Q-Link Knob 8 (MPC Renaissance) or the fourth Q-Link knob in the third row (MPC Studio).

Semi is the coarse tuning of the pad: -36 to +36 semitones. 0 corresponds to no coarse-tuning adjustment.

To set the coarse tuning of the pad, use this field or turn Q-Link Knob 1 (MPC Renaissance) or the first Q-Link knob in the fourth row (MPC Studio).

Fine is the fine tuning of the pad: -99 to +99 cents. 0 corresponds to no fine-tuning adjustment.

To set the fine tuning of the pad, use this field or turn Q-Link Knob 2 (MPC Renaissance) or the second Q-Link knob in the fourth row (MPC Studio).

Mute Grp determines if the pad is assigned to a mute group: 1–32 or Off (no mute group). When pads assigned to the same mute group receive MIDI notes, the last pad played will silence all other pads in that mute group. A mute group affects pads within that program only; mute groups do not affect pads in other programs.

By default, each column of pads is assigned to the same mute group. This means only one pad from each column can be playing its clip at a time. You can use the Mute Group field to configure this any way you like, though.

To set the mute group, use this field or turn Q-Link Knob 3 (MPC Renaissance) or the third Q-Link knob in the fourth row (MPC Studio).

Fade determines whether or not a very small fade-in and fade-out are applied at the start and end of the clip. This feature helps prevent “clicks” and glitches that can occur if the start or end points are not placed at the waveform’s “zero-crossings.”

To set whether or not the sample uses a fade-in and fade-out, set this field to On or Off (respectively) or turn Q-Link Knob 4 (MPC Renaissance) or the fourth Q-Link knob in the fourth row (MPC Studio).

The start and end points of the clip assigned to the pad are not shown in the screen, but you can still use the MPC hardware to adjust them.

To set the clip’s start point, use Q-Link Knobs 9–12 (MPC Renaissance) or the Q-Link knobs in the first row (MPC Studio) to adjust the start point with varying degrees of resolution.

To set the clip’s end point, use Q-Link Knobs 13–16 (MPC Renaissance) or the Q-Link knobs in the second row (MPC Studio) to adjust the end point with varying degrees of resolution.
Plugin Programs

When using plugin programs, Program Edit Mode shows an overview of all available plugin parameters with an adjustable parameter for each one.

The buttons under the screen will vary depending on the plugin. Press each one to access a tab of parameters that you can adjust using the data dial, +/- buttons, or corresponding Q-Link knob. Some of the fields may not contain a parameter.

To select preset within your plugin:
1. Select the Program field at the top of the screen, and press Window.
2. In the screen that appears, select the desired preset, and press F5/Select to continue or F4/Close to return to the previous screen.
3. You can press F2/AutoSel to activate or deactivate automatic selection, which will automatically load each preset as you move through the list.

To assign a parameter to one of the fields, use the MPC software.

Note: To see the user guide in the MPC software and learn how to do this, click the Help menu, select MPC Help, and select MPC User Manual.
MIDI Programs

When using MIDI programs, Program Edit Mode shows an overview of all available MIDI CCs with an adjustable parameter for each one.

<table>
<thead>
<tr>
<th>Page</th>
<th>Page 2</th>
<th>Page 3</th>
<th>Page 4</th>
<th>Page 5</th>
<th>Page 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>1:</td>
<td>57:15:</td>
<td>21:16:</td>
<td>0:17:</td>
<td>29</td>
<td></td>
</tr>
<tr>
<td>10:</td>
<td>40:11:</td>
<td>102:12:</td>
<td>30:13:</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>6:</td>
<td>38:7:</td>
<td>8:8:</td>
<td>126:3:</td>
<td>127</td>
<td></td>
</tr>
<tr>
<td>2:</td>
<td>12:3:</td>
<td>0:4:</td>
<td>0:5:</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

The buttons under the screen correspond to six tabs. Press each one to access 16 MIDI CCs on each tab that you can adjust using the data dial, –/+ buttons, corresponding Q-Link knob, or numeric keypad.

To assign a parameter to one of the fields, use the MPC software.

Note: To see the user guide in the MPC software and learn how to do this, click the Help menu, select MPC Help, and select MPC User Manual.

CV Programs

When using CV programs, Program Edit Mode shows an overview of all eight CV outputs with an adjustable voltage parameter for each one.

<table>
<thead>
<tr>
<th>Page</th>
<th>Page 2</th>
<th>Page 3</th>
<th>Page 4</th>
<th>Page 5</th>
<th>Page 6</th>
</tr>
</thead>
<tbody>
<tr>
<td>CU</td>
<td>t 5:</td>
<td>2.40V:</td>
<td>3.25V:</td>
<td>3.85V:</td>
<td>5.00V:</td>
</tr>
<tr>
<td>CU</td>
<td>t 6:</td>
<td>0.00V:</td>
<td>0.75V:</td>
<td>1.70V:</td>
<td>1.80V:</td>
</tr>
</tbody>
</table>

The buttons under the screen correspond to six tabs. You can press each one to access a tab, but only the first tab (Page 1) contains the eight adjustable voltage parameters that you can adjust using the data dial, –/+ buttons, corresponding Q-Link knob, or numeric keypad.

To assign a parameter to one of the fields, use the MPC software.

Note: To see the user guide in the MPC software and learn how to do this, click the Help menu, select MPC Help, and select MPC User Manual.
Anatomy of an Envelope

An envelope creates a variable control signal. It can be used, for instance, to modulate the filter settings of a sound over a given period of time.

Drum programs and keygroup programs can use three types of envelopes: AD (attack-decay), AHDS (attack-hold-decay-sustain), or ADSR (attack-decay-sustain-release).

For drum programs, when Sample (in the Lfo Mod tab) is set to One Shot (OneSht), it will use ADSR envelopes only. When set to Note On (NoteOn), it can use an AD or ADHS envelope. See Program Edit Mode > Drum Programs > Filter Envelope and LFO Modulation to learn how to change the envelope.

For keygroup programs when Sample (in the Master tab) is set to One Shot (O.ht), it can use an AD or AHDS envelopes. When set to Note On (N.On), it will use ADSR envelopes only. See Program Edit Mode > Keygroup Programs > Filter Envelope and Master to learn how to change the envelope.

With AD envelopes, the following happens when you trigger a sample:
1. Within the period of time you have defined with the attack (Atk), the sample volume rises to its maximum value.
2. The sample’s maximum volume will be maintained until its decay (Dec) phase, when the sample’s volume will gradually drop to zero over the set duration. The decay can function in one of two ways:
   • Decay From Start (Strt): The volume will start decreasing immediately after reaching its maximum level.
   • Decay From End (End): The maximum volume will be maintained for a hold phase until it reaches the decay phase.

With AHDS envelopes, the following happens when you trigger a sample:
1. Within the period of time you have defined with the attack (Atk), the sample volume rises to its maximum value.
2. The sample’s maximum volume will be maintained during the Hold phase.
3. During the decay (Dec) phase, the sample’s volume will gradually drop to the Sustain (Sust) level.
4. The sample’s volume will stay at the sustain level (Sust) until the pad is released.

With ADSR envelopes, the following happens when you trigger a sample:
1. Within the period of time defined by the attack (Atk), the sample volume rises to its maximum value.
2. During the decay (Dec) phase, the sample’s volume will gradually drop to the Sustain (Sust) level.
3. The sample’s volume will stay at the Sustain (Sust) level until the Release (Rel) phase begins.
4. The sample’s volume will drop to “zero” over the duration set by Release (Rel).
Browser

The Browser lets you navigate your computer’s internal hard disk to load samples, sequences, songs, etc. Using filter buttons and user-definable folders, you can easily adapt it to your preferred workflow. You can also audition (preview) your samples before loading them.

To enter the Browser, press Browser.

These are the buttons under the screen:

- **F2 Auto** Press this button to enable or disable the audition function. When enabled, each sample file will automatically play when it is first selected.
- **F3 Play** Press this button to play the sample.
- **F4 Volume** Press and hold this button to show the Audition Volume field, which you can use to adjust how loudly samples play in the Browser.
- **F5 Set** Press this button to assign the current location to a folder button. Use the data dial or +/- buttons to select one of Folders 1–5 and press F5/Do It to confirm your choice or F4/Cancel to return to the previous screen.
- **F6 Open** When a folder is selected, press this button to enter it. Alternatively, press the right cursor.
- **F6 Load** When a file is selected, press this button to load it.
  
  If the file is a **project**, press F4/OK to confirm your choice or F3/Cancel to return to the previous screen.
  
  If the file is a **sequence**, press F5/Do It to confirm your choice or F4/Cancel to return to the previous screen.
  
  If the file is a **sample** (in a supported format), it will be loaded immediately to your project’s sample pool.
To enter a folder, press F6/Load. You can also use the folder buttons to jump immediately to those pre-assigned file paths (see below to learn how to assign these file paths):

- **Folder 1**: Shift+Project/Folder 1.
- **Folder 2**: Shift+Sequence/Folder 2.
- **Folder 3**: Shift+Program/Folder 3.
- **Folder 4**: Shift+Sample/Folder 4.
- **Folder 5**: Shift+No Filter/Folder 5.

To move up one folder level, press the left cursor.

To move through a list, turn the data dial, use the up or down cursors, or use the –/+ buttons.

To load a selected file, press F6/Load.

- If the file is a project, press F4/OK to confirm your choice or F3/Cancel to return to the previous screen.
- If the file is a sequence, press F5/Do It to confirm your choice or F4/Cancel to return to the previous screen.
- If the file is a sample (in a supported format), it will be loaded immediately to your project’s sample pool.

You can play a sound file to preview it before loading it into your project. The Audition feature lets you do this automatically as you move through lists of files.

- **To play a selected sound**, press and hold F3/Play.
- **To enable or disable the audition function**, press F2/Auto. When enabled, each sample file will automatically play when it is first selected.
- **To set the volume level of sounds that play in the Browser**, press and hold F4/Volume. Use the numeric keypad, data dial, or –/+ buttons to change the number of Audition Volume in the screen that appears.

You can play a sound file to preview it before loading it into your project. The Audition feature lets you do this automatically as you move through lists of files.

- **To play a selected sound**, press and hold F3/Play.
- **To enable or disable the audition function**, press F2/Auto. When enabled, each sample file will automatically play when it is first selected.
- **To set the volume level of sounds that play in the Browser**, press and hold F4/Volume. Use the numeric keypad, data dial, or –/+ buttons to change the number of Audition Volume in the screen that appears.

To get the most efficient use of the Browser, set the file paths to your favorite drive locations first. There are five folder buttons labeled 1–5 in the upper-right corner. You can set these to be shortcuts to five locations on your MPC hardware’s internal drive and/or any connected storage devices, giving you quick access to your files.

- **To assign the current location to a folder button**, press F5/Set. Use the data dial or –/+ buttons to select one of Folders 1–5 and press F5/Do It to confirm your choice or F4/Cancel to return to the previous screen.
- **To enter a shortcut folder**, press the corresponding combination of buttons below:

  - **Folder 1**: Shift+Project/Folder 1.
  - **Folder 2**: Shift+Sequence/Folder 2.
  - **Folder 3**: Shift+Program/Folder 3.
  - **Folder 4**: Shift+Sample/Folder 4.
  - **Folder 5**: Shift+No Filter/Folder 5.
Sample Record Mode

Sample Record Mode lets you record audio samples to use in your projects.

**Important:** To record any audio, you need to connect an audio source to your MPC hardware or to your computer’s audio interface.

**Important:** The **Input**, **Channel**, **Monitor**, **Threshold**, and effects (**Fx**) are the same for both Sample Record Mode and the Looper.

To enter Sample Record Mode, press **Shift+Sample Edit/Sample Rec.**

Use the **cursors** to select each field, and then use the **data dial** or −/+ buttons to change the parameter. If the field is a number, you can use the **numeric keypad** to enter a number and then press **Enter** to confirm it.

These are the buttons under the screen during normal operation:

- **F1** **Sampler/Looper** Press this button to switch between Sample Record Mode and the Looper.
- **F2** **Sample/Slice**/ **Pad Tap/Pad Hold** Press this button to cycle through the four sampling methods: **Sample**, **Slice**, **Pad Tap**, and **Pad Hold**.
- **F3** **Peak** Press this button to reset the peak indicator on the **input level meter**.
- **F4** **Fx** Press this button to show and edit the sampler’s insert effects.
- **F6** **Record** Press this button to record-arm the sampler.

These are the buttons under the screen when the sampler is record-armed:

- **F4** **Fx** Press this button to show and edit the sampler’s insert effects.
- **F5** **Cancel** Press this button to record-disarm the sampler.
- **F6** **Start** Press this button to start recording in the sampler.

To set up the sampler before recording:

1. Make sure to reduce the volume levels of your audio source and speakers, headphones, and/or monitors before you make any connections to avoid “pops” or feedback.
2. Connect a synthesizer or other line-level audio source to the input/inputs of your MPC hardware.
3. Turn the **Rec Gain** knob to set the input level while playing your audio source. You should now see the level in the meter. Make sure it does not exceed the maximum level (the meter should not be “peaking” constantly).
4. Set the recording controls as desired (described in this chapter).
5. Press **F6/Record** to record-arm the sampler.

You can record using four different methods: **Sample**, **Slice**, **Pad Tap**, or **Pad Hold**, all described later in this chapter. The following controls are present regardless of which method you use.

To select a sampling method, press **F2** to cycle through them: **Sample**, **Slice**, **Pad Tap**, **Pad Hold**.
Now is the time counter at the top of the screen, which shows the current playhead position. See General Features > Now & Locators to learn about this.

Inserts determines whether insert effects are activated (ON) or deactivated (OFF) for the sampler and Looper.

**Important:** These effects are applied to the audio as you record it. This means that the effects cannot be “removed” from the sound later. Learn more about how effects work in General Features > Effects.

- **To activate or deactivate the insert effects**, set this field to ON or OFF (respectively).
- **To load, activate, deactivate, or edit the insert effects**, press F4/Fx.

Input determines the source of the recording in Sample Record Mode (and the Looper). You can select an external audio signal (In 1,2–In 31,32) or an internal signal (Resample).

**Tip:** Because resampling does not record from an external source, it does not require an audio connection and can record without any loss in audio quality. Furthermore, you can resample two or more samples at once by pressing the corresponding pads simultaneously.

- **To set the input**, use this field. All options are stereo pairs. If you want to record a mono signal, use the Channel field to determine which one is the source.
- **To set which channel is the source**, use the Channel field to select the left channel only (LEFT), right channel only (RIGHT), or both channels (STEREO).

Channel determines which channel you will record from the source while using Sample Record Mode (and the Looper): the left channel only (LEFT), right channel only (RIGHT), or both channels (STEREO).

- **To set which channel is the source**, use this field.

Monitor determines whether or not input monitoring is on or off while using Sample Record Mode (and the Looper). When on, the audio you hear in your headphones will be taken before it reaches the sampler, ensuring zero latency. When off, the audio you hear in your headphones will be taken after it is processed in the sampler, so there may be some latency, but you will hear the audio source as it sounds in the recording.

- **To activate or deactivate input monitoring**, set this field to ON or OFF (respectively).

**Tip:** To avoid possible clicks or feedback while input monitoring, reduce the level of the audio sources.

Threshold indicates the minimum audio signal level required to start the sampler (or Looper) when it is record-armed. In other words, when record-armed, the sampler will automatically start recording when the incoming audio signal is louder than this threshold. The T marker under the level meters is a visual indication of this setting.

Set this level carefully. If you set it too high, the recording may not start when you play the input source, or the start of the material you wanted to record may be missing. If you set it too low, the recording may start too early, before you play the external source. Use the level meter to find the appropriate setting.

- **To set the threshold**, use this field, or Q-Link Knob 1 (MPC Renaissance) or the first Q-Link knob (MPC Studio).

Time determines the maximum sampling time up to 19 minutes and 59 seconds (19:59) per sample. We recommend setting these to values that roughly match your estimated recording duration.

- **To set the sampling time**, use this field or turn Q-Link Knobs 3 and 4 (MPC Renaissance) or the third and fourth Q-Link knobs (MPC Studio) to set the Minutes and Seconds (respectively). If you use the numeric keypad to enter a time, enter the total number of seconds (e.g., enter 90 instead of 1:30).

Output determines if the recorded sample will be monaural (Mono) or binaural (Stereo).

- **To set whether the recorded sample will be monaural or binaural**, use this field.
The **Left/Right level meters** shows the current input gain level of the incoming audio signal. The **T** marker under the **level meters** is a visual indication of the **Threshold** setting.

You can record using four different methods: **Sample**, **Slice**, **Pad Tap**, or **Pad Hold**, all described later in this chapter.

- **To select a sampling method**, press **F2** to cycle through them: **Sampler**, **Slice**, **Pad Tap**, **Pad Hold**.

**Peak** allows you to reset the peak indicator when the input level meter has exceeded the maximum volume level.

- **To reset the peak indicator**, press **F3/Peak**.

**Fx** shows any enabled or disabled effects for Sample Record Mode (and the Looper).

**Important**: These effects are applied to the audio as you record it. This means that the effects cannot be “removed” from the sound later. Learn more about how effects work in **General Features > Effects**.

- **To load, activate, deactivate, or edit the insert effects**, press **F4/Fx**. **Inserts 1–4** show the insert effects loaded to Sample Record Mode (and the Looper).
  - **To load an effect**, use its **Insert** field. Select an effect in the **Select Effect** screen that appears. Press **F4/Select** to load the selected effect or **F3/Back** to return to the previous screen.
  - **To change the settings of a loaded effect**, select its **Insert** field, and press **Window**. In the screen that appears, you can select and change each parameter (you can use the **numeric keypad** on some of them). Press **F4/Close** to return to the previous screen.
  - **To activate or deactivate an effect**, select its **Insert** field, and press **Window**. In the screen that appears, press **F6/On/Off** to activate or deactivate the effect. Press **F4/Close** to return to the previous screen.
  - **To activate or deactivate all four insert effects**, set the **Inserts** field to **ON** or **OFF** (respectively).
  - **To return to the previous screen**, press **F4/Fx**.

Press **F6/Record** to record-arm the sampler. The button will then change to **Start** and **Waiting for Signal** will appear in the screen.

- **To start recording**, start performing so that the incoming audio level exceeds the **Threshold** setting, or press **F6/Start** to start recording manually. For reference, the **Sample Length** counter shows you the length of your sample during the recording procedure.

- **To disarm the sampler instead**, tap **F5/Cancel**.
Sample

Using this method, you can insert slice markers directly in your sample as you record it.

Slice markers divide the sample into multiple regions called *slices*, which you can adjust in the Chop Mode of Sample Edit Mode (see *Sample Edit Mode > Chop Mode* for more information). This is useful when working with a long sample with different sounds throughout (e.g., a drum loop or a long melodic or harmonic passage).

**To select the Sample method**, press F2 to cycle through the options until *Sample* appears in the button.

![Sample interface](image)

**To start recording**, start performing so that the incoming audio level exceeds the *Threshold* setting, or press F6/Start to start recording manually. For reference, the *Sample Length* counter shows you the length of your sample during the recording procedure.

**To disarm the sampler instead**, tap F5/Cancel.

**To stop recording**, press F6/Stop.

**To insert a slice marker in a sample while recording**, press Slice+ (in the lower-right corner) as the sample records. Each time you press it, a slice marker will be placed at that location.

After you stop your recording, the *Keep or Discard Sample* window will appear.

![Keep or Discard Sample interface](image)

**Name** is the name of the new sample.

**Prg** is the program to which the sample will be assigned.

**To assign the sample to a program**, use this field. Select `<none>` to save it to the project without assigning it to a program.
Assign To Pad determines the pad (in the program shown in the Prg field) to which the sample will be assigned.

To assign the sample to a pad within the program, use this field or press the pad. Select Off to assign it to the program without assigning it to a pad.

Root Note is the root note of the sample. This determines which note will play the sample at its original pitch when in a keygroup program.

To set the root note, use this field.

F1/Save saves the sample.
F3/Play plays the sample.
F4/Discard erases the recorded sample and returns to the previous screen.
F5/Keep saves the recorded sample with the settings in this window and returns to the previous screen.
F6/Edit opens Sample Edit Mode so you can edit the recorded sample (recommended, see Sample Edit Mode for more information).

If you recorded a sample while a sequence was playing, the Keep or Discard Sample window will show a few more options if you set Assign To Pad to a pad.

Add Event determines whether or not the sample will be added to the sequence you played.

To select whether or not the sample is added, set this field to Yes or No (respectively).

At determines where you want the event to start. When set to Start, the sample will be a note event at the start of the currently playing sequence. When set to Trigger, the sample will be a note event where you began recording it in the currently playing sequence.

To set where the event will start, set this field to Start or Trigger.

Track is the track that will contain the new event.

To set which track will contain the new event, use this field.

F1/Save saves the sample.
F3/Play plays the sample.
F4/Discard erases the recorded sample and returns to the previous screen.
F5/Keep saves the recorded sample with the settings in this window and returns to the previous screen.
F6/Edit opens Sample Edit Mode so you can edit the recorded sample (recommended, see Sample Edit Mode for more information).
Slice

Using this method, the pads correspond to slices of the currently recorded sample. Slice markers divide the sample into multiple regions called slices, which you can adjust in the Chop Mode of Sample Edit Mode (see Sample Edit Mode > Chop Mode for more information). This is useful when working with a long sample with different sounds throughout (e.g., a drum loop or a long melodic or harmonic passage).

To select the Slice method, press F2 to cycle through the options until Slice appears in the button.

To start recording, start performing so that the incoming audio level exceeds the Threshold setting, or press F6/Start to start recording manually. For reference, the Sample Length counter shows you the length of your sample during the recording procedure.

To disarm the sampler instead, tap F5/Cancel.

To stop recording, tap Stop under the Sample Length counter.

To insert a slice marker in a sample while recording, press any pad as the sample records. Each time you press it, a slice marker will be placed at that location.

The number of the pad that flashes red is the number of the slice marker that will be inserted next. The numbers of the pads that are lit yellow are the numbers of the slice markers that are already inserted.

When you are done recording, you can name the sample and create a new program using the slices.

To stop recording, press F6/Stop.

After you stop your recording, the Keep or Discard Sample window will appear.
Create New Prg determines how each pad’s layer settings will be set when each slice is assigned to it (see Program Edit Mode to learn more about the parameters mentioned below):

- **Off** will not create a program, but the slices will still be added to your project’s sample pool.
- **With Non-Destructive Slices** will create a new program with each pad’s Slice setting set to the slice number. This is identical to how you can assign samples in Sample Edit Mode (as described in Sample Edit Mode > Chop Mode > Converting or Assigning Slices).
- **With Pad Parameters** will create a new program with each pad’s Slice setting set to Pad. The pad Start and End parameters will be set to the slice’s start point and end point values, and the Loop position parameter will be set to the slice’s start point but with Pad Loop deactivated. This is identical to how you can assign samples in Sample Edit Mode (as described in Sample Edit Mode > Chop Mode > Converting or Assigning Slices).

**F1/Save** saves the sample.

**F3/Play** plays the sample.

**F4/Discard** erases the recorded sample and returns to the previous screen.

**F5/Create** saves the recorded sample with the settings in this window and returns to the previous screen.

**F6/Edit** opens Sample Edit Mode so you can edit the recorded sample (recommended, see Sample Edit Mode for more information).

**Pad Tap**

**Important**: This mode works for drum programs only; you must select a drum program before using this mode. Otherwise, this feature will not do anything, even though it may appear to work.

With this method, pressing a pad immediately starts or continues recording directly to that pad (make sure you are using the desired program before you start recording). Pads with assigned samples are lit bright yellow. Pads without samples are lit dim yellow.

**To select the Pad Tap method**, press **F2** to cycle through the options until **Pad Tap** appears in the button.

**To start recording to a pad**, press it. Recording will start immediately, and the pad will flash red. If you press a new pad, the recording will stop on the previous pad, which will turn green, and start on the new pad, which will flash red.

**Note**: If you start recording by pressing **F6/Record**—or if the volume exceeds the level of the threshold slider—the sample will record to your project’s sample pool, not to a pad.

**To stop recording to a pad**, press the currently recording pad, which is flashing red. The sample will continue recording. You can start recording on another pad at any time.

**To stop recording**, press **F6/Stop**.

When you are done recording, each pad that you have pressed during recording:

- will have its Slice setting set to Pad;
- will have its pad Start and End set to the slice’s start point and end point values; and
- will have its Loop position set to the slice’s start point but with Loop deactivated.

This is identical to how you can assign samples in Sample Edit Mode (as described in Sample Edit Mode > Chop Mode > Converting or Assigning Slices).

**Tip**: We recommend editing your recorded sample in Sample Edit Mode (see Sample Edit Mode for more information).
Pad Hold

**Important:** This mode works for *drum programs only*; you must select a drum program before using this mode. Otherwise, this feature will not do anything, even though it may appear to work.

With this method, pressing and holding a pad immediately starts or continues recording directly to that pad (make sure you are using the desired program before you start recording). Pads with assigned samples are lit **bright yellow**. Pads without samples are lit **dim yellow**.

**To select the Pad Hold method,** press F2 to cycle through the options until **Pad Hold** appears in the button.

![Sampler interface](image)

**To start recording to a pad,** press and hold it. Recording will start immediately, and the pad will light **red**.

**Note:** If you start recording by pressing F6/Record—or if the volume exceeds the level of the threshold slider—the sample will record to your project’s sample pool, not to a pad.

**To stop recording,** release the pad. The pad will light **green**, and the sample will continue recording. You can start recording on another pad at any time.

**To stop recording,** press F6/Stop.

When you are done recording, each pad that you have pressed during recording:

- will have its Slice setting set to **Pad**;
- will have its pad Start and End set to the slice’s start point and end point values; and
- will have its Loop position set to the slice’s start point but with **Pad Loop** deactivated.

This is identical to how you can assign samples in Sample Edit Mode (as described in *Sample Edit Mode > Chop Mode > Converting or Assigning Slices*).

**Tip:** We recommend editing your recorded sample in **Sample Edit Mode** (see *Sample Edit Mode* for more information).
Looper

The Looper lets you record and overdub audio in real time—a great tool for live performance as well as spontaneous moments in the studio. You can export the loop as a sample to use in your project.

**Important:** The Input, Channel, Monitor, Threshold, and effects (Fx) are the same for both Sample Record Mode and the Looper. The Input and Threshold settings, however, are shown in Sample Record Mode only. See [Modes > Sample Record Mode](#) to learn how to use these settings.

To enter the Looper, press **Shift+Sample Edit/Sample Rec** to enter Sample Record Mode, and then press **F1/Sampler** to switch to the Looper.

Use the cursors to select each field, and then use the data dial or +/- buttons to change the parameter. If the field is a number, you can use the numeric keypad to enter a number and then press **Enter** to confirm it.

These are the buttons under the screen:

- **F1 Looper/Sampler** Press this button to switch between the Looper and Sample Record Mode.
- **F2 Export** Press this button to export the contents of the Looper as a sample.
- **F3 Reverse** Press this button to reverse the playback of the Looper.
- **F4 Play** Press this button to play the Looper.
- **F5 Replace** Press this button to overwrite the contents of the Looper while recording.
- **F6 Overdub** Press this button to keep the contents of the Looper while recording, essentially adding more layers to it.

**Shift+F5 Fx** Press these buttons to show and edit the Looper’s insert effects.

**Shift+F6 Clear** Press this button to erase the contents of the Looper.

Below is a brief step-by-step process so you can get started quickly. Continue reading the rest of this chapter to learn how to use the Looper in different cases.

**To get started using the Looper:**

1. Make sure to reduce the volume levels of your audio source and speakers/headphones/monitors before you make any connections to avoid “pops” or feedback.
2. Connect a synthesizer, audio player, etc. to the input/inputs of your MPC hardware or computer interface.
3. Turn the Rec Gain knob to set the input level while playing your audio source. You should now see the level in the meter. Make sure it does not exceed the maximum level (the meter should not be “peaking” constantly).
4. Set the recording controls as desired (described in this chapter).
5. Set Record To to Overdub.
6. Press **F6/Record** to start recording in the Looper.
7. Play your audio source. The Looper will start recording immediately when the input level reaches the threshold value. Alternatively, Press F4/Play to manually start recording.

Each time the Looper repeats, its contents are being overdubbed—a new layer of audio will be added each time you let the Looper repeat as it records.

Tip: You can record a loop while playing a sequence in the background for reference.

8. To stop recording, Press F4/Play.

To export your loop as a sample, press F2/Export to show the Export Loop as Sample screen.

To clear the contents of the Looper, press Shift+F6/Clear.

Important: The Input and Threshold settings the same for both Sample Record Mode and the Looper, but they are shown in Sample Record Mode only. See Modes > Sample Record Mode to learn how to use these settings.

Now is the time counter at the top of the screen, which shows the current playhead position. See General Features > Now & Locators to learn about this.

Gain is the output signal level of the Looper.

To set the output signal level, use this field or turn Q-Link Knob 4 (MPC Renaissance) or the fourth Q-Link knob (MPC Studio).

Bars is the length of the loop in bars. Regardless of how much or how little audio you record, this is how long your loop will be.

To set the number of bars, use this field.

Sync determines whether or not the Looper is synchronized with sequence playback. When set to ON, the looper will stay in step with your current sequence. When you play or record into the Looper, it will wait until the sequence starts playing Bar 1 to start. When set to OFF, the looper will remain independent of any sequence playback.

To synchronize or un-synchronize the Looper with sequence playback, set this field to ON or OFF (respectively).

Rec To determines the recording behavior:

PLAY: Before recording, you must first press F4/Play, which will start playing the Looper.

OVERDUB: Before recording, you must first press F6/Overdub to record-arm the Looper.

Monitor determines whether or not input monitoring is on or off while using the Looper (and Sample Record Mode). When on, the audio you hear in your headphones will be taken before it reaches the Looper, ensuring zero latency. When off, the audio you hear in your headphones will be taken after it is processed in the Looper, so there may be some latency, but you will hear the audio source as it sounds in the recording.

To activate or deactivate input monitoring, set this field to ON or OFF (respectively).

Tip: To avoid possible clicks or feedback while input monitoring, reduce the level of the audio sources.

Ch determines which channel you will record from the source while using the Looper (and Sample Record Mode): the left channel only (LEFT), right channel only (RIGHT), or both channels (STEREO).

To set which channel is the source, use this field.
The **waveform display** is a visual representation of the contents of the Looper.

The **level meters** on either side of the waveform display show the audio signal level at the beginning and end of the loop.

The icon next to the “in” level meter indicates whether the Looper is paused (■), playing (▶), or recording (●).

**Fx** shows any enabled or disabled effects for the Looper (and Sample Record Mode).

**Important**: These effects are applied to the audio as you record it. This means that the effects cannot be “removed” from the sound later. Learn more about how effects work in *General Features > Effects*.

To load, activate, deactivate, or edit the insert effects, press Shift+F5/Fx. **Inserts 1–4** show the insert effects loaded to the Looper (and Sample Record Mode).

- **To load an effect**, use its **Insert** field. Select an effect in the *Select Effect* screen that appears. Press F4/Select to load the selected effect or F3/Back to return to the previous screen.

- **To change the settings of a loaded effect**, select its **Insert** field, and press Window. In the screen that appears, you can select and change each parameter (you can use the numeric keypad on some of them). Press F4/Close to return to the previous screen.

- **To activate or deactivate an effect**, select its **Insert** field, and press Window. In the screen that appears, press F6/On/Off to activate or deactivate the effect. Press F4/Close to return to the previous screen.

- **To activate or deactivate all four insert effects**, set the **Inserts** field to **ON** or **OFF** (respectively).

- **To return to the previous screen**, press F4/Fx.

**Peak** allows you to reset the peak indicator when the input level meter has exceeded the maximum volume level.

- **To reset the peak indicator**, press F3/Peak.
To record with the Looper:

**Important:**

**To record without erasing any audio you've already recorded in the loop**, press F6/Overdub.

**To overwrite the audio you've already recorded**, press F5/Replace.

If Rec To is set to PLAY:

- **To start recording**, press F5/Replace or F6/Overdub as the loop is playing. The Looper will start recording immediately.
- **To stop recording**, press F5/Replace or F6/Overdub again. The Looper will stop recording but continue playing.
- **To stop playback and recording**, press F4/Play.

If Rec To is set to OVERDUB:

- **To start recording**, press F4/Play.
  - If Sync is set to OFF, you can also play your audio source so that the input level reaches the threshold value.
  - If Sync is set to ON, you can also press the Play or Play Start button to start playing a sequence; recording will start when the sequence starts on Bar 1.
- **To stop recording**, press F6/Overdub. The Looper will stop recording but continue playing.
- **To stop playback and recording**, press F4/Play or press Stop to stop sequence playback.

**To play or stop the loop** (without recording), press F4/Play.

**To reverse loop playback**, press F3/Reverse. If Sync is set to ON, playback will reverse once the Looper’s playhead reaches the end of the loop. If Sync is set to OFF, playback will reverse immediately.

**To erase the contents of the Looper immediately**, press Shift+F6/Clear.

**To export the loop as a sample**, press F2/Export to show the Export Loop as a Sample screen.

- **Name** is the name of the new sample.
- **Prg** is the program to which the sample will be assigned.
  - To assign the sample to a program, use this field. Select <none> to save it to the project without assigning it to a program.
- **Assign To Pad** determines the pad (in the program shown in the Prg field) to which the sample will be assigned.
  - To assign the sample to a pad within the program, use this field or press the pad. Select Off to assign it to the program without assigning it to a pad.
- **Root Note** is the root note of the sample. This determines which note will play the sample at its original pitch when in a keygroup program.
  - To set the root note, use this field.
- **F1/Save** saves the loop.
- **F3/Play** plays the loop.
- **F4/Cancel** returns to the previous screen.
- **F5/Do It** saves the recorded loop with the settings in this window and returns to the previous screen. When your loop is done exporting, it will be added to your project’s sample pool and will be assigned to the program and pad you selected (if any).
- **F6/Edit** opens Sample Edit Mode so you can edit the recorded loop (recommended, see Sample Edit Mode for more information).
Pad Mixer

In the Pad Mixer, you can set a program’s levels, stereo panning, routing, and effects. This mode appears differently for each type of program:

- For drum programs, this mode shows settings for each individual pad (of 128).
- For keygroup programs, this mode shows settings for each individual keygroup (up to 128).
- For clip programs, this mode shows settings for each individual clip.
- For MIDI programs, plugin programs, and CV programs, this mode is unavailable.

Important: The Prog Mix button on your MPC hardware corresponds to the Pad Mixer in the MPC software. This is due to the functionality changing as the software has evolved.

To enter the Pad Mixer, press Prog Mix.

The Pad Mixer works like an audio mixer with various settings for each pad, shown in a 4x4 array. All of their functionality is identical. The pad number is displayed in each field.

Use the cursors to select each field, and then use the data dial or +/- buttons to change the parameter. If the field is a number, you can use the numeric keypad to enter a number and then press Enter to confirm it.

These are the buttons under the screen:

- **F1 Level**: Press this button to view the levels of the pads. See Level to learn more.
- **F2 Pan**: Press this button to view the panning of the pads. See Pan to learn more.
- **F3 Mute**: Press this button to view the mute status of the pads. See Mute to learn more.
- **F4 Send**: Press this button to cycle through the four tabs of send effect levels of the pads. See Send to learn more.
- **F5 Insert**: Press this button to cycle through the four tabs of insert effects loaded to the pads. See Insert to learn more.
- **F6 Route**: Press this button to view the routing of the pads. See Route to learn more.
To select a pad, press its corresponding pad. Alternatively, use the Pad field in the upper-left corner.

To view more pads, use the Pad Bank buttons.

To show the name of the sample assigned to each pad instead of the setting, press and hold Shift. The sample on the first layer of each pad will appear in place of the corresponding settings. Release Shift to return to the normal view.

Program is the program whose pads you are viewing and editing. Only one type of program will be available in this field at a time (e.g., if Track is set to a track using a drum program, Program can be set to a drum program only). Remember that only drum programs, keygroup programs, or clip programs will display properly in the Pad Mixer.

To select a program, use this field.

Track is the track whose program you are viewing and editing. This also determines the type of program you can select with the Program field (e.g., if Track is set to a track using a drum program, Program can be set to a drum program only).

To select a track, use this field.

To view each setting in all 16 fields, press the corresponding button (F1–F6) under the screen. You can press F4/Send or F5/Insert multiple times to cycle through the four available slots for each.

The following controls and tabs are available as indicated:

**Level**

When the Level tab is selected, the 16 fields show the volume level of each pad in dB.

To adjust the level of a pad, use its corresponding field or turn its corresponding Q-Link knob.

**Pan**

When the Pan tab is selected, the 16 fields show the panning (stereo placement) of each pad. 50 L (left) to 50 R (right). C indicates the center position.

To adjust the panning of a pad, use its corresponding field or turn its corresponding Q-Link knob. If you use the numeric keypad to change this number, use values from 0 to 100: 0 corresponds to 50 L, 50 corresponds to C, and 100 corresponds to 50 R.

**Mute**

When the Mute tab is selected, the 16 fields show the mute status of each pad.

To mute or unmute a pad, use its corresponding field or turn its corresponding Q-Link knob.

**Send**

When the Send tab is selected, the 16 fields show one of the four send levels of each pad: 0–100. You can select up to four send effects for each pad. You can use various effects in the MPC software as well as other VST and AU plugins installed on your computer.

Important: To use a send effect, you have to load an effect into the corresponding send effect slot in the Channel Mixer. Please see General Features > Effects > Send/Return Effects to learn more about send effects.

To adjust the send level of a pad, use its corresponding field or turn its corresponding Q-Link knob.

To cycle through the four send effect levels, press F4/Send.
Insert

When the Insert tab is selected, the 16 fields show one of the four insert effects of each pad. You can select up to **four insert effects** for each pad. You can use various effects in the MPC software as well as other VST and AU plugins installed on your computer.

**Important:**

When using keygroup insert effects, they will be applied to that keygroup only. Keep this in mind if you load insert effects to multiple keygroups with overlapping note ranges—the effects will overlap in that range as well.

If a routing is set to anything other than **Program**, then a program insert effect will **not** be applied to that pad or keygroup.

Please see **General Features > Effects > Insert Effects** to learn more about insert effects.

- To select an insert effect for a pad, use its corresponding field.
- To cycle through the four insert effect slots, press **F4/Send**.
- To load an effect, use its corresponding field. Select an effect in the **Select Effect** screen that appears. Press **F4/Select** to load the selected effect or **F3/Back** to return to the previous screen.
- To change the settings of a loaded effect, select its **Insert** field, and press **Window**. In the screen that appears, you can select and change each parameter (you can use the numeric keypad on some of them). Press **F4/Closed** to return to the previous screen.
- To activate or deactivate an effect, turn its corresponding **Q-Link knob**. Alternatively, select its **Insert** field, and press **Window**. In the screen that appears, press **F6/On/Off** to activate or deactivate the effect. Press **F4/Closed** to return to the previous screen.

Route

When the Route tab is selected, the 16 fields show the output of each pad: **Program**, Submix (Sub) 1–8, Out 1,2–31,32, or Out 1–32. Usually, this is set to **Program**.

**Note:** When set to a mono channel, the left and right channels are summed post-pan knob. If the pan knob is set to the center position, the left and right channels will be summed and padded. If the pan knob is set to the maximum left or right positions, only the respective channel will be sent to the output.

- To select the output of a pad, use its corresponding field or turn its corresponding **Q-Link knob**.
In the **Channel Mixer**, you can set levels, stereo panning, and other settings for your MIDI and audio tracks, programs, returns, submixes, and master outputs.

This mode appears differently for each type of “channel”: **MIDI Tracks** (Tracks), **Audio Tracks**, **Programs**, **Returns**, **Submixes**, and **Master Outputs** (Outputs).

**Important:** Track Mix (or Shift+Prog Mix/Track Mix) on your MPC hardware corresponds to the **Channel Mixer** in the MPC software. This is due to the functionality changing as the software has evolved.

To open the **Channel Mixer**, press Shift+Prog Mix/Track Mix.

The **Channel Mixer** works like an audio mixer with various settings for each channel, shown in a 4x4 array. Their functionality is mostly identical. The name of the track, program, or channel is displayed at the top of each one.

Use the **cursors** to select each field, and then use the **data dial** or +/- buttons to change the parameter. If the field is a number, you can use the **numeric keypad** to enter a number and then press **Enter** to confirm it.

These are the buttons under the screen:

- **F1 Level**: Press this button to view the levels of the pads. See the description [here](#) to learn more.
- **F2 Pan**: Press this button to view the panning of the pads. See the description [here](#) to learn more.
- **F3 Mute**: Press this button to view the mute status of the pads. See the description [here](#) to learn more.
- **F4 Send**: Press this button to cycle through the four tabs of send effect levels of the pads. See the description [here](#) to learn more.
- **F5 Insert**: Press this button to cycle through the four tabs of insert effects loaded to the pads. See the description [here](#) to learn more.
- **F6 Route**: Press this button to view the routing of the pads. See the description [here](#) to learn more.

**Mixer** is the type of channels whose settings you are viewing and editing: **MIDI Tracks** (Tracks), **Audio Tracks**, **Programs**, **Returns**, **Submixes**, and **Master Outputs** (Outputs). Each page has slight differences, described in each section of this chapter.

To select the type of **channel**, use this field.
The field in the upper-right corner determines the channels whose settings you are viewing and editing: 1–16, 17–32, etc. The name of the field varies depending on the type of channel. You cannot change this value for returns, submixes, or master outputs (pairs) because there are 16 or fewer of them.

To select the channels shown in the screen, use this field: Track (for MIDI tracks), Audio Track, Program, Return, Submix, or Output Pairs (for master outputs).

To view each setting in all 16 fields, press the corresponding button (F1–F6) under the screen. You can press F4/Send or F5/Insert multiple times to cycle through the four available slots for each.

To show the names or numbers of the channels instead of their settings, press and hold Shift. The track name, program name, return number, submix number, or master output numbers will appear in place of the corresponding settings. Release Shift to return to the normal view.

The following controls and tabs are available as indicated:

**Level**

When the Level tab is selected, the 16 fields show the velocity level (0–127) of MIDI tracks or the volume levels in dB of the audio tracks, programs (except for MIDI and CV programs), returns, submixes, or master outputs.

To adjust a level setting, use its corresponding field or turn its corresponding Q-Link knob.

**Pan**

When the Pan tab is selected, the 16 fields show the panning of the MIDI or audio tracks, programs (except for MIDI and CV programs), returns, submixes, or master outputs. 50 L (left) to 50 R (right). C indicates the center position.

To adjust a panning setting, use its corresponding field or turn its corresponding Q-Link knob. If you use the numeric keypad to change this number, use values from 0 to 100: 0 corresponds to 50 L, 50 corresponds to C, and 100 corresponds to 50 R.

**Mute**

When the Mute tab is selected, the 16 fields show the mute status of the MIDI or audio tracks, programs (except for MIDI and CV programs), returns, submixes, or master outputs.

To mute or unmute a channel, use its corresponding field or turn its corresponding Q-Link knob.

**Send** (audio tracks, programs, and submixes only)

When the Send tab is selected, the 16 fields show one of the four send levels of the audio tracks, programs (except for MIDI and CV programs), or submixes: 0–100. You can select up to four send effects for each one. You can use various effects in the MPC software as well as other VST and AU plugins installed on your computer.

Important: To use a send effect, you have to load an effect into the corresponding send effect slot in the Channel Mixer. Please see General Features > Effects > Send/Return Effects to learn more about send effects.

To adjust a send level, use its corresponding field or turn its corresponding Q-Link knob.

To cycle through the four send effect levels, press F4/Send.
Insert (audio tracks, programs, returns, submixes, and master outputs only)

When the Insert tab is selected, the 16 fields show one of the four insert effects of the audio tracks, programs (except for MIDI and CV programs), returns, submixes, and master outputs. You can select up to four insert effects for each one. You can use various effects in the MPC software as well as other VST and AU plugins installed on your computer.

To select an insert effect, use its corresponding field.

To cycle through the four insert effect slots, press F4/Send.

To load an effect, use its corresponding field. Select an effect in the Select Effect screen that appears. Press F4/Select to load the selected effect or F3/Back to return to the previous screen.

To change the settings of a loaded effect, select its Insert field, and press Window. In the screen that appears, you can select and change each parameter (you can use the numeric keypad on some of them). Press F4/Closed to return to the previous screen.

To activate or deactivate an effect, turn its corresponding Q-Link knob. Alternatively, select its Insert field, and press Window. In the screen that appears, press F6/On/Off to activate or deactivate the effect. Press F4/Closed to return to the previous screen.

Please see General Features > Effects > Insert Effects to learn more about insert effects.

Route (audio tracks, programs, returns, and submixes only)

When the Route tab is selected, the 16 fields show the output of the audio tracks, programs (except for MIDI and CV programs), returns, and submixes: Submix (Sub) 1–8 (for audio tracks and programs), Out 1,2–31,32, or Out 1–32.

Note: When set to a mono channel, the left and right channels are summed post-pan knob. If the pan knob is set to the center position, the left and right channels will be summed and padded. If the pan knob is set to the maximum left or right positions, only the respective channel will be sent to the output.

To select the output for a channel, use its corresponding field or turn its corresponding Q-Link knob.
MIDI Tracks

The MIDI Track Mixer shows levels, panning, and mute states for all used tracks.

To view a specific setting on all tracks, press F1/Level, F2/Pan, or F3/Mute.
Audio Tracks

The Audio Track Mixer shows levels, mute states, send and insert effects, and routing for all used tracks. To view a specific setting on all tracks, press F1/Level, F2/Pan, F3/Mute, F4/Send, F5/Insert, or F6/Route. Press F4/Send or F5/Insert to cycle through the four send effect levels or insert effect slots (respectively).

<table>
<thead>
<tr>
<th>Mixer: Audio Tracks</th>
<th>Audio Track 1-16</th>
</tr>
</thead>
<tbody>
<tr>
<td>13: -</td>
<td>14: -</td>
</tr>
<tr>
<td>9: -</td>
<td>10: -</td>
</tr>
<tr>
<td>5: L</td>
<td>6: L</td>
</tr>
<tr>
<td>11: C</td>
<td>2: C</td>
</tr>
<tr>
<td>Level</td>
<td>Pan</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mixer: Audio Tracks</th>
<th>Audio Track 1-16</th>
</tr>
</thead>
<tbody>
<tr>
<td>13: -</td>
<td>14: -</td>
</tr>
<tr>
<td>9: -</td>
<td>10: -</td>
</tr>
<tr>
<td>5: Muted</td>
<td>6: Muted</td>
</tr>
<tr>
<td>11:</td>
<td>2:</td>
</tr>
<tr>
<td>Level</td>
<td>Pan</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mixer: Audio Tracks</th>
<th>Audio Track 1-16</th>
</tr>
</thead>
<tbody>
<tr>
<td>13: -</td>
<td>14: -</td>
</tr>
<tr>
<td>9: -</td>
<td>10: -</td>
</tr>
<tr>
<td>5: 60</td>
<td>6: 50</td>
</tr>
<tr>
<td>11: 28</td>
<td>2: 23</td>
</tr>
<tr>
<td>Level</td>
<td>Pan</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mixer: Audio Tracks</th>
<th>Audio Track 1-16</th>
</tr>
</thead>
<tbody>
<tr>
<td>13: -</td>
<td>14: -</td>
</tr>
<tr>
<td>9: -</td>
<td>10: -</td>
</tr>
<tr>
<td>5: Rev. Small</td>
<td>6:</td>
</tr>
<tr>
<td>1: AIR,verb</td>
<td>2: Rev.edium</td>
</tr>
<tr>
<td>Level</td>
<td>Pan</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mixer: Audio Tracks</th>
<th>Audio Track 1-16</th>
</tr>
</thead>
<tbody>
<tr>
<td>13: -</td>
<td>14: -</td>
</tr>
<tr>
<td>9: -</td>
<td>10: -</td>
</tr>
<tr>
<td>5: Sub 1</td>
<td>6: Sub 2</td>
</tr>
<tr>
<td>11: Out 1,2</td>
<td>2: Out 1,2</td>
</tr>
<tr>
<td>Level</td>
<td>Pan</td>
</tr>
</tbody>
</table>
### Programs

The Pad Mixer shows levels, panning, mute states, send and insert effects, and routing for all programs except for MIDI programs and CV programs.

To view a specific setting on all programs, press **F1/Level**, **F2/Pan**, **F3/Mute**, **F4/Send**, **F5/Insert**, or **F6/Route**. Press **F4/Send** or **F5/Insert** to cycle through the four send effect levels or insert effect slots (respectively).
Returns

Pads, programs, and audio tracks can each be sent to up to four send channels. Their audio signals will be routed to the send channels at their designated send levels. After being processed by the effects on those channels, their signals are then sent to the assigned master output based on their return settings (levels, panning, etc.). This view displays the four return channels. The return mixer shows levels, panning, mute states, insert effects, and routing for all used tracks.

To view a specific setting on all returns, press F1/Level, F2/Pan, F3/Mute, F5/Insert, or F6/Route. Press F5/Insert to cycle through the four insert effect slots.
### Submixes

The Submixer shows levels, panning, mute states, send and insert effects, and routing for the eight available submixes.

**To view a specific setting on all submixes**, press F1/Level, F2/Pan, F3/Mute, F4/Send, F5/Insert, or F6/Route. Press F4/Send or F5/Insert to cycle through the four send effect levels or insert effect effect slots (respectively).
Master Outputs

The Master Mixer shows levels, panning, mute states, and insert effects for all stereo pairs of outputs: Out 1,2–31,32. To view a specific setting on all master outputs, press F1/Level, F2/Pan, F3/Mute, F5/Insert, or F6/Route. Press F5/Insert to cycle through the four insert effect slots.
Pad Mute Mode

Pad Mute Mode lets you easily mute pads on a single track with a drum program or clip program—by simply pressing them on your MPC hardware. This function is similar to muting pads in the Pad Mixer but more convenient. You can also set groups for each pad, enabling you to mute multiple pads at once. This is useful if you want to hear a track without a particular sound or if you want to isolate specific sounds or combinations of sounds.

To enter Pad Mute Mode, press Shift+Track Mute/Pad Mute.

Use the cursors to select each field at the top of the screen, and then use the data dial or –/+ buttons to change the parameter. If the field is a number, you can use the numeric keypad to enter a number and then press Enter to confirm it.

These are the buttons under the screen:

- **F1 PadMute**: Press this button to view the PadMute tab.
- **F2 PadGroup**: Press this button to view the PadGroup tab.
- **F4 Time Div**: Press this button to open the Timing Correct screen.
- **F5 T.C.**: This button indicates whether or not Timing Correct is on. Pressing it does not perform any function.

Now is the time counter at the top of the screen, which shows the current playhead position. See General Features > Now & Locators to learn about this.

Program is the program whose pads you are viewing. Only one type of program will be available in this field at a time (e.g., if your currently selected track uses a drum program, Program can be set to a drum program only). Remember that only drum programs, keygroup programs, or clip programs will display properly in Pad Mute Mode.

To select a program, use this field.

The pads are shown in a 4x4 array with the names of their assigned samples. Unused pads do not show any sample names and cannot be muted.

To mute a pad, press it on your MPC hardware. Muted pads are blue in the screen and red on your MPC hardware. Unmuted pads are white in the screen and yellow on your MPC hardware.

**Important**: Unused pads do not show any sample names and cannot be muted.

To view more pads, use the Pad Bank buttons.
The pad group feature extends the concept of pad mutes: you can mute or unmute multiple pads (on a single track) by pressing one pad that you have assigned to a pad group. You can create up to 16 different pad groups.

**To select a pad to add to a group**, press it on your MPC hardware. The selected pad is **white** in the screen and **green** on your MPC hardware. If there are other pads in the same group, they will flash **yellow** on your MPC hardware.

**To assign the selected pad to a group**, use the **data dial** or **+- buttons**. Alternatively, turn the **Q-Link knobs** to assign their corresponding pads to groups.

**Time Div** opens the Timing Correct screen, which lets you quantize pad mutes, synchronizing them with a specific time division: **Off**, 1/16th, 1/8th, 1/4, 1 bar, or 2 bar (a (3) indicates a triplet-based value). For example, with **Note Value** set to 1 Bar, your mutes will always occur at the beginning of the measure immediately after you press the pad.

**Note**: The Timing Correct screen in other modes perform a similar function but show additional settings. See **General Features > Timing Correct/T.C.** to learn about this.

**To open the Timing Correct settings**, press **F4/Time Div**.

**To set the quantization of the pad mutes**, use the **Note Value** field.

**To return to the previous screen**, press **F4/Close**. The **F4/T.C.** button will be **lit** when Timing Correct is on or **unlit** when Timing Correct is off.
Track Mute Mode

Track Mute Mode lets you easily mute tracks within a sequence—by simply pressing them on your MPC hardware. This function is similar to muting tracks in the Channel Mixer but more convenient. You can also set groups for each track, enabling you to mute multiple tracks at once. This is useful if you want to hear a sequence without a particular track (e.g., muting your keyboard track to focus on the bass) or if you want to isolate specific sounds or combinations of sounds that are separated by track.

To enter Track Mute Mode, press Track Mute.

Use the cursors to select each field at the top of the screen, and then use the data dial or –/+ buttons to change the parameter. If the field is a number, you can use the numeric keypad to enter a number and then press Enter to confirm it.

These are the buttons under the screen:

- **F1 TrkMute** Press this button to view the PadMute tab.
- **F2 TrkGroup** Press this button to view the PadGroup tab.
- **F4 Time Div** Press this button to open the Timing Correct screen.
- **F5 T.C.** This button indicates whether or not Timing Correct is on. Pressing it does not perform any function.
- **F6 Solo** Press and hold this button, and then press one or more pads to solo them rather than mute them.

Now is the time counter at the top of the screen, which shows the current playhead position. See General Features > Now & Locators to learn about this.

Seq is the sequence whose tracks you are viewing.

To select a program, use this field.

The tracks are represented by the 16 pads in a 4x4 array with their names. Unused tracks show (unused) and cannot be muted.

To mute a track, press its corresponding pad on your MPC hardware. Pads with muted tracks are blue in the screen and red on your MPC hardware. Pads with unmuted tracks are white in the screen and yellow on your MPC hardware.

To view more tracks, use the Pad Bank buttons.
The track group feature extends the concept of track mutes: you can mute or unmute multiple tracks (in a single sequence) by pressing one pad whose track you have assigned to that track group. You can create up to 16 different track groups.

**To select a track to add to a group**, press the corresponding pad on your MPC hardware. The selected pad is **white** in the screen and **green** on your MPC hardware. If there are other tracks in the same group, their pads will flash **yellow** on your MPC hardware.

**To assign the selected track to a group**, use the **data dial** or **–/+** buttons. Alternatively, turn the **Q-Link knobs** to assign the tracks on their corresponding pads to groups.

**Time Div** opens the Timing Correct screen, which lets you quantize track mutes, synchronizing them with a specific time division: **Off**, **1/16th**, **1/8th**, **1/4**, **1 Bar**, or **2 Bar** (a (3) indicates a triplet-based value). For example, with **Note Value** set to **1 Bar**, your mutes will always occur at the beginning of the measure immediately after you press the pad.

**Note**: The Timing Correct screen in other modes perform a similar function but show additional settings. See **General Features > Timing Correct/T.C.** to learn about this.

**To open the Timing Correct settings**, press **F4/Time Div**.

**To set the quantization of the track mutes**, use the **Note Value** field.

**To return to the previous screen**, press **F4/Close**. The **F4/T.C.** button will be **lit** when Timing Correct is on or **unlit** when Timing Correct is off.

Solo lets you solo pads rather than mute them.

**To solo one or more pads**, press and hold **F6/Solo**, and then press one or more pads to solo or un-solo them.
Next Sequence Mode

Next Sequence Mode lets you trigger different sequences simply by playing the pads. This is useful during live performances when you may want to change a song’s structure in real time.

To enter Next Sequence Mode, press Next Seq.

These are the buttons under the screen:

- **F1** To Song: Press this button to open the Copy to Song screen.
- **F3** Next Bar: Press this button to switch to the selected sequence at the beginning of the next bar.
- **F4** Sudden: Press this button to switch to the selected sequence immediately.
- **F5** Hold: Press this button to repeat the currently paying sequence indefinitely and temporarily ignore other pad presses.
- **F6** Clear: Press this button to delete the currently selected sequence from the sequence playlist.

Now is the time counter at the top of the screen, which shows the current playhead position. See General Features > Now & Locators to learn about this.

Seq is the sequence that is currently playing.

To select a sequence, press its corresponding pad.

The sequences are represented by the 16 pads in a 4x4 array with their names. Unused sequences show (unused) but can still be selected and played.

To select a sequence, press its corresponding pad on your MPC hardware. The pad for the currently playing sequence is white in the screen and green on your MPC hardware.

To view more sequences, use the Pad Bank buttons.

During playback, change the next sequence that will play by pressing the corresponding pad. If you do not select another sequence, the current sequence will repeat indefinitely. As a sequence plays, you can use the F3–F6 buttons under the screen to change how playback works.

To start playback, press Play or Play Start.

To stop playback, press Stop.

The Next Bar function causes the next sequence to play only after the current bar is done playing. This is useful for switching to another sequence before the current one ends without worrying about timing issues.

To activate the Next Bar function, press and hold F3/Next Bar. Release the button to deactivate it.
The **Sudden** function causes the new sequence to start playing whether or not the current sequence is done. This is useful in live performances for switching to the next sequence instantly at a certain cue.

**To activate the Sudden function**, press and hold F4/Sudden. Release the button to deactivate it.

The **Hold** function causes the currently playing sequence to repeat indefinitely and temporarily ignore other pad presses. This is useful if you want to select other pads without selecting them to play next.

**To activate the Hold function**, press F5/Hold. Press it again to deactivate it.

All of the sequences that have played are stored in a playlist in the MPC software (with their number of repetitions and tempos as well as the precise order in which they were played). You can send this playlist to Song Mode in order to export it to a finished song, or you can clear it and start a new performance.

**To cancel the sequence that will play next**, press F6/Clear. This will delete the next sequence from the sequence playlist. The current sequence will continue playing or you can click or press a pad to select another sequence to play next. This option is available only if that sequence is not playing at that moment.

**To copy the sequence playlist to a song**, press F1/To Song while playback is stopped. In the Copy to Song screen that appears, use the Copy to Song field to select a song, and then press F5/Do It to continue or F4/Cancel to return to the previous screen. Please see **Song Mode** to learn more about exporting a song.
**Song Mode**

Song Mode lets you arrange sequences in a specific order with specified repetitions to create complete songs. You can edit the structure of a song during playback for easy, on-the-fly composing.

A project can contain up to 32 songs, each consisting of up to 999 “steps.” Each step can have an assigned sequence as well as the number of times that sequence will repeat.

**To open Song Mode,** press **Song**.

**Important:** If a sequence is currently playing, stop playback before entering Song Mode. You cannot enter Song Mode during playback.

**Important:** When creating a song, the program used by each track in the song’s first sequence will be used by all subsequent tracks. In other words, all identically numbered tracks (across sequences) will use the program used by the first sequence in the song—regardless of what programs each track uses while not in Song Mode.

For example, if you create a project in this way…:

- Track 1 of **Sequence 1** uses a **drum** program.
- Track 1 of **Sequence 2** uses a **keygroup** program.

A song uses Sequence 1 as its first sequence and then uses Sequence 2 any time after it.

...then, in that song, Track 1 in Sequence 2 will use the same drum program as Track 1, Sequence 1.

Because of this, we recommend trying to be consistent while creating tracks in sequences that you intend to use in a single song. Remember that you can copy one track to another if you ever need to reorder the tracks of a sequence (see **General Features > Edit Sequence** to learn about this).

These are the buttons under the screen:

- **F1** Clear: Press this button to clear all steps and sequences from the list immediately.
- **F2** Sudden: During playback, press this button to switch to the next sequence at the beginning of the next bar.
- **F3** Next: During playback, press this button to switch to the next sequence immediately.
- **F4** Convert: Press this button to open the Convert Song screen.
- **F5** Delete: Press this button to delete the currently selected sequence from the sequence playlist.
- **F6** Insert: Press this button to insert a step in the sequence playlist immediately after the currently selected step.

**Now** is the time counter at the top of the screen, which shows the current playhead position. See **General Features > Now & Locators** to learn about this.

The BPM next to seq/mst at the top of the screen is the current tempo.

When set to **seq**, the number is the tempo of the currently selected sequence.

When set to **mst**, the number is the master tempo.

To set the tempo, use the BPM field or press **Tap Tempo** in time with the desired tempo.

To set whether the sequence follows its own tempo (seq) or a master tempo (mst), use the seq/mst selector or press **Shift+Tap Tempo**.

**Song** is the current song number and its name.

**To select a sequence,** use this field.

**Bars** is the length of the sequence in bars.

**To set the number of bars,** use this field.
The sequence playlist lists the “steps” of a song:

- **Step** is the step number (each song can contain up to 999 steps)
  - To insert a step, press F6/Insert.
  - To delete a step, press F5/Delete.
- **Sequence** is the number and name of the sequence used in that step.
  - To change the sequence of the selected step, use this field.
- **Rpts** is the number of times the sequence plays. Each step can play up to 999 times. To set the sequence to repeat indefinitely until you stop playback, set it to Hold (the lowest/minimum value).
  - To change the number of repetitions, use this field.
- **BPM** is the tempo of the sequence.
- **Bars** is the number of bars in the sequence (ignoring the number of repetitions).

**Clear** immediately erases all steps and sequences from the list.
- To clear the song, press F1/Clear.

**Convert** opens the Convert Song screen where you can export the song as a sequence within your project.
- To convert your song into a sequence, press F4/Convert. Use the fields in the Convert Song screen that appears:
  - **Sequence** is the sequence to which your song will be exported.
  - **Muted Tracks** determines if the exported song will include any tracks that are currently muted (INCLUDE MUTED TRACKS) or exclude them (IGNORE MUTED TRACKS).
  - **F4/Cancel** returns to the previous screen without exporting the song.
  - **F5/Do It** exports the song to the sequence and returns to the previous screen.

**Delete** immediately erases the currently selected sequence from the sequence playlist.
- To delete a step, press F5/Delete.

**Insert** creates a step in the sequence playlist immediately after the currently selected step.
- To insert a step, press F6/Insert.

Alternatively, “record” a song using the pads:

**Note**: The sequences or song will not play back as you use the pads to create your song in this way. Pressing the pads just enters their corresponding sequences as steps.

1. Press Rec or Overdub to “record-arm” the song.
2. Press the pad that corresponds to the first sequence you want to use. That sequence will appear in the sequence playlist as the first step.
3. Repeat Step 2 for each additional step you want to add to the sequence playlist. Press a pad multiple times to add to the number of times it plays.
4. Press Stop to stop “recording.”

**To render/export your song as an audio file**, use the Audio Mixdown screen in the software window. To see the user guide in the MPC software and learn how to do this, click the Help menu, select MPC Help, and select MPC User Manual.
Q-Link Edit Mode

Q-Link Edit Mode lets you determine what the Q-Link knobs control in other modes. This is helpful when you want to use the Q-Link knobs to control parameters that might not be shown in the current mode—or parameters that are shown across different modes.

To enter Q-Link Edit Mode, press **Shift + Prog Edit/Q-Link**.

These are the buttons under the screen:

**F1 Project**  
Press this button to select the **Project** Q-Link Edit mode. See the following **Project** section to learn about this.

**F2 Program**  
Press this button to select the **Program** Q-Link Edit mode. See the following **Program** section to learn about this.

**F3 Pad Scene**  
Press this button to select the **Pad Scene** Q-Link Edit mode. See the following **Pad Scene** section to learn about this.

**F4 Pad Param**  
Press this button to select the **Pad Parameter** Q-Link Edit mode. See the following **Pad Parameter** section to learn about this.

**F5 Screen**  
Press this button to select the **Screen** Q-Link Edit mode. See the following **Screen** section to learn about this.

**F6 Parameter/Value**  
Press this button to switch between viewing the parameter names (**Parameter**) and values (**Value**) in the screen.

While in Q-Link Edit Mode:

- **To adjust the settings shown on-screen**, turn the corresponding **Q-Link knobs**.
- **To select an edit mode for the Q-Link knobs**, press the corresponding button (**F1–F5**) under the screen. See **below** for more information.
- **To switch between viewing the parameter names and values in the screen**, press **F6/Parameter/Value**.
To select an edit mode for the Q-Link knobs, press the corresponding button (F1–F5) under the screen:

**Project:** In this edit mode, the Q-Link knobs can control 16 parameters within the current project overall. See the following *Project* section to learn about this specific Q-Link Edit Mode.

**Program:** In this edit mode, the Q-Link knobs can control 16 program or audio track parameters. See the following *Program* section to learn about this specific Q-Link Edit Mode.

**Pad Scene** (for drum programs only): In this edit mode, the Q-Link knobs can control 16 parameters for the currently selected pad. See the following *Pad Scene* section to learn about this specific Q-Link Edit Mode.

**Pad Parameter:** In this edit mode, the 16 Q-Link knobs correspond to the 16 pads, each one controlling the same parameter for each pad. This is useful if you need to adjust the same parameter on multiple pads at once rather than having to select and edit each pad individually. See the following *Pad Parameter* section to learn about this specific Q-Link Edit Mode.

**Screen:** In this edit mode, the Q-Link knobs will control a parameter or group of parameters in your currently selected mode (e.g., Main Mode, Sample Edit Mode, etc.).

---

**Project**

In the *Project* Q-Link Edit Mode, the Q-Link knobs control 16 parameters within the current project.

![Project Q-Link Edit Mode](image)

You can customize the parameters shown in this mode by using the *Q-Link Setup* section in MPC software window. To see the user guide in the MPC software and learn how to do this, click the *Help* menu, select *MPC Help*, and select *MPC User Manual*.

**Program**

In the *Program* Q-Link Edit Mode, the Q-Link knobs control 16 parameters within the currently selected program or audio track.

![Program Q-Link Edit Mode](image)

You can customize the parameters shown in this mode by using the *Q-Link Setup* section in MPC software window. To see the user guide in the MPC software and learn how to do this, click the *Help* menu, select *MPC Help*, and select *MPC User Manual*.
Pad Scene

In the **Pad Scene** Q-Link Edit Mode, the Q-Link knobs control your favorite 16 parameters for the currently selected pad. You can select another pad simply by pressing it, allowing you to adjust the same 16 parameters for that new pad. (These assignments are automatically saved with other user settings. Any project you load will use these assignments.)

<table>
<thead>
<tr>
<th>AMP E. ATTACK</th>
<th>AMP ENV DECAY</th>
<th>AMP E. SUSTAIN</th>
<th>AMP E. RELEASE</th>
</tr>
</thead>
<tbody>
<tr>
<td>FILTER CUTOFF</td>
<td>FILTER AMOUNT</td>
<td>SEND 1</td>
<td>SEND 2</td>
</tr>
<tr>
<td>SEND 3</td>
<td>SEND 4</td>
<td>LEVEL</td>
<td>PAN</td>
</tr>
<tr>
<td>PAD SOLO</td>
<td>PAD MUTE</td>
<td>Pad Scene</td>
<td>Pad Param</td>
</tr>
</tbody>
</table>

To select a pad, press it.

You can customize the parameters shown in this mode by using the **Q-Link Setup** section in MPC software window. To see the user guide in the MPC software and learn how to do this, click the **Help** menu, select **MPC Help**, and select **MPC User Manual**.

Pad Parameter

In the **Pad Parameter** Q-Link Edit Mode, the Q-Link knobs control the same pad parameter for each of the 16 pads in the current pad bank.

For example, if the **Parameter** is set to **Level**, the 16 Q-Link knobs will adjust the 16 independent **Level** settings for each pad in the current pad bank. You could then set the **Parameter** to **Pan** and use the Q-Link knobs to adjust the panning of all 16 pads.

**Tip:** Pressing **F6/Parameter/Value** to switch between viewing the parameter names (**Parameter**) and values (**Value**) in the screen is the most useful in this mode.

You can customize the parameters shown in this mode by using the **Q-Link Setup** section in MPC software window. To see the user guide in the MPC software and learn how to do this, click the **Help** menu, select **MPC Help**, and select **MPC User Manual**.
Screen

In the Screen Q-Link Edit Mode, the Q-Link knobs will control only the parameter or group of parameters in your currently selected mode (e.g., Main Mode, Sample Edit Mode, etc.).
MIDI Control Mode

You can use MIDI Control Mode on your MPC hardware to customize what MIDI messages each control sends. This custom “control map” will then work whenever you are in MIDI Control Mode. The edits you make in MIDI Control Mode will be retained with the current MPC project.

This is helpful when using MPC as a plugin: you can use MIDI Control Mode to use your MPC hardware to control your host software, and then switch back to any other mode to control the MPC plugin.

To enter MIDI Control Mode, press Shift+Song/Other.

**Important:** In your host software, make sure your MPC hardware is selected as a MIDI controller device.

<table>
<thead>
<tr>
<th>Control: Q-Link 4</th>
<th>Set All: On</th>
</tr>
</thead>
<tbody>
<tr>
<td>Light LED: Local</td>
<td>Low Range: 0</td>
</tr>
<tr>
<td>Midi Channel: 1</td>
<td>High Range: 127</td>
</tr>
<tr>
<td>CC Number: 103</td>
<td>Touch Sense: Off</td>
</tr>
<tr>
<td>Mode: Absolute</td>
<td>Touch Note: 3 [Eb-2]</td>
</tr>
</tbody>
</table>

Use the fields to set each control’s parameters to your preference. The available parameters depend on its type: a **pad**, or **button**, or a **Q-Link knob**. When you have set all of the parameters as desired, you can select another control or enter another mode.

These are the buttons under the screen:

- **F1** Prefs Press this button to show the Preferences screen. See General Features > Preferences to learn more.

To select a pad or button to edit, use the **Control** field, or press it on your MPC hardware.

To select a Q-Link knob to edit, use the **Control** field, or touch or turn it on your MPC hardware.

**Note:** The **Control** field may show many more hardware controls than are actually available on your MPC hardware. This is because the list includes all possible controls from all current MPC models (MPC Renaissance, MPC Studio, MPC Touch, etc.). You can edit only the controls that are described in this chapter.

**Note:** The MPC software window will also display a graphical interface resembling your MPC hardware. Editable controls show their current MIDI message. Pads and Q-Link knobs show their current MIDI channels.
These are the MIDI parameters you can edit for each pad:

**Control** is the hardware control you are currently editing (Pad 1–Pad 16).

**Set All** determines whether or not these settings will be applied across all pad banks.
- **On**: The pad’s messages and parameters will be identical across all eight banks.
- **Off**: The pad’s messages and parameters will apply to the current pad only.

**Light LED** determines how the pad’s LEDs will behave.
- **Never**: The LEDs will always be off.
- **MIDI Input**: The LEDs will light up when the software receives a MIDI message that matches the pad.
- **Local**: The LEDs will light up when you press the pad and/or MIDI input is received.

**Midi Channel** determines which MIDI channel (1–16) the pad will use to send its message to the software.

**Note** is the MIDI note number the pad will send to the software when you press it (0–127 or C-2 to G8).

**Velocity** determines whether the pad will be velocity-sensitive (On) or not (Off). When set to Off, pressing the pad will send a note at full-level (127) always.

**Aftertouch** determines how the pad’s aftertouch (pressure applied to the pad after the initial press) behaves.
- **Off**: The pad will not send any aftertouch messages.
- **Channel**: If you press multiple pads that have this setting, the aftertouch messages they send will be identical.
- **Poly**: If you press multiple pads, the aftertouch message each pad sends will be independent from the others.
Buttons

These are the MIDI parameters you can edit for each button.

**Control** is the hardware control you are currently editing (the button name).

**Light LED** determines how the button’s LED (or multiple LEDs) will behave.
- **Never**: The LEDs will always be off.
- **MIDI Input**: The LEDs will light up when the software receives a MIDI message that matches the button.
- **Local**: The LEDs will light up when you press the button and/or MIDI input is received.

**Midi Channel** determines which MIDI channel (1–16) the button will use to send its message to the software.

**CC Number** determines what MIDI control change number the button will send to the software.

**Type** determines whether the button will behave as a temporary switch (**Momentary**) or latching switch (**Toggle**).

**Set All** determines whether or not these settings will be applied across all buttons.
- **On**: The button’s messages and parameters will be identical across all buttons.
- **Off**: The button’s messages and parameters will apply to the current button only.
Q-Link Knobs

These are the MIDI parameters you can edit for each Q-Link knob:

- **Control** is the hardware control you are currently editing (Q-Link 1–16).
- **Light LED** determines how the Q-Link knobs LEDs will behave on an MPC Renaissance. This does not have a function on MPC Studio (whose Q-Link knobs do not have LEDs).
  - **Never**: The LEDs will always be off.
  - **MIDI Input**: The LEDs will light up when the software receives a MIDI message that matches the Q-Link knob.
  - **Local**: The LEDs will light up when you touch or turn the Q-Link knob and/or MIDI input is received.
- **Midi Channel** determines which MIDI channel (1–16) the Q-Link knob will use to send its message to the software.
- **CC Number** determines what MIDI control change number the Q-Link knob will send to the software.
- **Mode** determines how the Q-Link knob will control its parameter:
  - **Absolute**: The Q-Link knob’s current position determines its parameter’s value; moving it may cause its parameter to “snap” to a new position if you’re using it to control different parameters in different modes.
  - **Relative**: Moving the Q-Link knob will increase or decrease its parameter regardless of its physical position.
- **Set All** determines whether or not these settings will be applied across all Q-Link knobs.
  - **On**: The Q-Link knob’s messages and parameters will be identical across all Q-Link knobs.
  - **Off**: The Q-Link knob’s messages and parameters will apply to the current Q-Link knob only.
- **Low Range** is the Q-Link knob’s lowest possible value (0–127).
- **High Range** is the Q-Link knob’s highest possible value (0–127).
- **Touch Sense** activates or deactivates the Q-Link knob’s touch-capacitive circuitry.
  - **On**: You can touch the Q-Link knob to send a Note On message to the software (this is how your MPC hardware normally works).
  - **Off**: The Q-Link knob will not send any Note On messages; it will only send CC messages when you turn it.
- **Touch Note** is the MIDI note number the Q-Link knob will send to the software when you touch it (0–127 or C-2 to G8). **Touch Sense** must be set to **On** for this to work.
Pad Perform Mode

Pad Perform Mode lets you assign musical scales/modes, chords, or progressions to the pads for more creative performance.

To enter Pad Perform Mode, press Pad Assign while using a keygroup program, MIDI program, plugin program, or CV program. (Although you can enter Pad Perform Mode while using a drum program or clip program, it does not work with these programs.)

The screen will show the current pad bank's mapping of notes or chords. The pads are shown in a 4x4 array with the names of their assigned note or chord.

To play a note or chord, press it on your MPC hardware.

To shift the octave range of the pads down or up, press F5/Octave– or F6/Octave+ (respectively).

To transpose the pads down or up, press Shift+F5/Note– or Shift+F6/Note+ (respectively).

These are the buttons under the screen:

- **F1** Notes: Press this button to set Type to Notes.
- **F2** 1-3-5: Press this button to set Type to Chords and set Chord to 1-3-5 (major/minor).
- **F3** 1-3-5-7: Press this button to set Type to Chords and set Chord to 1-3-5-7 (major7/minor7).
- **F4** Progrsn: Press this button to set Type to Progressions.
- **F5** Octave–: Press this button to shift the pad assignments down an octave.
- **F6** Octave+: Press this button to shift the pad assignments up an octave.
- **Shift+F2** 1-4-5: Press these buttons to set Type to Chords and set Chord to 1-4-5 (sus4).
- **Shift+F3** 1-3-5-7b: Press these buttons to set Type to Chords and set Chord to 1-3-5-7b (dominant).
- **Shift+F5** Note–: Press these buttons to shift the pad assignments down a semitone, essentially lowering the Root Note field by a half-step.
- **Shift+F6** Note+: Press these buttons to shift the pad assignments up a semitone, essentially raising the Root Note field by a half-step.

Now is the time counter at the top of the screen, which shows the current playhead position. See General Features > Now & Locators to learn about this.
**Type** determines what will be mapped over the pads:

- **Chromatic**: Each pad is assigned a note, ascending by one semitone with each pad. Pads with notes in the key determined by the **Scale** will be lit, while pads with notes between the scale degrees will be unlit.
- **Notes**: Each pad is assigned a note, ascending by one scale degree with each pad.
- **Chords**: Each pad is assigned a chord, the root note ascending by one scale degree with each pad. All available chords will play in the key determined by the **Scale** field.
- **Chromatic Chords**: Each pad is assigned a chord, the root note ascending by one scale degree with each pad. You can play any chord type regardless of the key determined by the **Scale** field. Essentially, this is like the Chords setting but with more options to play chords out of the set key.
- **Progressions**: Each pad is assigned a chord in a chord progression. You can play the pads in (or out of) order to construct songs quickly. The available chords are determined by the **Chord** field.

### Type: Chromatic
- **Scale**: C Natural Minor
- **Chord**: Dorian
- **Banks**: Start on root

### Type: Notes
- **Scale**: C Major
- **Chord**: 1-3-5
- **Banks**: Start on root

### Type: Chords
- **Scale**: C Major
- **Chord**: 1-3-5
- **Banks**: Start on root

### Type: Chromatic Chords
- **Scale**: C Major
- **Chord**: Minor
- **Banks**: Start on root

### Type: Progressions
- **Scale**: C Major
- **Chord**: Classic Major
- **Banks**: Start on root
Scale determines the root note and the scale type.

Root Note (pitch and register): This is the starting point of the scale. The available notes are all chromatic notes across the range of the pads. The pad that’s assigned the root note will be lit differently (and highlighted on the screen) to indicate where the scale starts in each octave.

Scale Type: This is the scale or mode based on the root note (this is disabled when Type is set to Progressions). The available scales are:

<table>
<thead>
<tr>
<th>Major</th>
<th>Gypsy</th>
<th>Dorian</th>
</tr>
</thead>
<tbody>
<tr>
<td>Natural Minor</td>
<td>Hungarian Gypsy</td>
<td>Phrygian</td>
</tr>
<tr>
<td>Harmonic Minor</td>
<td>Persian</td>
<td>Lydian</td>
</tr>
<tr>
<td>Pentatonic Major</td>
<td>Major Bebop</td>
<td>Mixolydian</td>
</tr>
<tr>
<td>Pentatonic Minor</td>
<td>Whole Tone</td>
<td>Aeolian</td>
</tr>
<tr>
<td>Blues (minor)</td>
<td>Chromatic</td>
<td>Locrian</td>
</tr>
<tr>
<td>Flamenco</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Chord determines what chord type will play when pressing a pad. The chord will use those scale degrees based off of the pad’s root note. You can use this only when Type is set to Chords or Chromatic Chords.

When set to Chords, the available chords are:

- 1-3-5 (major/minor)
- 1-3-5-7 (major7/minor7)
- 1-4-5 (sus4)
- 1-3-5-7b (dominant)
- 1-2-5 (sus2)

When set to Chromatic Chords, the available chords are:

<table>
<thead>
<tr>
<th>Major</th>
<th>Major7</th>
<th>Augmented</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minor</td>
<td>Minor7</td>
<td>Diminished</td>
</tr>
<tr>
<td>Sus2</td>
<td>Major9</td>
<td></td>
</tr>
<tr>
<td>Sus4</td>
<td>Minor9</td>
<td></td>
</tr>
</tbody>
</table>

Banks determines how the notes are mapped across the pad banks:

- **Continuous:** Pad 1 of one bank is always one scale degree higher than Pad 16 of the previous bank.
- **Start on Root:** Pad 1 will always be the root note of the scale in every pad bank.
Appendix

Effects & Parameters

This chapter lists the available effects. To learn more about how effects work with MPC, please see General Features > Effects.

Note: Some of these effects have a "sync" version (e.g., Flanger Sync, Autopan Sync, etc.) whose rates will be affected by the current tempo. While viewing the rate of these effects, a "." next to the time division indicates a triplet-based rate.

Reverbs

Options: Reverb Small, Reverb Medium, Reverb Large, Reverb Large 2, Reverb In Gate, Reverb Out Gate

Reverb Small

This is a spatial effect, designed to emulate a small room.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Pre-Delay</td>
<td>1–100</td>
<td>50</td>
</tr>
<tr>
<td>Early Reflection</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Density</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Diffuse</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Decay</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Lo-Cut</td>
<td>0–100</td>
<td>15</td>
</tr>
<tr>
<td>Hi-Cut</td>
<td>0–100</td>
<td>10</td>
</tr>
</tbody>
</table>

Reverb Medium

This is a spatial effect, designed to emulate a medium room.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Pre-Delay</td>
<td>1–100</td>
<td>50</td>
</tr>
<tr>
<td>Early Reflection</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Density</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Diffuse</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Decay</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Lo-Cut</td>
<td>0–100</td>
<td>15</td>
</tr>
<tr>
<td>Hi-Cut</td>
<td>0–100</td>
<td>10</td>
</tr>
</tbody>
</table>
Reverb Large
This is a spatial effect, designed to emulate the sound of a large hall.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Pre-Delay</td>
<td>1–100</td>
<td>50</td>
</tr>
<tr>
<td>Early Reflection</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Density</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Diffuse</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Decay</td>
<td>0–100</td>
<td>75</td>
</tr>
<tr>
<td>Lo-Cut</td>
<td>0–100</td>
<td>10</td>
</tr>
<tr>
<td>Hi-Cut</td>
<td>0–100</td>
<td>10</td>
</tr>
</tbody>
</table>

Reverb Large 2
This is a less CPU-intensive spatial effect, emulating the sound of a large hall.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Pre-Delay</td>
<td>1–100</td>
<td>50</td>
</tr>
<tr>
<td>Early Reflection</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Density</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Diffuse</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Decay</td>
<td>0–100</td>
<td>75</td>
</tr>
<tr>
<td>Lo-Cut</td>
<td>0–100</td>
<td>10</td>
</tr>
<tr>
<td>Hi-Cut</td>
<td>0–100</td>
<td>10</td>
</tr>
</tbody>
</table>

Reverb In Gate
This is a hall reverb with an additional control. The reverb effect is cut off when the input drops below the level set in the Gate In parameter.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Pre-Delay</td>
<td>1–100</td>
<td>50</td>
</tr>
<tr>
<td>Early Reflection</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Density</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Diffuse</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Decay</td>
<td>0–100</td>
<td>75</td>
</tr>
<tr>
<td>Lo-Cut</td>
<td>0–100</td>
<td>10</td>
</tr>
<tr>
<td>Hi-Cut</td>
<td>0–100</td>
<td>10</td>
</tr>
<tr>
<td>Gate In</td>
<td>0–100</td>
<td>0</td>
</tr>
</tbody>
</table>
Reverb Out Gate

This is a hall reverb that has an additional control. The reverb effect is cut off when the output drops below the level set in the Gate Out parameter.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Pre-Delay</td>
<td>1–100</td>
<td>50</td>
</tr>
<tr>
<td>Early Reflection</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Density</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Diffuse</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Decay</td>
<td>0–100</td>
<td>75</td>
</tr>
<tr>
<td>Lo-Cut</td>
<td>0–100</td>
<td>10</td>
</tr>
<tr>
<td>Hi-Cut</td>
<td>0–100</td>
<td>10</td>
</tr>
<tr>
<td>Gate Out</td>
<td>0–100</td>
<td>0</td>
</tr>
</tbody>
</table>

Delays

Delays the original signal for a specified period of time and plays it back over an adjustable period of time.

Options: Delay Mono, Delay Mono Sync, Delay Stereo, Delay Sync (Stereo), Delay LP, Delay HP, Delay Analog, Delay Analog Sync, Delay Tape Sync, Delay Ping Pong, Delay Multi-Tap

Delay Mono

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Time</td>
<td>2–2000 ms</td>
<td>100</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>25</td>
</tr>
<tr>
<td>Damping</td>
<td>0–100</td>
<td>100</td>
</tr>
</tbody>
</table>

Delay Mono Sync

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Time</td>
<td>1 bar – 1/16 triplets</td>
<td>1/4</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Damping</td>
<td>0–100</td>
<td>100</td>
</tr>
</tbody>
</table>
Delay Stereo
Stereo Delay operates similarly to Mono Delay but in true stereo.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Time</td>
<td>2–2000 ms</td>
<td>100</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>25</td>
</tr>
<tr>
<td>Damping</td>
<td>0–100</td>
<td>100</td>
</tr>
</tbody>
</table>

Delay Sync (Stereo)
Stereo Delay operates similarly to Mono Delay but in true stereo.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Time</td>
<td>1 bar – 1/16 triplets</td>
<td>1/4</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Damping</td>
<td>0–100</td>
<td>100</td>
</tr>
</tbody>
</table>

Delay LP
LP Delay is identical to the Mono Delay, but it uses a resonant low-pass filter in the delay line.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Time</td>
<td>2–2000 ms</td>
<td>500</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Cutoff</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>20</td>
</tr>
</tbody>
</table>

Delay HP
HP Delay is identical to the Mono Delay, but it uses a resonant high-pass filter in the delay line.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Time</td>
<td>2–2000 ms</td>
<td>100</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Cutoff</td>
<td>0–100</td>
<td>33</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>33</td>
</tr>
</tbody>
</table>
Delay Analog

Analog Delay is similar to the Mono Delay, except that it’s designed to emulate an analog “Bucket Brigade”-style delay. This delay has a unique character to it that gives a warmer sound by adding subtle inaccuracies in phase and timing.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Time</td>
<td>2–2000 ms</td>
<td>100</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>25</td>
</tr>
</tbody>
</table>

Delay Analog Sync

Analog Delay is similar to Mono Delay, except that it’s designed to emulate an analog “Bucket Brigade”-style delay. This delay has a unique character to it that gives a warmer sound by adding subtle inaccuracies in phase and timing.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Time</td>
<td>1 bar – 1/16 triplets</td>
<td>1/4</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Ramp</td>
<td>0–100</td>
<td>50</td>
</tr>
</tbody>
</table>

Delay Tape Sync

Tape Delay emulates a delay system using an analog tape loop and a series of tape heads to produce an echo effect. This delay type yields a very distinct echo sound often heard in reggae and dub-style music.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Time</td>
<td>1 bar – 1/16 triplets</td>
<td>1/4</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Head 1</td>
<td>0–100</td>
<td>100</td>
</tr>
<tr>
<td>Head 2</td>
<td>0–100</td>
<td>0</td>
</tr>
<tr>
<td>Head 3</td>
<td>0–100</td>
<td>0</td>
</tr>
<tr>
<td>Head 4</td>
<td>0–100</td>
<td>0</td>
</tr>
<tr>
<td>Tone</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Spread</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Wow &amp; Flutter</td>
<td>0–100</td>
<td>50</td>
</tr>
</tbody>
</table>

Delay Ping Pong

This stereo delay allows you to set different delay times for its left and right repeats.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Time, Left</td>
<td>2–2000 ms</td>
<td>100</td>
</tr>
<tr>
<td>Time, Right</td>
<td>2–2000 ms</td>
<td>100</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>25</td>
</tr>
<tr>
<td>Damping</td>
<td>0–100</td>
<td>100</td>
</tr>
</tbody>
</table>
Delay Multi-Tap

This delay is a mono delay which has three delay generators with independently adjustable delay times and stereo position.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Time 1</td>
<td>2–2000 ms</td>
<td>100</td>
</tr>
<tr>
<td>Time 2</td>
<td>2–2000 ms</td>
<td>100</td>
</tr>
<tr>
<td>Time 3</td>
<td>2–2000 ms</td>
<td>100</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>25</td>
</tr>
<tr>
<td>Pan 1</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Pan 2</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Pan 3</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Damping</td>
<td>0–100</td>
<td>100</td>
</tr>
<tr>
<td>Gain 1</td>
<td>0–100</td>
<td>25</td>
</tr>
<tr>
<td>Gain 2</td>
<td>0–100</td>
<td>25</td>
</tr>
<tr>
<td>Gain 3</td>
<td>0–100</td>
<td>25</td>
</tr>
</tbody>
</table>

Flangers

A flanger is a modulated delay to emulate the sound created when running two analog tape machines in parallel with a slight time misalignment. Slow Rate settings can produce a “whooshing” jet engine sound, while faster rates result in more of a “warble.”

Options: Flanger, Flanger Sync

Flanger

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Rate</td>
<td>0–100</td>
<td>10</td>
</tr>
<tr>
<td>Feedback</td>
<td>-100 – 100</td>
<td>0</td>
</tr>
<tr>
<td>Delay</td>
<td>0–100</td>
<td>20</td>
</tr>
<tr>
<td>Width</td>
<td>0–100</td>
<td>80</td>
</tr>
</tbody>
</table>

Flanger Sync

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Rate</td>
<td>8 bars – 1/16 triplets</td>
<td>1/4</td>
</tr>
<tr>
<td>Feedback</td>
<td>-100 – 100</td>
<td>0</td>
</tr>
<tr>
<td>Delay</td>
<td>0–100</td>
<td>20</td>
</tr>
<tr>
<td>Width</td>
<td>0–100</td>
<td>80</td>
</tr>
</tbody>
</table>
Choruses

A chorus effect uses an LFO to modulate the pitch and a delay of the input signal, which are then added to the dry signal. In small amounts, this creates the illusion of multiple voices playing at once. Turn up the Feedback and Depth for more pronounced “shimmering” and “watery” sounds.

Options: Chorus 2-Voice, Chorus 4-Voice

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Delay</td>
<td>0–100</td>
<td>20</td>
</tr>
<tr>
<td>Amount</td>
<td>0–100</td>
<td>80</td>
</tr>
<tr>
<td>Width</td>
<td>0–100</td>
<td>80</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Rate</td>
<td>0–100</td>
<td>10</td>
</tr>
</tbody>
</table>

Chorus 4-Voice

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Delay</td>
<td>0–100</td>
<td>20</td>
</tr>
<tr>
<td>Amount</td>
<td>0–100</td>
<td>80</td>
</tr>
<tr>
<td>Width</td>
<td>0–100</td>
<td>80</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Rate</td>
<td>0–100</td>
<td>10</td>
</tr>
</tbody>
</table>

Autopans

This effect uses an LFO to move the incoming signal back and forth across the stereo field, creating a rotary effect.

Options: Autopan, Autopan Sync

Autopan

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Rate</td>
<td>0–100</td>
<td>10</td>
</tr>
</tbody>
</table>

Autopan Sync

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Rate</td>
<td>8 bars – 1/32</td>
<td>1/4</td>
</tr>
</tbody>
</table>
Tremolos

This effect uses an LFO to increase and decrease the volume of the signal. Depending on the LFO shape, this can produce a smooth wave effect (sine wave) or a stuttering “on-off” effect (square wave).

Options: *Tremolo, Tremolo Sync*

<table>
<thead>
<tr>
<th>Tremolo</th>
<th>Parameter Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Rate</td>
<td>0–100</td>
<td>10</td>
</tr>
<tr>
<td>Sine to Square</td>
<td>0–100 (sine–square)</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tremolo Sync</th>
<th>Parameter Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Rate</td>
<td>1 bar – 1/16 triplets</td>
<td>1/4</td>
</tr>
<tr>
<td>Sine to Square</td>
<td>0–100 (sine–square)</td>
<td>0</td>
</tr>
</tbody>
</table>

Phasers

The classic phaser effect created by multiple ganged all-pass filters to create “notches,” or sharp spikes, in the frequency spectrum. The frequencies of these all-pass filters are usually modulated by an LFO to create a sweeping sound.

Options: *Phaser 1, Phaser 2, Phaser Sync*

<table>
<thead>
<tr>
<th>Phaser 1</th>
<th>Parameter Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Rate</td>
<td>0–100</td>
<td>10</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Phaser 2</th>
<th>Parameter Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Rate</td>
<td>0–100</td>
<td>10</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Phaser Sync</th>
<th>Parameter Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Rate</td>
<td>1 bar – 1/16 triplets</td>
<td>1/4</td>
</tr>
</tbody>
</table>
HP (High-Pass) Filters

Options: HP Filter, HP Filter Sweep, HP Filter Sync, HP Shelving Filter

HP Filter
This effect is a static filter without modulation.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>10–19999 Hz</td>
<td>1500</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>0</td>
</tr>
</tbody>
</table>

HP Filter Sweep
This effect is a high-pass filter with its cutoff frequency modulated by an LFO.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>80</td>
</tr>
<tr>
<td>Low Frequency</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>High Frequency</td>
<td>0–100</td>
<td>100</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>33</td>
</tr>
<tr>
<td>Rate</td>
<td>0–100</td>
<td>10</td>
</tr>
</tbody>
</table>

HP Filter Sync
This effect is a high-pass filter with its cutoff frequency modulated by an LFO.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Low Frequency</td>
<td>0–100</td>
<td>0</td>
</tr>
<tr>
<td>High Frequency</td>
<td>0–100</td>
<td>100</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Rate</td>
<td>8 bars – 1/32</td>
<td>1/4</td>
</tr>
</tbody>
</table>

HP Shelving Filter
This filter differs from the standard filter type, as it attenuates all frequencies after the cutoff point equally.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>10–19999 Hz</td>
<td>1500</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>0</td>
</tr>
<tr>
<td>Gain</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
</tr>
</tbody>
</table>
LP (Low-Pass) Filters

Options: LP Filter, LP Filter Sweep, LP Filter Sync, LP Shelving Filter

LP Filter
This effect is a static filter without modulation.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>10–19999 Hz</td>
<td>1500</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>0</td>
</tr>
</tbody>
</table>

LP Filter Sweep
This effect is a low-pass filter with its cutoff frequency modulated by an LFO.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>80</td>
</tr>
<tr>
<td>Low Frequency</td>
<td>0–100</td>
<td>0</td>
</tr>
<tr>
<td>High Frequency</td>
<td>0–100</td>
<td>100</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>33</td>
</tr>
<tr>
<td>Rate</td>
<td>0–100</td>
<td>10</td>
</tr>
</tbody>
</table>

LP Filter Sync
This effect is a low-pass filter with its cutoff frequency modulated by an LFO.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Low Frequency</td>
<td>0–100</td>
<td>0</td>
</tr>
<tr>
<td>High Frequency</td>
<td>0–100</td>
<td>100</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Rate</td>
<td>8 bars – 1/32</td>
<td>1/4</td>
</tr>
</tbody>
</table>

LP Shelving Filter
This filter differs from the standard filter type, as it attenuates all frequencies after the cutoff point equally.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>10–19999 Hz</td>
<td>1500</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>0</td>
</tr>
<tr>
<td>Gain</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
</tr>
</tbody>
</table>
Options: **PEQ 2-Band, 2-Shelf, PEQ 4-Band**

### PEQ 2-Band, 2-Shelf
This effect is a combination of one two-band parametric equalizer and two shelving filters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low Frequency</td>
<td>22–1000 Hz</td>
<td>220</td>
</tr>
<tr>
<td>Frequency 1</td>
<td>82–3900 Hz</td>
<td>820</td>
</tr>
<tr>
<td>Frequency 2</td>
<td>220–10000 Hz</td>
<td>2200</td>
</tr>
<tr>
<td>High Frequency</td>
<td>560–19999 Hz</td>
<td>5600</td>
</tr>
<tr>
<td>Q1</td>
<td>0–100</td>
<td>0</td>
</tr>
<tr>
<td>Q2</td>
<td>0–100</td>
<td>0</td>
</tr>
<tr>
<td>Low Gain</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
</tr>
<tr>
<td>Gain 1</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
</tr>
<tr>
<td>Gain 2</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
</tr>
<tr>
<td>High Gain</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
</tr>
</tbody>
</table>

### PEQ 4-Band
This effect is a powerful four-band parametric equalizer with four independent EQ ranges.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low Frequency</td>
<td>22–1000 Hz</td>
<td>220</td>
</tr>
<tr>
<td>Frequency 1</td>
<td>82–3900 Hz</td>
<td>820</td>
</tr>
<tr>
<td>Frequency 2</td>
<td>220–10000 Hz</td>
<td>2200</td>
</tr>
<tr>
<td>High Frequency</td>
<td>560–19999 Hz</td>
<td>5600</td>
</tr>
<tr>
<td>Q1</td>
<td>0–100</td>
<td>5</td>
</tr>
<tr>
<td>Q2</td>
<td>0–100</td>
<td>5</td>
</tr>
<tr>
<td>Q3</td>
<td>0–100</td>
<td>5</td>
</tr>
<tr>
<td>Q4</td>
<td>0–100</td>
<td>5</td>
</tr>
<tr>
<td>Gain 1</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
</tr>
<tr>
<td>Gain 2</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
</tr>
<tr>
<td>Gain 3</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
</tr>
<tr>
<td>Gain 4</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
</tr>
</tbody>
</table>
Distortions

Options: Distortion Amp, Distortion Fuzz, Distortion Grimey, Distortion Overdrive, Distortion Custom

Distortion Amp

This effect is designed to reproduce the sound of a tube amplifier at high volumes.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Drive</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Tone</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Dynamics</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Output</td>
<td>0–100</td>
<td>50</td>
</tr>
</tbody>
</table>

Distortion Fuzz

This popular effect uses hard clipping of the audio signal, which, at extreme settings, can turn a standard waveform into a square wave, producing a “razor” effect.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Drive</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Output</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Low</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Low-Mid</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>High-Mid</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>High</td>
<td>0–100</td>
<td>50</td>
</tr>
</tbody>
</table>

Distortion Grimey

This is a unique distortion effect that distorts a frequency range in a selectable band.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Drive</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Grime</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Center</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Width</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Output</td>
<td>0–100</td>
<td>50</td>
</tr>
</tbody>
</table>

Distortion Overdrive

This distortion is designed to sound like a mildly distorting amplifier at medium volumes. It is the smoothest distortion type available.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Drive</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Tone</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Output</td>
<td>0–100</td>
<td>50</td>
</tr>
</tbody>
</table>
Distortion Custom

This effect is a highly customized distortion, capable of a wide range of useable sounds.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Drive</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>+Soft</td>
<td>5–75</td>
<td>2</td>
</tr>
<tr>
<td>+Clip</td>
<td>5–50</td>
<td>25</td>
</tr>
<tr>
<td>–Soft</td>
<td>5–75</td>
<td>2</td>
</tr>
<tr>
<td>–Clip</td>
<td>5–50</td>
<td>25</td>
</tr>
<tr>
<td>Low</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
</tr>
<tr>
<td>Mid</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
</tr>
<tr>
<td>High</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
</tr>
<tr>
<td>Output</td>
<td>-18.0 – 18.0 dB</td>
<td>50</td>
</tr>
</tbody>
</table>

Compressors

A compressor is an effect that changes the dynamic range of a signal by automatically reducing its gain.

Options: Compressor Master, Compressor Opto, Compressor VCA, Compressor Vintage

Compressor Master

This is the most transparent compressor, able to perform substantial volume adjustments without artifacts.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Attack</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Release</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Threshold</td>
<td>-50 – 0 dB</td>
<td>0</td>
</tr>
<tr>
<td>Ratio</td>
<td>1–20</td>
<td>1</td>
</tr>
<tr>
<td>Oldskool</td>
<td>Off, On</td>
<td>Off</td>
</tr>
<tr>
<td>Output</td>
<td>-6 – 24 dB</td>
<td>0</td>
</tr>
</tbody>
</table>

Compressor Opto

The Opto Compressor is modeled after a vintage compressor type using an optical circuit to control the volume reduction of the input signal. These compressors are usually associated with soft and unobtrusive attack and release characteristics.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Input</td>
<td>-6 – 18 dB</td>
<td>0</td>
</tr>
<tr>
<td>Attack</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Release</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Threshold</td>
<td>-50 – 0 dB</td>
<td>0</td>
</tr>
<tr>
<td>Ratio</td>
<td>1–20</td>
<td>1</td>
</tr>
<tr>
<td>Knee</td>
<td>1–100</td>
<td>1</td>
</tr>
<tr>
<td>Output</td>
<td>-6 – 24 dB</td>
<td>0</td>
</tr>
</tbody>
</table>
Compressor VCA

This compressor is more modern-sounding, with a slightly more transparent sound. A VCA Compressor tends to have quicker attack and release times than an Opto Compressor.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Input</td>
<td>-6 – 18 dB</td>
<td>0</td>
</tr>
<tr>
<td>Attack</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Release</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Threshold</td>
<td>-50 – 0 dB</td>
<td>0</td>
</tr>
<tr>
<td>Ratio</td>
<td>1–20</td>
<td>1</td>
</tr>
<tr>
<td>Knee</td>
<td>1–100</td>
<td>1</td>
</tr>
<tr>
<td>Output</td>
<td>-6 – 24 dB</td>
<td>0</td>
</tr>
</tbody>
</table>

Compressor Vintage

This compressor has a sound similar to classic tube compressors, with their gentle yet pumping response and a dash of tube saturation.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Input</td>
<td>-6 – 18 dB</td>
<td>0</td>
</tr>
<tr>
<td>Attack</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Release</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Threshold</td>
<td>-50 – 0 dB</td>
<td>0</td>
</tr>
<tr>
<td>Ratio</td>
<td>1–20</td>
<td>1</td>
</tr>
<tr>
<td>Knee</td>
<td>1–100</td>
<td>1</td>
</tr>
<tr>
<td>Output</td>
<td>-6 – 24 dB</td>
<td>0</td>
</tr>
</tbody>
</table>

Bit Reducers

Options: Decimator, Resampler

Decimator

Decimator down-samples the incoming signal by removing bits from the digital signal. The difference between decimation and resampling is that Decimator does not use any filtering to mask or correct digital artifacts. The result is an effect ranging from mild to almost completely pure digital distortion, depending on the setting and the source material.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Decimate</td>
<td>0–100</td>
<td>0</td>
</tr>
<tr>
<td>Bit Reducer</td>
<td>4–32</td>
<td>32</td>
</tr>
</tbody>
</table>

Resampler

Resampler is similar to Decimator in that it removes bits from an incoming signal. The difference is that Resampler applies a complex suite of filters and anti-aliasing to attempt to retain the original sound quality. This is a method used by popular vintage samplers and sampling drum machines from the 1980s. Resampler can be used to achieve a “dirty” sound on drum loops, without the harshness of distortion.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Rate</td>
<td>0–100</td>
<td>0</td>
</tr>
<tr>
<td>Decimate</td>
<td>0–100</td>
<td>0</td>
</tr>
</tbody>
</table>
Other

Options: Auto Wah, Frequency Shifter, Transient Shaper

Auto Wah
This effect is a low-pass filter modulated by an envelope that yields a classic funky “wah-wah”-like sound. The envelope is triggered by the incoming signal’s amplitude. The amount of the envelope on the cutoff frequency is user-definable.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>75</td>
</tr>
<tr>
<td>Attack</td>
<td>0–100</td>
<td>30</td>
</tr>
<tr>
<td>Release</td>
<td>0–100</td>
<td>30</td>
</tr>
<tr>
<td>Center</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Sensitivity</td>
<td>0–100</td>
<td>50</td>
</tr>
</tbody>
</table>

Frequency Shifter
A frequency shifter changes the frequencies of an input signal by a fixed amount and alters the relationship of the original harmonics. This can produce a chorus-like effect as well as very crazy artificial timbres.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Frequency</td>
<td>-1000 – 1000</td>
<td>0</td>
</tr>
<tr>
<td>Asynchrony</td>
<td>0–1000</td>
<td>0</td>
</tr>
<tr>
<td>A Pan</td>
<td>0–100</td>
<td>0</td>
</tr>
<tr>
<td>B Pan</td>
<td>0–100</td>
<td>100</td>
</tr>
<tr>
<td>A Gain</td>
<td>0–100</td>
<td>75</td>
</tr>
<tr>
<td>B Gain</td>
<td>0–100</td>
<td>75</td>
</tr>
</tbody>
</table>

Transient Shaper
A transient shaper can be used to enhance or soften the Attack and Release phases of audio material.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Attack</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Release</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Output</td>
<td>0–100</td>
<td>50</td>
</tr>
</tbody>
</table>
Glossary

This glossary briefly defines and explains many of the technical terms used throughout this manual.

**Aftertouch**
The majority of contemporary keyboards are capable of generating aftertouch messages. On this type of keyboard, when you press harder on a key you are already holding down, a MIDI aftertouch message is generated. This feature makes sounds even more expressive (e.g., through vibrato).

**Aliasing**
Aliasing is an audible side effect arising in digital systems as soon as a signal contains harmonics higher than half the sampling frequency.

**Amount**
Describes to which extent a modulation source influences a given parameter.

**Amplifier**
An amplifier is a component that influences the volume level of a sound via a control signal. It can be modulated by a control signal (e.g., generated by an envelope or an LFO).

**Attack**
An envelope parameter. This term describes the ascent rate of a time-relevant process (e.g., an envelope from its starting point to the point where it reaches its highest value). The attack phase is initiated immediately after a trigger signal is received (e.g., after you play a note on a trigger pad or a keyboard).

**Bit Rate**
Bit rate (also known as word length), is the number of bits used to store the level information of each single sample slice within a whole sample. The higher the bit rate, the more precise the information about a sample (i.e., its dynamics’ resolution). Normal audio CDs are 16-bit. The MPC hardware supports full 24-bit resolution.

**Bounce**
When you “bounce” a sequence, track, or program, you are rendering that part of your project as an audio file (as opposed to a MIDI file). The MPC hardware lets you bounce sequences, tracks, or programs as samples (saved to your project’s sample pool) or as full audio tracks (saved to your project’s sample pool and added directly to the current sequence).

Bouncing a track will render that track after it is sent through its program. Bouncing a program will render all tracks that use that program after they are sent through it. Bouncing a sequence will render all tracks in that sequence after they are sent through their respective programs.

**Clipping**
Clipping is a sort of distortion that occurs when a signal exceeds the maximum value that can be handled by a signal processing system it is fed into. The curve of a clipped signal is dependent on the system where the clipping occurs. In the analog domain, clipping effectively limits the signal to a given maximum level. In the digital domain, clipping is similar to a numerical overflow, resulting in negative polarity of the signal’s portions exceeding the maximum level.

**Control Change**
(MIDI messages enable you to manipulate the behavior of a sound generator to a significant degree. This message essentially consists of two components:

- The controller number, which determines the parameter to be influenced. It can range from 0 to 127.
- The controller value, which determines the extent of the modification.

Controllers can be used for effects such as slowly swelling vibrato, changing the stereo panning position and influencing filter frequency.

**Cutoff**
The cutoff frequency is a significant factor for a filter. A low-pass filter for example dampens the portion of the signal that lies above this frequency. Frequencies below this value are allowed to pass through without being processed.
CV stands for **control voltage**, an analog method of sending control messages to external synthesizers, drum machines, etc. CV messages are typically used in conjunction with **Gate** messages (CV messages determine the pitch of notes while Gate messages determine note activation and length). CV messages are sent from the CV out ports of your MPC hardware and to the CV in ports of your external MIDI device.

Please note that each external MIDI device uses a specific control voltage range, which determines how many volts are used in each octave (e.g., 1V/oct). Be mindful of this when setting it up with the MPC software and/or controller hardware—mismatched voltage ranges can produce unusual/undesirable “re-scaling” of the octaves.

**Decay**

Decay describes the descent rate of an **envelope** once the attack phase has reached its maximum and the envelope drops to the level defined by the sustain value.

**Envelope**

An envelope is used to modulate a sound-shaping component within a given time. For instance, an envelope that modulates the cutoff frequency of a filter opens and closes this filter over a period of time. An envelope is started via a trigger, usually a MIDI note.

The classic **ADSR** envelope consists of four individually variable phases: attack, decay, sustain, and release. Attack, decay and release are time or slope values, while sustain is an adjustable level. Once an incoming trigger is received, the envelope runs through the attack and decay phases until it reaches the programmed sustain level. This level remains constant until the trigger is terminated. The envelope then initiates the release phase until it reaches the minimum value.

You can see and read about the envelopes used in MPC Studio in **Operation > Modes > Program Edit Mode > Anatomy of an Envelope**.

**Filter**

A filter is a component that allows some of a signal’s frequencies to pass through it and dampens other frequencies. The most important aspect of a filter is the filter cutoff frequency. Filters generally come in four categories: **low-pass**, **high-pass**, **band-pass**, and **band-stop**.

These are the available filters:

- A **low-pass** filter (the most common type) dampens all frequencies above the cutoff frequency.
- A **high-pass** filter in turn dampens the frequencies below the cutoff.
- A **band-pass** filter allows only those frequencies around the cutoff frequency to pass. All others are dampened.
- A **band-stop** filter does the opposite of a band-pass: it dampens only the frequencies around the cutoff frequency.

A **band-boost** filter boosts the frequencies around the cutoff frequency, similar to what a band on an equalizer would do. All other frequencies pass through normally.

The number of **poles** in a filter’s “slope” determines how extreme or subtle the effect of the filter will be. Filters with one or two poles produce a subtler sound while filters with six or eight poles are much more pronounced.

The **Model** filters are analog-style emulations of famous vintage synth filters. **Model1** is a four-pole filter that distorts at high input levels. **Model2** uses a mellow resonance with a “fattening” distortion in the lower frequencies. **Model3** can produce howling, piercing resonances and extreme sub frequencies—watch your speakers!

The **Vocal** filters are formant filters that emulate the human voice. **Vocal1** produces “ah” and “ooh” vowel sounds. **Vocal2** uses three bands to produce “oh” and “ee” vowel sounds. **Vocal3** uses five bands to emulate an idealized model of the vocal tract.

**MPC3000 LPF** is a dynamic, resonant low-pass filter (12 dB/oct) that was used on the original MPC3000, released in 1994.

Please also see the entry for **Resonance**, an essential characteristic of a filter’s sound.

**Gate**

Gate messages are analog messages sent to external synthesizers, drum machines, etc. Gate messages are typically used in conjunction with **CV** messages (CV messages determine the pitch of notes while Gate messages determine note activation and length). Gate messages are sent from the CV out ports of your MPC hardware and to the CV/Gate in ports of your external MIDI device.
LFO

LFO is an acronym for **low-frequency oscillator**. The LFO generates a periodic oscillation at a low frequency and features variable waveshapes. Similar to an envelope, an LFO can be used to modulate a sound-shaping component.

MIDI

MIDI stands for **musical instrument digital interface**. Developed in the early 1980s, MIDI enables interaction between various types of electronic music instruments from different manufacturers. At the time a communications standard for heterogeneous devices did not exist, so MIDI was a significant advance. It made it possible to link various devices with one another through simple, standardized connectors.

Essentially, this is how MIDI works: One sender is connected to one or several receivers. For instance, if you want to use a computer to play a MIDI synthesizer, the computer is the sender and the synthesizer acts as the receiver. With a few exceptions, the majority of MIDI devices are equipped with two or three ports for this purpose: MIDI In, MIDI Out and in some cases MIDI Thru. The sender transfers data to the receiver via the MIDI Out jack. Data are sent via a cable to the receiver’s MIDI In jack.

MIDI Thru has a special function. It allows the sender to transmit to several receivers. It routes the incoming signal to the next device without modifying it. Another device is simply connected to this jack, thus creating a chain through which the sender can address a number of receivers. Of course, it is desirable for the sender to be able to address each device individually. To achieve this, a MIDI channel message is sent with each MIDI event.

MIDI Channel

This is a very important element of most messages. A receiver can only respond to incoming messages if its receive channel is set to the same channel as the one the sender is using to transmit data. Subsequently, the sender can address specific receivers individually. MIDI Channels 1–16 are available for this purpose.

MIDI Clock

The MIDI clock message transmits real-time tempo information to synchronize processes among several connected devices (e.g., a sound generator’s delay time to a MIDI sequencer).

Modulation

A modulation influences or changes a sound-shaping component via a modulation source. Modulation sources include envelopes, LFOs or MIDI messages. The modulation destination is a sound-shaping component such as a filter or a VCA.

Note On & Note Off

This is the most important MIDI message. It determines the pitch and velocity of a generated note. A note-on message will start a note. Its pitch is derived from the note number, which can range from 0 to 127. The velocity ranges from 1 to 127. A velocity value of 0 is equivalent to a note-off message.

Normalize

Normalization is a function to raise the level of a sample to its maximum (0 dB) without causing distortion. This function automatically searches a sample for its maximum level and consequently raises the entire sample’s level until the previously determined maximum level reaches 0 dB. In general, this results in a higher overall volume of the sample.

Panning

The process or the result of changing a signal’s position within the stereo panorama.

Pitch-Bend

Pitch-bend is a MIDI message. Although pitch-bend messages are similar in function to control change messages, they are a distinct type of message. The resolution of a pitch-bend message is substantially higher than that of a conventional controller message. The human ear is exceptionally sensitive to deviations in pitch, so the higher resolution is used because it relays pitch-bend information more accurately.
Program

A program is a file that contains a list of all samples to be used, and settings for each sample (e.g., pad assignments, loop points, pitch tuning, effects, etc.) Program Edit Mode is where you can edit and assign samples (read more about this in Operation > Modes > Program Edit Mode). You can have a total of 128 programs in a project.

There are three kinds of programs that use samples for their sound source. Drum programs are mostly used for creating drum programs and easy and quick assigning of samples to a pad. With keygroup programs, you can use one sample (or more) and spread it across two or more keys and play the sample chromatically over a keyboard. That way, there is no need to sample every key of, for instance, a piano. Clip programs use several samples that can be looped (clips), each of which can assigned to a pad; launching different combinations of clips together lets you create intriguing, layered performances.

Program Change

These are MIDI messages that select sound programs. Programs 1–128 can be changed via program change messages.

Release

An envelope parameter. This term describes the descent rate of an envelope to its minimum value after a trigger is terminated. The release phase begins immediately after the trigger is terminated, regardless of the envelope’s current status. For instance, the release phase may be initiated during the attack phase.

Resonance

Resonance or emphasis is an important filter parameter. It emphasizes the frequencies around the filter cutoff frequency by amplifying them with a narrow bandwidth. This is one of the most popular methods of manipulating sounds. If you increase the emphasis to a level where the filter enters a state of self-oscillation, it will generate a relatively pure sine waveform.

Root Key

The root key determines the original pitch of a recorded instrument or of a sample. Samples in MPC contain the dedicated root key information. This information will be created automatically during recording or importing.

Sample

When you press the pads on your MPC hardware, you can trigger sounds that we call samples. Samples are digitized snippets of audio that can be recorded using the recording (sampling) function of your MPC hardware or loaded from the Browser.

You can edit and process a sample in different ways. For example, a sample can be trimmed, looped, pitch-shifted or processed, using various effects. When you have finished editing your sample, you can assign it to one or more drum pads to play it. Samples can be either mono or stereo.

Sample Rate

This is the frequency representing the amount of individual digital sample scans per second that are taken to capture an analog signal digitally. For normal CD audio recordings, 44100 samples per second are used, also written as 44.1 kHz.

You can export audio using sampling rates up to 96 kHz (see Operation > General Features > Audio Mixdown) and play audio using 44.1 kHz.

Sequence

A sequence is the most basic “building block” of music you can create within an MPC project. MIDI information from your MPC hardware pads, buttons, and Q-Link knobs are recorded to the tracks of a sequence. Each sequence on your MPC hardware can contain 128 MIDI tracks and 8 audio tracks. Each project can store up to 128 separate sequences.

The length of a sequence can be set from 1 to 999 bars, which would be enough to create an entire song using only one sequence. However, MPC Studio has a dedicated Song Mode that lets you chain sequences together to create a song.

Song

Song Mode that allows you to arrange different sections (verse, chorus, hook, etc.) in order to build a song. Each song can have up to 999 “steps” (stages in which a sequence may play one or more times). Each project can store up to 32 songs.
**Stretch Factor**

The stretch factor is a value generated by the *Warp* algorithm in the software. When you record an audio file, the current sequence tempo will be embedded with it. This information is stored within the sample file when you save the project. When you warp an audio track region, the warping algorithm uses this sequence tempo and the current value in the **BPM** field to generate the stretch factor.

**Sustain**

This term describes the level of an *envelope* remaining constant after it has passed the attack and decay phases. Once reached, the sustain level is kept until the trigger is terminated.

**Time-Stretch**

See *Warp* below.

**Track**

A sequence on your MPC hardware can contain **128** MIDI tracks and **8** audio tracks.

Each **MIDI track** contains MIDI note events and controller data. In this case, the track contains no audio information—only MIDI information that uses the samples in a program (or an external MIDI sound module) to generate its audio. You can edit your performance in many different ways once the performance has been captured.

Each **audio track** contains an audio signal that has been recorded or imported into your project. You can edit this audio within the software and incorporate it into your sequences alongside your MIDI tracks.

**Trigger**

A trigger is a signal that initiates events. Trigger signals are very diverse. For instance, a MIDI note or an audio signal can be used as a trigger. The events a trigger can initiate are also very diverse. A common application for a trigger is its use to start an envelope.

**Warp**

The Warp feature lengthens or shortens a region of an audio track or sample without changing its pitch. This enables you to fit the length of an audio track or sample to the length of a sequence, a bar in your sequence, etc. while maintaining its original key.

Please note that the Warp algorithms are very CPU-intensive and can result in audio drop-outs during playback if used too freely. Be mindful of how (and how often) you use the warp function. You can reduce the CPU resources required by doing any/all of the following:

- Minimize the amount of pitch adjustment of warped audio.
- In Program Edit Mode, avoid using extreme *Stretch* values.
- Avoid warping very small audio regions.
- Warp as few tracks or track regions as possible (i.e., reduce the number of total number of voices of the polyphonic limit that use the Warp algorithm at a given time), especially instances where the warped regions start at the same time.
- Avoid rapidly triggering samples that are warped.
- If you have warped samples used in a drum program, consider using the Flatten Pad function to consolidate the affected pad’s layers into one audio sample. After you flatten the pad, its sample/samples no longer need to be warped. To see the user guide in the MPC software and learn how to do this, click the Help menu, select MPC Help, and select MPC User Manual.
MIDI Machine Control (MMC)

Your MPC hardware can send and receive MIDI Machine Control (MMC) messages, a standard protocol for transport controls.

The MPC hardware can send these messages:

<table>
<thead>
<tr>
<th>MPC Button</th>
<th>MMC Command Sent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rec</td>
<td>MMC Record Strobe (when recording starts), then MMC Record Exit</td>
</tr>
<tr>
<td>Overdub</td>
<td>MMC Record Strobe (when recording starts), then MMC Record Exit</td>
</tr>
<tr>
<td>Stop</td>
<td>MMC Stop</td>
</tr>
<tr>
<td>Play</td>
<td>MMC Deferred Play</td>
</tr>
<tr>
<td>Play Start</td>
<td>MMC Locate Zero, then Deferred Play</td>
</tr>
<tr>
<td>Data Dial, –/+, &lt;/&gt;, &lt;&lt;/&gt;&gt;</td>
<td>MMC Locate values</td>
</tr>
</tbody>
</table>

To set up your MPC hardware to send MMC messages to an external device:
1. Use a standard 5-pin MIDI cable to connect your MPC hardware's MIDI Out 1 to the MIDI input of your external device.
2. In the MPC software window, enter the Preferences and use the Sync tab to set up MMC communication over the MIDI port. To learn how to do this, please see the MPC software user guide: click the Help menu, select MPC Help, and select MPC User Manual.
3. Configure your other device properly so it can receive MMC messages.

The MPC hardware can receive these messages:

<table>
<thead>
<tr>
<th>MPC Command Received</th>
<th>MPC Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>MMC Deferred Play</td>
<td>Play</td>
</tr>
<tr>
<td>MMC Locate Zero, then Deferred Play</td>
<td>Play Start</td>
</tr>
<tr>
<td>MMC Stop</td>
<td>Stop</td>
</tr>
<tr>
<td>MMC Record Strobe</td>
<td>Record (Rec)</td>
</tr>
<tr>
<td>MMC Pause</td>
<td>Stop</td>
</tr>
<tr>
<td>MMC Locate values</td>
<td>Change location in sequence</td>
</tr>
</tbody>
</table>

To set up your MPC hardware to receive MMC messages from an external device:
1. Use a standard 5-pin MIDI cable to connect your MPC hardware's MIDI In A to the MIDI output of your external device.
2. In the MPC software window, enter the Preferences and use the Sync tab to set up MMC communication over the MIDI port. To learn how to do this, please see the MPC software user guide: click the Help menu, select MPC Help, and select MPC User Manual.
3. Configure your other device properly so it can send MMC messages.
Trademarks & Licenses

Akai Professional and MPC are trademarks of inMusic Brands, Inc., registered in the U.S. and other countries.
Ableton is a trademark of Ableton AG.
ASIO and VST are trademarks of Steinberg Media Technologies GmbH.
MPC software incorporates élastique Pro V3 by zplane.development.
Apple and macOS are trademarks of Apple Inc., registered in the U.S. and other countries.
Windows is a registered trademark of Microsoft Corporation in the United States and other countries.
All other product names, company names, trademarks, or trade names are those of their respective owners.
For complete legal information, visit akaipro.com/product-legal
Step Sequencer: Velocity Adjustment via Q-Links

While using the Step Sequencer, you can now use the Q-Link knobs to adjust the velocity of the note event at each step. The numbers of the steps that correspond to the Q-Link knobs will be shown in the screen. (This has been added to Operation > Modes > Step Sequencer.)

To show the step numbers in the screen, press Shift+Prog Edit/Q-Links, and then press F5/Screen. Press F6/Parameter/Value to switch between viewing the parameter names (Parameter) and values (Value) in the screen.

To adjust the velocity of each note event, use the corresponding Q-Link knob to select a value (1–127).

To enter a note event at a step, use the corresponding Q-Link knob to change its velocity from 0 (Off) to a value of 1 or greater.

To delete a note event from a step, set the corresponding Q-Link knob to its minimum position, 0 (Off).
List Editor

You can view and edit MIDI tracks in a List Editor. This mode displays all events in the track as a sequential list with information about: the type of event; the MIDI note or pad, length, and velocity for note events; and the type and value of automation events. This feature has been available since earlier releases of the MPC software but not documented for use with MPC Renaissance or MPC Studio.

To open the List Editor, press Shift+Step Seq.

These are the buttons under the screen:

- **F1 T.C.** Press this button to open the Timing Correct/T.C. screen, which contains various settings to help quantize the note events in your sequence. See General Features > Timing Correct/T.C. to learn about this.

- **F2 Edit** Press this button to show three additional buttons to edit the track: F3/Delete, F4/Copy, and F5/Move (all described below).

- **F3 Track** Press this button to select the track you are currently viewing in the List Editor.

- **F4 Nudge** Press this button to enable or disable the Nudge feature. When enabled, you can shift the event forward or backward by the length of the current time division. See below to learn how to use this.

- **F5 Insert** Press this button to show the Insert Event screen, which contains parameters you can use to create an event in the track (described below).

- **F6 Play** Press this button to play the currently selected event. This works with note events only.

To insert an event, press F5/Insert to open the Insert Event screen.

- **Time** is the position of the event you want to insert (in bars, beats, and ticks).

- **Type** is the type of event you want to insert: Note, Program Automation, Program Mixer, Track Automation, or Effect Automation.

- **Pad(Note)** This is available when Type is set to Note or Program Automation.

- **Effect** is the name of the effect and the number of its insert slot. This is available when Type is set to Effect Automation.

- **Parameter** is the type of modifier used via automation. This is available when Type is set to Program Automation, Program Mixer, Track Automation, or Effect Automation.

- **F4/Close** returns to the previous screen without inserting the event.

- **F5/Do It** inserts the event and returns to the previous screen.
To edit an event, press F2/Edit and press one of the following buttons that appears:

- **F2/Edit** returns to the previous screen.
- **F3/Delete** deletes the currently selected event.
- **F4/Copy** opens the Copy To screen.
  - Copy To is where the selected event in the track will be duplicated.
  - **F3/Close** returns to the previous screen without duplicating the event.
  - **F4/Do It** duplicates the event and returns to the previous screen.
- **F5/Move** opens the Move To screen.
  - Move To is the desired location of the selected event in the track.
  - **F3/Close** returns to the previous screen without changing the time of the event.
  - **F4/Do It** changes the time of the event and returns to the previous screen.

**Now** is the time counter at the top of the screen, which shows the current playhead position. See General Features > Now & Locators to learn about this.

The **View** menu lets you select what type of events are shown in the list.

- **All**: Select this option to show all event types.
- **Notes**: Select this option to show only notes.
- **Aftertouch**: Select this option to show only aftertouch messages.
- **Trk Automation**: Select this option to show only track automation events.
- **Prg Automation**: Select this option to show only program automation events.
- **Pitch Bend**: Select this option to show only pitch bend events.
- **Control Change**: Select this option to show only MIDI CC messages.
- **Prg Change**: Select this option to show only MIDI program change messages.
- **Ch Pressure**: Select this option to show only channel pressure messages.
- **Solo/Mute**: Select this option to show only solo and mute events for tracks, programs, and pads.
- **Other**: Select this option to show other types of events not listed above, such as pad or keygroup parameters.

The **BPM** in the upper-right corner of the screen is the current tempo.

- To **set the tempo**, use the BPM field or press Tap Tempo in time with the desired tempo.
- To **set whether the sequence follows its own tempo or a master tempo**, press Shift+Tap Tempo.
**Time** is the position of the event in bars, beats, and ticks.

**To change the time of an event**, do one of the following:

- Use the **cursors** to select the event, press **F2/Edit**, and then press **F5/Move**.
  
  **Move To** is the desired location of the selected event in the track.
  
  **F3/Close** returns to the previous screen without changing the time of the event.
  
  **F4/Do It** changes the time of the event and returns to the previous screen.

- Use the **cursors** to select the event, press **F4/Nudge** so the button is lit, and then use the **left** and **right cursors** to shift the event forward or backward by the length of the current time division.

**Type** is the type of event.

- **Note**: a MIDI note
- **Trk**: a track-related parameter:
  
  - **Track Mixer Automation** *(Volume, Pan, Mute, Solo)*
  
  - **Track MIDI CC Automation** *(0–127)*
  
  - **Track Parameter Automation** *(Aftertouch, Pitchbend, Channel Pressure, or Program Change)*
- **Prg**: a program-related parameter:
  
  - **Program Mixer Automation** *(Volume, Pan, Mute, Solo, or Send 1–4)*
  
  - **Program Parameter Automation** *(options vary based on the type of program)*
- **Pad**: a pad-related parameter:
  
  - **Pad/Keygroup Mixer Automation** *(Level, Pan, Pad Mute, Pad Solo, or Send 1–4)*
  
  - **Pad/Keygroup Parameter Automation** *(options vary based on the type of program)*
- **FX**: an effect-related parameter:
  
  - **Program Insert Effect** *(options vary based on the effect)*
  
  - **Pad/Keygroup Insert Effect** *(options vary based on the effect)*

**Pad/Note** is the pad and/or corresponding MIDI note number. For drum programs, you will see the pad number. For keygroup programs, plugin programs, and midi programs, you will see the note.

**To change the pad/note of a note event**, use the **cursors** to select its **Pad/Note** value, and then use the **data dial** or “/+” buttons to change it.

**Length** is the length of the note event in ticks. This is shown only for note events.

**To change the length of a note event**, use the **cursors** to select its **Length** value, and then use the **data dial** or “/+” buttons to change it. You can use the **numeric keypad** to enter a number and then press **Enter** to confirm it.
Vel is the velocity of the note event. This is shown only for note events.

To change the velocity of a note event, use the cursors to select its Vel value, and then use the data dial or −/+ buttons to change it. You can use the numeric keypad to enter a number and then press Enter to confirm it.

Mod Type/Value is the type of modifier used via automation and the automation value.

To change the automation value of an event, use the cursors to select its Value, and then use the data dial or −/+ buttons to change it. You can use the numeric keypad to enter a number and then press Enter to confirm it.

To view the List Editor Settings, press Window.

Use the Follow Now Position field to set how the screen behaves relative to the audio playhead during playback.

Scroll: The list will scroll along in the background while keeping the audio playhead centered.

Off: The list will not move during playback.

Faster Attack for Amp Envelopes

In the amp envelope of a drum program or keygroup program, an attack value of 0 now produces a much faster response, thus making your drum hits even punchier than before. (You can set the attack value in Program Edit Mode. See Operation > Modes > Program Edit Mode > Drum Programs and Keygroup Programs to learn more.)

Important: Any drum or keygroup programs that you created and saved before this update will load in MPC 2.1 with an attack value of 1 to ensure backwards compatibility.
**Arpeggiator**

MPC now includes a full-featured arpeggiator and phrase player for melodic program types.

**To open the Arpeggiator settings:**
1. Set the current track type to **Plugin**, **Keygroup**, **MIDI**, or **CV**.
2. Press and hold the **Note Repeat** button, then press **F6/Arp**.

Use the **cursors** to select each field, and then use the **data dial** or **–/+** buttons to change the parameter. If the field is a number, you can use the **numeric keypad** to enter a number and then press **Enter** to confirm it.

- **Enable** determines whether or not the arpeggiator feature is activated.  
  - **To enable or disable the Arpeggiator**, set this field to **On** or **Off** (respectively).

- **Latch** determines whether the arpeggiator will continue to run when notes are released.  
  - **To enable or disable latching**, set this field to **On** or **Off** (respectively).

- **Action** determines what kind of arpeggiator will be used and its functions. There are four types of arpeggiator function: **Arpeggio**, **Note Repeat**, **Rhythm** and **Pattern**.  
  - **To select the arpeggiator action**, use this field. See below for a description of each action and its settings.

  When the **Arpeggio** action is selected, hold down a chord and the arpeggiator will play a pattern based on the notes held.

  - **Pattern** determines how the arpeggiator triggers the held notes.

  - **Octaves** is how many octaves of the held notes the arpeggiator will cycle through, from **1–3**.

  - **Step** is the note value of each arpeggiator step, from **1/1–1/64** beats, including **T** (triplet) variations.

  - **Length** is the length of the played note in each step, from **1–100%**.

  - **Swing** is the amount of "shuffle" added to your beats, from **50%** (no swing, "straight") to **75%** (extreme).

  - **Vel** is the velocity of the played notes. Select **As played**, **From first note**, **Accented**, **Full**, **3/4**, **Half** or **1/4**.

  When the **Note Repeat** action is selected, hold down a note or chord for traditional MPC note repeat behavior.

  - **Step** is the note value of each arpeggiator step, from **1/1–1/64** beats, including **T** (triplet) variations.

  - **Length** is the length of the played note in each step, from **1–100%**.

  - **Spread** is the amount of timing spacing of the held note, creating a glissando effect.

  - **Vel** is the velocity of the played notes. Select **As played**, **From first note**, **Accented**, **Full**, **3/4**, **Half** or **1/4**.
When the **Rhythm** action is selected, hold down a chord and the arpeggiator will play the held notes in a rhythmic pattern.

- **Rhythm** is the type of rhythm played.
- **Step** is the note value of each arpeggiator step, from 1/1–1/64 beats, including T (triplet) variations.
- **Length** is the length of the played note in each step, from 1–100%.
- **Spread** is the amount of timing spacing of the held note, from 0–240, creating a glissando effect.
- **Vel** is the velocity of the played notes. Select **As played, From first note, Accented, Full, 3/4, Half or 1/4**.

When the **Pattern** action is selected, hold down a single note to trigger a melodic phrase. As you change what note is held, the melodic phrase will be transposed.

- **Pattern** is the type of pattern played.
- **Length** is the length of the played note in each step, from 1–100%.
- **Vel** is the velocity of the played notes. Select **As played, From first note, Accented, Full, 3/4, Half or 1/4**.

To close the arpeggiator settings, press **F4/Close**.

---

**Pad Perform Mode: Chromatic Type**

You can now use Pad Perform Mode to set the pads to follow a chromatic layout. When the **Chromatic** type is selected, each pad is assigned a note, ascending by one semitone with each pad. Pads with notes in the key determined by the **Scale** will be lit, while pads with notes between the scale degrees will be unlit.

**Q-Link Navigation Enhancements**

Q-Link functionality has been enhanced in the following modes: Main Mode, Track View, Next Sequence, Grid Editor, and Audio Edit Mode.

Set the **Q-Link Mode** to **Screen** in these pages to access the following controls:

- Use **Q-Link Knob 2** to adjust the playhead position.
- Use **Q-Link Knob 3** to scroll through the waveform in the large waveform display.
- Use **Q-Link Knob 4** to zoom in or zoom out at the playhead position.

*Note: For MPC Studio, these are in the first Q-Link row.*
Updates in MPC 2.4

New Features

Clip Program Improvements

The internal architecture of clip programs has been significantly improved. You can now play up to 16 clip programs at the same time. Clips will continue to play when changing tracks or sequences, allowing you to seamlessly incorporate them into live performance.

Next Sequence Mode

Next Sequence Mode now remembers the next sequence change when switching to another mode.

Additional Transport Controls

You can now hold Shift and press Stop to return the playhead to the beginning of the timeline.
Updates in MPC 2.6

New Features

Erase Parameters

From the Erase window, you can now erase selected automation parameters.

1. While the sequence is stopped, press the **Erase** button to open the Erase screen.
2. Set the **Erase** field to **Automation**.
3. By default, the **Parameter** field is set to **All**. Use the **data dial** or 
   \(-/+\) buttons to scroll through the list of all parameters that have been automated on the current track.
4. Select the parameter you would like to erase, and then press **F5/Do It** to erase the automation.

Workflow Enhancements

The **Keep or Discard** screen in **Sample Record Mode** now has function button assignments to **Save** or **Edit** the recorded sample.

In **Sequence Edit Mode**, you can now copy events from individual or multiple pads or notes from the **Copy Events** screen.

Timing Correct can now be applied to all tracks by pressing the **All Track** function button in the **Timing Correct** window.